Legal Notice

For information about NetIQ legal notices, disclaimers, warranties, export and other use restrictions, U.S. Government restricted rights, patent policy, and FIPS compliance, see https://www.netiq.com/company/legal/.

Copyright (C) 2016 NetIQ Corporation. All rights reserved.
Contents

About This Guide ........................................... 9

1 About the Operations Center Dashboard .................... 11
   1.1 Getting Started with the Dashboard .......................... 11
   1.2 About the Liferay v6.2.603 User Interface ................. 11
      1.2.1 Adding Pages and Portlets .............................. 11
      1.2.2 Using New Menus ...................................... 13
      1.2.3 Using the Control Panel ............................... 13

2 Dashboard Installation .................................... 15
   2.1 Performance Considerations ............................... 15
   2.2 Installing the Dashboard ................................ 15
      2.2.1 Verifying Your Operations Center Server’s Default Accounts and Configuration Settings ............... 16
      2.2.2 Installing the Dashboard ............................... 17
      2.2.3 Configuring the Dashboard Database ..................... 19
      2.2.4 Verifying the Dashboard Default Time Zone for User Accounts ........................................ 20
      2.2.5 Configuring the Dashboard, Operations Center Server, and the Image Server ........................ 20
      2.2.6 Starting the Dashboard for the First Time and Verifying the Installation ............................ 23
      2.2.7 Update Dashboard Configuration Settings ............ 24
   2.3 Starting and Stopping the Dashboard ....................... 25
      2.3.1 Starting the Dashboard ................................ 25
      2.3.2 Stopping the Dashboard ................................ 25
   2.4 Enterprise-Wide Trusted Sites ............................. 26

3 Dashboard Configuration .................................. 27
   3.1 About the Dashboard Control Panel ....................... 27
   3.2 Updating Dashboard Administrative Configurations .......... 28
      3.2.1 Updating Dashboard Administrative Configurations ............................................ 29
   3.3 Configuring Auto-Login for Single Sign-On (SSO) ........ 29
      3.3.1 Implementing Auto-Login with Your Web Server ................. 29
      3.3.2 Disabling Direct Client Login ......................... 31
   3.4 Setting Session Timeout .................................. 32
      3.4.1 Configuring Dashboard Session Timeout .................. 32
      3.4.2 Disabling Dashboard Session Timeout ................. 33
      3.4.3 Configuring the “Remember Me” Feature and Setting Browser Cookie Lifespan .................... 33
   3.5 Changing the Dashboard Account for Persistent Connection .... 34
   3.6 Configuring the Mail Server ................................ 35
   3.7 Configuring the Proxy Server .............................. 36
   3.8 Creating Operations Center Server Profiles ................ 37
   3.9 Understanding Portal Properties Files .................... 38
   3.10 Deploying Portlets to the Dashboard ..................... 39
      3.10.1 Deploying a Portlet with an Archive File .............. 40
      3.10.2 Deploying a Portlet using Hot Deploy .................. 40
   3.11 Default Portlet Settings ................................ 40
   3.12 Granting or Denying Access to Portlets .................. 42
## SLA Reporting Portlets

9 SLA Reporting Portlets .................................................................................. 133

9.1 Understanding the SLA Reporting Portlets .................................................. 133
9.1.1 Generating SLA Report Portlets .............................................................. 133
9.1.2 SLA Report Portlet Options ..................................................................... 134
9.2 Configuring the SLA Compliance Portlet ....................................................... 134
9.2.1 Setting Up the SLA Compliance Portlet .................................................... 136
9.2.2 Using the SLA Compliance Portlet .......................................................... 138
9.2.3 Regenerating the Report with Ad-Hoc Options .......................................... 138
9.3 Configuring the SLA Status Portlet .............................................................. 139
9.3.1 Setting Up the SLA Status Portlet ............................................................ 140
9.3.2 Using the SLA Status Portlet ................................................................... 142
9.3.3 Setting Up User Navigation to Drive an SLA Status Portlet ....................... 143

## Chart Builder Portlet

10 Chart Builder Portlet ...................................................................................... 145

10.1 Predefined Templates ................................................................................. 145
10.1.1 Chart Display Examples ......................................................................... 146
10.1.2 Deploying Charts .................................................................................. 146
10.1.3 Setting Up the SLA Status Dashboard ..................................................... 147
10.2 Custom Templates ..................................................................................... 148
10.2.1 Creating the Template File ..................................................................... 149
10.2.2 Integrating Operations Center Data ....................................................... 151
10.2.3 Creating Drill-Down URLs for a Chart ................................................... 153
10.2.4 An Example: Modifying a PCXML File with JSP Tags ............................... 153
10.2.5 Uploading New Templates ................................................................. 155
10.2.6 Deleting Templates .............................................................................. 156

## Reporting Center Portlets

11 Reporting Center Portlets ............................................................................. 157

11.1 Understanding the Configuration Portlet ..................................................... 157
11.1.1 Adding a Configuration Portlet ............................................................... 158
11.1.2 Configuring the Configuration Portlet .................................................... 158
11.2 Understanding the Reporting Portlet .......................................................... 158
11.2.1 Adding a Reporting Portlet ................................................................. 159
11.2.2 Configuring the Reporting Portlet ......................................................... 159
11.2.3 Using the Reporting Portlet ................................................................... 161
11.3 Selecting the Dashboard 508 theme ........................................................... 164
11.4 Differences in the reports between and Reporting Center Console and the Dashboard ........................................ 164
11.5 Supported Reporting Center report properties .......................................... 165

## Portal and Site Permissions

12 Portal and Site Permissions .......................................................................... 167

12.1 Assigning Permissions Using Roles ........................................................... 167
12.1.1 Site Roles ............................................................................................ 168
13 Advanced Administrative Topics 173

13.1 Encrypting the Dashboard Database Password .................................................. 173
13.2 Configuring Dashboard Ports for RMI Callbacks .................................................. 173
13.3 Enabling the Dashboard for Section 508 Accessibility ........................................... 174
13.4 Moving a Dashboard Configuration ................................................................. 175
   13.4.1 Preparing to Move a Dashboard Configuration .............................................. 175
   13.4.2 Moving a Dashboard Configuration .......................................................... 175
13.5 Upgrading the Dashboard .................................................................................... 176
   13.5.1 About Patches .............................................................................................. 176
   13.5.2 Installing Patches ......................................................................................... 177
   13.5.3 Rolling Back a Patch Installation .................................................................. 178
   13.5.4 Upgrading the Dashboard ............................................................................ 178
   13.5.5 Upgrading from the Dashboard Embedded Database to Oracle or SQL Server . 179
13.6 Performing System Recovery ................................................................................ 180

A System Properties File 181

A.1 Overriding System Settings in the Systems Properties File .................................... 181
A.2 Viewing the Default System Properties ............................................................... 182

B Running a Console or Unattended Installation 187

B.1 Console Installation .............................................................................................. 187
B.2 Unattended Installation ........................................................................................ 187
   B.2.1 Running an Unattended Installation .............................................................. 188
   B.2.2 Using a Response File ................................................................................... 190
   B.2.3 Sample Response File .................................................................................. 190

C JSP Tag Library Reference 193

C.1 Understanding JSP Tag Libraries in Operations Center .............................................. 193
C.2 Query Tag Library .................................................................................................. 194
   C.2.1 createQuery .................................................................................................... 194
   C.2.2 performQuery ............................................................................................... 195
C.3 Constrain Tag Library ............................................................................................ 195
   C.3.1 category ........................................................................................................ 195
   C.3.2 element .......................................................................................................... 196
   C.3.3 excludeManual ............................................................................................. 196
   C.3.4 local ............................................................................................................... 196
   C.3.5 offering ......................................................................................................... 196
   C.3.6 objective ....................................................................................................... 196
   C.3.7 time ............................................................................................................... 197
   C.3.8 timeZone ....................................................................................................... 197
C.4 Expand Tag Library ................................................................................................ 197
   C.4.1 time ............................................................................................................... 197
C.5 Request Tag Library ............................................................................................... 198
   C.5.1 summaryState ............................................................................................... 198
   C.5.2 compliance ................................................................................................. 198
C.5.3 availability ................................................................. 199
C.5.4 outageCount ............................................................ 199
C.5.5 breachCount ............................................................ 199
C.5.6 outageDuration ......................................................... 200
C.5.7 objectiveInstance ..................................................... 200
C.6 Element Tag Library .................................................... 200
C.6.1 exists ................................................................. 200
C.7 Result Tag Library ..................................................... 202
C.7.1 iterator ............................................................... 202
C.7.2 ResultTagSupport Class ............................................ 202

D Troubleshooting Trace Logs ........................................... 205
D.1 Errors ................................................................. 205
D.1.1 User ID Exception – Unable to Synchronize User .............. 205
D.1.2 Data Dispatcher Exception – Broken Pipe ...................... 206
D.2 Warnings .............................................................. 208
D.2.1 No Such LayoutSet Exception ................................... 208
The *Dashboard Guide* provides information on how to use the Web-based application that provides Operations Center users with a personalized and portable view into the Operations Center server.

The following table shows which sections might be most helpful to you:

<table>
<thead>
<tr>
<th>If your role is …</th>
<th>Then you might be interested in …</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Information</td>
<td>• Chapter 1, “About the Operations Center Dashboard,” on page 11</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Chapter 2, “Dashboard Installation,” on page 15</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Chapter 3, “Dashboard Configuration,” on page 27</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Chapter 4, “User Accounts,” on page 43</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Chapter 12, “Portal and Site Permissions,” on page 167</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Chapter 13, “Advanced Administrative Topics,” on page 173</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Appendix A, “System Properties File,” on page 181</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Appendix B, “Running a Console or Unattended Installation,” on page 187</td>
</tr>
<tr>
<td>Installer and Administrator</td>
<td>• Appendix D, “Troubleshooting Trace Logs,” on page 205</td>
</tr>
<tr>
<td>Dashboard Users and Site Page Owners</td>
<td>• Chapter 5, “Personal Pages, Page Configurations, and Sites,” on page 57</td>
</tr>
<tr>
<td>Dashboard Users and Site Page Owners</td>
<td>• Chapter 6, “Adding Content to a Page Using Portlets,” on page 71</td>
</tr>
<tr>
<td>Dashboard Users and Site Page Owners</td>
<td>• Chapter 7, “Exposing Operations Center Content,” on page 79</td>
</tr>
<tr>
<td>Dashboard Users and Site Page Owners</td>
<td>• Chapter 8, “Configuring Operations Center Portlets,” on page 101</td>
</tr>
<tr>
<td>Dashboard Users and Site Page Owners</td>
<td>• Chapter 10, “Chart Builder Portlet,” on page 145</td>
</tr>
</tbody>
</table>

**Audience**

This guide is intended for dashboard administrators and users.

**Feedback**

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation.

**Additional Documentation & Documentation Updates**

This guide is part of the Operations Center documentation set. For the most recent version of the *Dashboard Guide* and a complete list of publications supporting Operations Center, visit our Online Documentation Web Site at [Operations Center online documentation](#).

The Operations Center documentation set is also available as PDF files on the installation CD or ISO; and is delivered as part of the online help accessible from multiple locations in Operations Center depending on the product component.
Additional Resources

We encourage you to use the following additional resources on the Web:

- NetIQ User Community (https://www.netiq.com/communities/): A Web-based community with a variety of discussion topics.

Technical Support


Use these resources for support specific to Operations Center:

- Telephone in Canada and the United States: 1-800-858-4000
- Telephone outside the United States: 1-801-861-4000
- E-mail: support@netiq.com (support@netiq.com)
- Submit a Service Request: http://support.novell.com/contact/ (http://support.novell.com/contact/)

Documentation Conventions

A greater-than symbol (>) is used to separate actions within a step and items in a cross-reference path. The > symbol is also used to connect consecutive links in an element tree structure where you can either click a plus symbol (+) or double-click the elements to expand them.

When a single path name can be written with a backslash for some platforms or a forward slash for other platforms, the path name is presented with a forward slash to preserve case considerations in the UNIX* or Linux* operating systems.

A trademark symbol (®, ™, etc.) denotes a NetIQ trademark. An asterisk (*) denotes a third-party trademark.
About the Operations Center Dashboard

The Dashboard is a Web-based application that provides Operations Center users with a personalized and portable view into the Operations Center server. It allows for single sign-on, personalization, and integration of data from both Operations Center and other sources.

The Dashboard utilizes portlets to provide functionality and selected content from various sources. Dashboard portlets are JSR-168 compliant and any portlet that uses this standard could be deployed in the Dashboard. Portlets from third-party sources including Liferay v6.2.6203 are leveraged by the Dashboard.

A portlet is a Web-based application built for integration into a portal; it serves as a frame or container for content. Content, including content alarms from the Operations Center server, can be updated in real time.

For users, the Dashboard provides a personal Web desktop. They can personalize the Dashboard display, customize the content, and save changes between sessions. Not only can private, personal pages be created, but users can join sites that have shared pages. Content can be distributed among sites and the responsibility of moderating content can be delegated to various users.

- Section 1.1, “Getting Started with the Dashboard,” on page 11
- Section 1.2, “About the Liferay v6.2.603 User Interface,” on page 11

1.1 Getting Started with the Dashboard

As with any Web site or portal, there are two main phases to using the Dashboard:

1. Install and configure the Dashboard.
2. Build and maintain the Dashboard portal.

When building a dashboard portal, the two primary considerations are users and content:

- **Users**: The Dashboard uses the same user accounts as the Operations Center server and users must have permissions in Operations Center to access that information in the Dashboard.

- **Content**: Content is distributed to users through personal pages or shared pages. Personal pages belong to a single user only. Shared pages can be accessed by members of a site.

1.2 About the Liferay v6.2.603 User Interface

With Liferay v6.2.603, several areas of the user interface are redesigned. The following sections describe the updated areas.

1.2.1 Adding Pages and Portlets

With Liferay v6.2.6203, you can add pages and portlets to a site by clicking the Add icon on the current site page. By default, the icon is on the left side of the page.
The Edit icon allows you to access options for customizing pages, including changing the page name, selecting the look and feel for a page, and selecting a page theme. By default, the icon is on the left side of the page.
1.2.2 Using New Menus

Several new menus replace the Welcome menu that was used in previous Liferay versions:

- **Admin** provides access to the Control Panel and other site administration tasks, including creating and managing pages, content, users, and configuration settings. For more information, see Section 1.2.3, "Using the Control Panel," on page 13.

- **My Sites** provides access to the sites (called communities in previous versions) that are assigned to the currently logged in user.

- **Default Administrator** provides access to user settings and other information for the currently logged in user.

1.2.3 Using the Control Panel

The Control Panel provides access to the administrative functions you need to maintain portals and their content. You can also add portlets that developers write to the Control Panel. The following sections are available:

- **Users** provides access to tasks that are related to user management, including creating and maintaining account information, personal pages, users and organizations, user groups, and roles, and setting password and monitoring policies. For more information, see Chapter 4, "User Accounts," on page 43.

- **Sites** provides access to tasks that are related to creating and managing sites, site templates, and page templates. Sites replaces the Communities section in previous Liferay versions. For more information, see Chapter 5, "Personal Pages, Page Configurations, and Sites," on page 57.

- **Apps** provides access to tasks that are related to installing new applications and managing the installed applications.

- **Configuration** provides access to options that control how the portal operates and integrates with other systems.
Dashboard Installation

The Dashboard is a separate product with its own installation CD or media download, and is not installed as part of the Operations Center server. For more information about installing Operations Center, see the Operations Center Server Installation Guide.

The Dashboard is a Web-based application that requires access to the Operations Center server. While it can be installed on the same server as Operations Center, it doesn’t need to be on the same host machine.

For hardware and deployment requirements, see “Supported Versions and Hardware Requirements” in the Operations Center Getting Started Guide.

During installation, various configuration values must be set for the Dashboard. After installation, you must start the Dashboard service. After the installation is verified, deploy additional portlets or make property changes to portlets.

- Section 2.1, “Performance Considerations,” on page 15
- Section 2.2, “Installing the Dashboard,” on page 15
- Section 2.3, “Starting and Stopping the Dashboard,” on page 25
- Section 2.4, “Enterprise-Wide Trusted Sites,” on page 26

2.1 Performance Considerations

Because the Operations Center Dashboard offers the flexibility to design your own dashboards, you might be required to upgrade hardware, increase memory allocations, alter page designs (including number of charts or expressions on a chart), or limit the amount of users to achieve optimal performance.

Performance can vary based on the number of users, complexity of installation, and amount of data in your dashboard pages. For example, a page might be loading slowly because of the amount of data being charted, the management system involved, or other variables. We suggest you contact NetIQ Consulting for help in implementing a high performing solution.

2.2 Installing the Dashboard

Do the following in the order listed:

1. Section 2.2.1, “Verifying Your Operations Center Server’s Default Accounts and Configuration Settings,” on page 16
2. Section 2.2.2, “Installing the Dashboard,” on page 17
3. Section 2.2.3, “Configuring the Dashboard Database,” on page 19
5. Section 2.2.6, “Starting the Dashboard for the First Time and Verifying the Installation,” on page 23
2.2.1  Verifying Your Operations Center Server's Default Accounts and Configuration Settings

Review the following topics for information about the connections and communications with the Operations Center server:

- “Confirming Default Server Accounts” on page 16
- “Verifying Configuration Settings” on page 16

Confirming Default Server Accounts

By default, the Operations Center’s default admin account is used to maintain a persistent connection between the Dashboard and the Operations Center server. While this can be changed later, verify the following default accounts still exist on the Operations Center server before installing the Dashboard:

- admin
- guest

If either of these accounts no longer exists, they need to be re-created. If re-creating the admin account, be sure to give it manage, define, access, and view permissions for the Users branch of the element hierarchy. This enables the account to create, delete, and update user accounts. The account does not need to be a member of the admins group.

Continue with “Verifying Configuration Settings” on page 16.

Verifying Configuration Settings

Because the Dashboard must communicate with the Operations Center server, we recommend verifying Operations Center server configuration settings before you start to install. For more information about the Configuration Manager and communication ports, see the Operations Center Server Configuration Guide.

The Operations Center server to which the Dashboard establishes a connection is considered the default Operations Center server and the Dashboard obtains all its Operations Center content from this server. However, the Dashboard does allow additional connections to other Operations Center servers so that users can view and use content from multiple servers while viewing Web pages in the Dashboard. For more information, see Section 3.8, “Creating Operations Center Server Profiles,” on page 37.

To verify and update Operations Center Configuration Settings:

1. Open the Operations Center Configuration Manager.
2. Switch to the Tasks tab (Networking section) to verify the following settings for the Operations Center server that are important for maintaining open communication between Operations Center and the Dashboard:
   - Host Name
   - Client/Server Communication Mode
   - Web Server Ports
   - Image Server Comm Port
   - Remote Services Port (RMI)
   - Dashboard Communications Security (for RMI communications security)
The Tasks tab on the Operations Center Configuration Manager allows you to view all Networking settings in a single list.

3 Because the RMI communications security can be set in Operations Center only, and is automatically detected by the Dashboard, do one of the following:

- If Remote Services Security (RMI) is set to Secured communication using SSL, or Secured communication using SSL and Client Certificates, then:
  - Set Operations Center server’s RMI communications to secure.
  - Configure the Operations Center Web server for secure communications.
- If Remote Services Security (RMI) is set to Unsecured communication, then:
  - Set Operations Center server’s RMI communications to unsecure.
  - Configure the Operations Center Web server for unsecure communications.

Use the Secured communication using SSL and Client Certificates option when running the Dashboard with a reverse-proxy scenario where the connecting client is always the Apache Web server. For more information about configuring the Dashboard with a reverse-proxy scenario or configuring Apache to deliver client certificates, contact Support (https://www.netiq.com/support/) as a Technical Information Document (TID) has been written on this subject.

For more information about securing communications between servers and setting up certificates, see "Communications Security" in Operations Center Security Management Guide.

4 (Unix Only) Configure the X11 Display Name for the display of images. Specify the display name where the server listens for connection with the virtual framebuffer.

For example, for a display name of 1 and screen name of 0, set to :1 or :1.0.

For more information, see Configuring Display for Images on UNIX in the Operations Center Server Installation Guide.

5 Continue with Section 2.2.2, “Installing the Dashboard,” on page 17.

2.2.2 Installing the Dashboard

Typically, the Dashboard is installed by using the Installation Wizard. It might also be installed using a console installation or an unattended (or silent) installation as detailed in Appendix B, “Running a Console or Unattended Installation,” on page 187. For more information about any of these installation methods, see the Operations Center Server Installation Guide.

To install the Dashboard:

1 (Recommended) Stop all programs before continuing especially those any programs that might interfere with the Operations Center installation.

2 If installing on Windows 2012 and using a DVD/CD, mounted ISO or mounted network install, do the following:
   - Locate the installation .exe file:
     
     mount_location\Dashboard\Disk1\InstData\Windows\VM\install.exe

   - Right-click the file and select Properties.

   - Open the Compatibility tab, mark the Run this program in compatibility mode for option and select Windows 7.
3 To obtain access to the installation files, do one of the following:
   - Insert the Operations Center Dashboard CD into the CD drive of the server where the software is to be installed.
   - Locate the Dashboard files that were downloaded on the server where the software is to be installed.

4 Do one of the following:
   - **Windows**: If the Installation Wizard does not launch automatically, run `install.bat` from a command prompt.
     If User Access Control (UAC) is enabled, you must run the installation as the Administrator.
   - **UNIX**: Set the variable path to where the Java executable is, mount the CD, then run `install.sh` from the root.

5 On the License Agreement page, review the contents of the license agreement and select the I accept the terms of the License Agreement radio button if you agree with the terms.

6 On the Choose JVM page, do one of the following:
   - (Windows 32-bit) Select the Choose a Java VM already installed on this application radio button and select the desired Java VM from the list.
   - Select Search For Others to list additional installed VMs.
   - Select Choose Another to navigate to the location of the Java VM you want to use.

   **IMPORTANT**: If installing on a Windows 32-bit platform, select a 32-bit JVM. If installing on a Windows 64-bit platform, select a 64-bit JVM. Dashboard cannot run if the wrong JVM is selected.
   If installing on Solaris x64, be sure to modify the Apache `Setclasspath.sh` file to reference the Java path in your AMD64 installation in order for the Dashboard to start successfully.
   For example,
   ```bash
   _RUNJAVA="/usr/jdk1.6.0_21/jre/bin/amd64/java"
   ```

7 On the Choose Install Folder page, click Next to accept the default installation directory. If necessary, click Choose to browse for a different location.
   We recommend that you do not install the Dashboard in the same directory as the Operations Center server.

8 On the Dashboard Server Configuration page, do the following:
   8a Specify the Dashboard communications mode by selecting one of the following Dashboard Communications Mode radio buttons:
      - **http only** to only use unsecure communications.
      - **https only** to only use secure communications.
      - **both** to allow both unsecure and secure communications.
   8b Specify the http port the Dashboard is to use for http communications in the Dashboard Web Server Port (HTTP) field.
   8c Specify the http port the Dashboard is to use for https communications in the Dashboard Web Server Port (HTTPS) field.
   8d Click Next.
   8e Specify the communications mode that the Dashboard uses to communicate with the Operations Center server by selecting one of the following Operations Center Communications Mode radio buttons:
      - **http** to use unsecure communication with Operations Center.
• **https** to use secure communications with Operations Center.

8f Specify the host name of the Operations Center server in the NOC Host Name field.

8g Specify the port for web communications of the Operations Center server in the NOC Web Port field.

8h Click Next.

8i Select the Run Configuration Manager after install option to launch the Configuration Manager during installation.

8j Select whether the Dashboard Service will run under the local system account or a Windows user account. If you select User Account, also provide the account credentials.

9 On the Pre-Installation Summary page, review the installation details and click Install.

10 While the Dashboard installs, note the following that occurs:

• The status display updates as the Dashboard installs.

• The Configuration Manager launches to configure settings for the installation if selected in Step 8i.

  Details on these settings are documented in Section 2.2.5, “Configuring the Dashboard, Operations Center Server, and the Image Server,” on page 20.

11 When the install is complete, continue with Section 2.2.3, “Configuring the Dashboard Database,” on page 19.

### 2.2.3 Configuring the Dashboard Database

While the Dashboard installs by default with an embedded Hypersonic SQL database, the Dashboard must be configured to use an Oracle or SQL Server database.

The following instructions provide instructions for configuring the Dashboard database:

• “Configuring Windows Servers for Database Single Sign-On (SSO)” on page 19

• “Configuring the Dashboard Database” on page 20

**Configuring Windows Servers for Database Single Sign-On (SSO)**

The Dashboard can be configured to use Server Domain Authentication for Single Sign-On with Microsoft SQL databases. Windows servers require additional configuration for SSO functionality.

To configure Windows servers for Single Sign-On with Dashboard MSSQL databases:

1 Stop the Dashboard.

2 Copy one of the following files into the directory containing the java.exe used by the Dashboard server:

• **On a 32-bit JVM:** OperationsCenter_Dashboard_install_path/mssql/win32/ntlmauth.dll

• **On a 64-bit JVM:** OperationsCenter_Dashboard_install_path/mssql/win64/ntlmauth.dll

3 Specify the domain, username and password when configuring the Dashboard portal-ext.custom.properties file.

  For information on configuring the Dashboard database and properties file for SSO, continue to Configuring the Dashboard Database.

4 Restart the Dashboard.
Configuring the Dashboard Database

The default database is a Hypersonic SQL embedded database. You can upgrade from the embedded database to an Oracle or SQL Server database. For more information, see Section 13.5.5, “Upgrading from the Dashboard Embedded Database to Oracle or SQL Server,” on page 179.

2.2.4 Verifying the Dashboard Default Time Zone for User Accounts

The default time zone for the portal is set to UTC for Dashboard users. It is important that its value be updated to an appropriate time zone if this is not the correct time zone for your users prior to the initial automatic synchronization with the Operations Center server.

Note that data in the Layout portlet and the Layout tab in the Information portlet displays based on the time zone of the Operations Center server, and not the time zone configured for the Dashboard.

To change the default time zone:

1. Open the `/OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.properties` file, and locate the list of time zones.

2. Open the `/OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.custom.properties` file. Add the user.timezone property, and define it using a time zone from the list in Step 1.

For more information about the `portal-ext.properties` and `portal-ext.custom.properties` files, refer to Section 3.9, “Understanding Portal Properties Files,” on page 38.

**WARNING:** When Dashboard users are created via the automatic synchronization with Operations Center server, their time zone is assigned based on the user.timezone property in the `system-ext.properties` file. If this property isn’t updated for the desired default time zone in the `system-ext.custom.properties` file prior to synchronization, each user must update their time zone individually via their Dashboard control panel. For more information about user synchronization, see Section 4.1, “Operations Center and Dashboard Interaction,” on page 43.

2.2.5 Configuring the Dashboard, Operations Center Server, and the Image Server

The Operations Center Dashboard’s Configuration Manager and the Operations Center’s Configuration Manager are two different configuration managers. You need to use both managers to configure the Dashboard.

Configurations must be made for general Dashboard operation and communications with the Operations Center server. In order for the Dashboard to communicate with the Operations Center server, some configuration settings must match the settings of the Operations Center server’s configuration. These settings are found in the Operations Center Dashboard Configuration Manager and must match the same settings in the Operations Center Configuration Manager.

**WARNING:** Changing the settings in either Configuration Manager replaces existing configuration files and any manual changes are lost.
To configure the Dashboard:

1. To access the Operations Center Dashboard Configuration Manager, do one of the following:
   - **Windows**: You have two options:
     - Click Start > All Programs > NetIQ Operations Center > NetIQ Operations Center Dashboard > Configure NetIQ Operations Center Dashboard.
     - At the DOS prompt, run customizer from the \OperationsCenter_Dashboard_install_path\bin directory.
   - **UNIX**: At a command prompt, run Customizer from the /OperationsCenter_Dashboard_install_path/bin directory.

2. Click NetIQ Operations Server in the Components tab.

3. Configure the following settings:
   - **NetIQ Operations Center Server Host Name**: The host name for the Operations Center server.
   - **NetIQ Operations Center Server Communication Mode**: The method of communication for the Operations Center server. Select between Unsecured communication or Secured communication using SSL.
   - **NetIQ Operations Center Server Web Server Port**: The Web server port for the Operations Center server. If using unsecured communication, specify the Web Server Port number for HTTP from the Operations Center server. Or, if using Secured communication using SSL, specify the Web Server Port number for HTTPS from the Operations Center server.
   - **NetIQ Operations Center Server SQL Views port**: The port used by SQL Views for access to the Operations Center server. For more information, see the Operations Center SQL Views Guide.
   - **NetIQ Operations Center Server RMI Server Port**: The RMI server port for the Operations Center server. The default RMI port is 1099. Value must match the RMI server port specified in the Operations Center configuration manager. If the port is changed in the Dashboard Configuration Manager, then the port value must be updated in the Operations Center Configuration Manager, and vice versa.
   - **NetIQ Operations Center Server Image Server Comm Port**: The Image Server’s Communication Port for the Operations Center server. If using a portlet that accesses the Operations Center server’s Image server, value must match the Image server communications port that is specified in the Operations Center configuration manager. The Operations Center server’s Image server can be accessed from the Dashboard IP Address. For more information on this, see the Operations Center Server Configuration Guide.
   - **NetIQ Operations Center Server System User Id**: The user name of the Operations Center admin account that is used for handling the persistent connection for user synchronization between the Dashboard and Operations Center.

   For more information about user and group synchronization and the default admin account, see Section 4.1, “Operations Center and Dashboard Interaction,” on page 43.

   For more information about changing the default admin account, see Section 3.5, “Changing the Dashboard Account for Persistent Connection,” on page 34.

   - **NetIQ Operations Center Server System User Password**: The corresponding password of the Operations Center admin account specified in the Operations Center server’s System User Id field.

4. To access the Dashboard configuration options, click Dashboard in the Components tab.
Configure the following Dashboard settings:

**Dashboard Communication Mode:** The method of communication for the Dashboard. Select *Unsecured communication*, *Secured communication using SSL*, or *Support both unsecured and secured communication*.

**Dashboard Web Server Port (HTTP):** The port to access the Dashboard if using an unsecured communication protocol.

**Dashboard Web Server Port (HTTPS):** The port to access the Dashboard if using a secure communication protocol.

**Dashboard Web Server Shutdown Port:** The TCP/IP port number to which the Dashboard listens for a shutdown command.

**Dashboard Data Caching:** The RMI connection between the Dashboard and Operations Center uses a memory sensitive cache to retain data for a predetermined amount of time. This cache resides on the Dashboard application and reduces the amount of calls to the Operations Center server. By default, the caching mechanism is enabled. Note that because this is a memory sensitive cache, it is purged if memory demands are exceeded by the Dashboard application.

**Cache timeout value in seconds:** The amount of time the data caching mechanism holds onto data. Defaults to 45 seconds.

**Dashboard Trace Level:** Controls how much information is passed to the server trace logs. Defaults to *INFO*, which is recommended. The trace levels are:

- **ERROR:** Logs error messages only.
- **WARN:** Logs error and warning messages.
- **INFO:** Logs informational, error, and warning messages.
- **DEBUG:** Logs all information and as the most detailed setting should be used only to track down problems.

**Dashboard Trace Destination:** Specifies the location of trace log output file. By default, all logging is saved to `/OperationsCenter_Dashboard_install_path/server/logs/dashboard.trc`. On application startup, the current version of the Dashboard and a listing of all environment variables are written to the trace file. For more information, see Appendix D, "Troubleshooting Trace Logs," on page 205.

**Dashboard Server Push:** Push technology allows data from the Operations Center server to be received as new data appears. If disabled, data is only sent when the user refreshes or loads a page. By default, this option is enabled and applies to all Operations Center portlets that support push technology. However, push settings can be overridden for each individual portlet taking precedence over this setting in the Operations Center Dashboard Configuration Manager. For more information, see Section 7.8.6, "Automatic Data Updates with Push Technology," on page 99.

Specify Java configuration options:

**Java Development Kit Directory:** The location of the JDK used by the Dashboard. Click **Browse** to select a new location.

**Java Initial Memory Pool:** (Windows Only) Initial and minimum Java heap size in megabytes.

**Java Max Memory Pool:** (Windows Only) Maximum Java heap size in megabytes.
**Java Runtime Options:** List of command line options in the form of -D or -X that are passed to the JDK. For Windows, separate entries with a semicolon. For UNIX, separate entries with a space.

For more information about JRE requirements, see “Requirements for the Dashboard” in the Operations Center Getting Started Guide.

7 To access the Image Server configuration options, click **Image Server** in the **Components** tab.

**Dashboard Host Override:** If running in SSL mode, specify a host name for the image server to call back to the dashboard. Set the host name to the same host name as used in the cacerts trust store for the Operations Center server. The Chart Builder functionality relies on the Image server for delivery of charts.

8 To restart the Dashboard, continue with Section 2.2.6, “Starting the Dashboard for the First Time and Verifying the Installation,” on page 23.

After making changes in the Configuration Manager, it is necessary to restart the Dashboard for any changes to take affect.

### 2.2.6 Starting the Dashboard for the First Time and Verifying the Installation

The last step to installing the Dashboard is to start the Dashboard and log in to verify a successful connection.

**IMPORTANT:** At the initial start up of the Dashboard server, a user synchronization process imports all users and groups from the Operations Center server into the Dashboard. For more information about the user synchronization process, see Section 4.1, “Operations Center and Dashboard Interaction,” on page 43.

When user accounts are created, a default time zone is assigned based on a property setting in the portal-ext.properties file. Be sure to validate, and override this setting if necessary in the portal-ext.custom.properties file, before starting the Dashboard server for the first time. For more information about time zone settings, see Section 2.2.4, “Verifying the Dashboard Default Time Zone for User Accounts,” on page 20.

For more information about the portal-ext.properties and portal-ext.custom.properties files, refer to Section 3.9, “Understanding Portal Properties Files,” on page 38

For more information on starting the Dashboard, see Section 2.3.1, “Starting the Dashboard,” on page 25.

To log in to the Dashboard:

1 From your Web browser, access the URL of the Dashboard server:
   
   http://server:dashboard_port
   
   For example, the Dashboard is installed on your current machine and the HTTP port (Operations Center Dashboard Configuration Manager) set to 8080, then point your browser to:
   
   http://localhost:8080
When successful, the guest home page for the Dashboard displays.

2 To verify RMI communication settings between the Dashboard and the Operations Center server, log in to the Dashboard.

Use the Operations Center default admin account credentials.

If successful, the Dashboard establishes a persistent administration connection to the Operations Center server. This connection is then used to verify the credentials provided by users in the login portlet. If the credentials are correct, the Access Control Synchronizer starts and users from Operations Center are imported.

After logged into the Dashboard, you can add and update content from your personal home page.

Next, configure the URL settings. For more information, see Section 3.2, "Updating Dashboard Administrative Configurations," on page 28.

3 If the connection or authentication fails, do the following as necessary:

- Confirm your administrator default account credentials.
- Verify that you are using the correct HTTP or HTTPS port.
- For all port configurations, verify that the port does not conflict with a port already in use.
- Confirm that the RMI connections specified in the Operations Center Dashboard Configuration Manager and the Operations Center Configuration Manager match.

If settings are changed in the Configuration Manager, restart the associated server.

- Review the dashboard.trc file for error messages.
- Add the Dashboard server as a trusted site.

For IE 7+ in Windows Vista or Windows Server 2008 and running in Protected Mode, the Dashboard server must be added as a trusted site before the Dashboard can function normally.

To add the Dashboard to the list of trusted sites, click Tools and select Internet Options. Select the Security tab and click Trusted Sites. Click Sites and specify the Dashboard host as a trusted site.

2.2.7 Update Dashboard Configuration Settings

For the Dashboard to function properly, the Virtual Host and Mail Domain settings need to be updated. Else, the Dashboard users might encounter redirect issues when navigating to the Dashboard or when the Dashboard is unable to send e-mail notifications.

For more information about other the Dashboard portal configuration settings, see Section 3.2, "Updating Dashboard Administrative Configurations," on page 28.

To update the Virtual Host and Mail Domain for the Dashboard:

1 From the Control Panel, under Configuration, select Portal Settings.
2 Specify the fully qualified host name for the server where the Dashboard is running in the Virtual Host field.
3 Specify the domain name for the mail host for this instance in the Mail Domain field.
4 Click Save to save all updated settings.
5 Click Back to exit the Control Panel.
2.3 Starting and Stopping the Dashboard

The user account starting and stopping the Dashboard must have the proper permissions to create, update, and delete contents in the Dashboard directory on the Dashboard server. The user must also have the Environment variable %JAVA_HOME% in Windows or $JAVA_HOME$ in Linux/Unix set to point to the JDK directory.

- Section 2.3.1, “Starting the Dashboard,” on page 25
- Section 2.3.2, “Stopping the Dashboard,” on page 25

2.3.1 Starting the Dashboard

For important notes about starting the Dashboard for the first time, see Section 2.2.6, “Starting the Dashboard for the First Time and Verifying the Installation,” on page 23.

To start the Dashboard:

1. Do one of the following:
   - **Windows**: Do one:
     - Run the \OperationsCenter_Dashboard_install_path\bin\startup.bat script file.
     - Start the Operations Center Dashboard Windows service.
       - In the Windows Start Menu, select NetIQ Operations Center > NetIQ Operations Center Dashboard > Start NetIQ Operations Center Dashboard.
   - **UNIX**: Issue the startup.sh command.

2.3.2 Stopping the Dashboard

To stop the Dashboard, do one of the following:

- **Windows**: Do one:
  - Run the \OperationsCenter_Dashboard_install_path\bin\shutdown.bat script file.
  - Stop the Operations Center Dashboard Windows service.
    - In the Windows Start Menu, select NetIQ Operations Center > NetIQ Operations Center Dashboard > Stop NetIQ Operations Center Dashboard.
- **UNIX**: Issue the shutdown.sh command.

If the Dashboard does not terminate normally after invoking the shutdown.sh command, issue the shutdown.sh command again using the -force option to perform a hard shutdown of the Dashboard.
2.4 Enterprise-Wide Trusted Sites

Because of Protected Mode functionality, the Dashboard server must be added as a trusted site before the Dashboard can be run successfully using IE 7+ in Windows Vista or Windows Server 2008 in Protected Mode.

Unfortunately, if Protected Mode is enabled for the entire enterprise, having each user modify the Trusted Sites list is difficult to maintain. Therefore, we recommend adding the Dashboard server to the list of Trusted Sites by the enterprise administrator through domain policy and pushed out to all clients.
3 Dashboard Configuration

Because the Operations Center Dashboard is built on top of Liferay, see http://dev.liferay.com for documentation on server configuration, portal administration, and Liferay content management functionality.

In addition, this section covers various administrator configurations required for the Dashboard, or for the proper functioning of various portlets.

- Section 3.1, “About the Dashboard Control Panel,” on page 27
- Section 3.2, “Updating Dashboard Administrative Configurations,” on page 28
- Section 3.3, “Configuring Auto-Login for Single Sign-On (SSO),” on page 29
- Section 3.4, “Setting Session Timeout,” on page 32
- Section 3.5, “Changing the Dashboard Account for Persistent Connection,” on page 34
- Section 3.6, “Configuring the Mail Server,” on page 35
- Section 3.7, “Configuring the Proxy Server,” on page 36
- Section 3.8, “Creating Operations Center Server Profiles,” on page 37
- Section 3.9, “Understanding Portal Properties Files,” on page 38
- Section 3.10, “Deploying Portlets to the Dashboard,” on page 39
- Section 3.11, “Default Portlet Settings,” on page 40
- Section 3.12, “Granting or Denying Access to Portlets,” on page 42

3.1 About the Dashboard Control Panel

All of the administrative functions that you will need to maintain the portal or its content can be found in the control panel. Additionally, developers can write portlets which can also be added to the control panel. Access the Control Panel through the Admin menu.

Administrative functions are listed in a logical order under main headings.

- **Users**: The first section is always the logged in user’s personal space. Here, you can change your account information and manage your own personal pages.
- **Sites**: The Sites section lists the sites that the logged in user can access.
- **Apps**: The Apps section allows you to manage installed applications and install new applications.
- **Configuration**: The Configuration section includes configuration options that control how the portal operates and integrates with other systems.

The Configuration section of the Control Panel is used for most administrative tasks, such creating and maintaining:

- Users
- Organizations
- Sites
Additionally, it allows you to configure many server settings, including:

- Password policies
  
  The Dashboard does not support Liferay functionality for password expiration and password lockout.
- Authentication options, including single sign-on and LDAP integration
- Default user associations
- Reserved screen names
- Mail host names
- Email notifications

You will use the Configuration section of the Control Panel to create your portal structure, implement security, and administer your users. Note that only users with the Administrator role—a portal scoped role—have permission to view this section of the Control Panel.

3.2 Updating Dashboard Administrative Configurations

Use the Portal Settings section that is under the main Configuration section for most of the main Dashboard administrative configuration tasks, including:

- **General**: Configure global settings such as the portal site name and the virtual host and mail domain.
- **Authentication**: Configure user authentication and connection methods, such as LDAP and single sign-on. Because users are loaded from the Operations Center server, do NOT change the default authentication method.
- **Users**: Configure the following:
  - Default assignments to sites, user roles, and user groups
  - Reserved screen names and e-mail addresses
- **Mail Host Names**: Configure additional domains for sending email messages related to certain portlets. For example, the login portlet allows users to request an account.
- **Email Notifications**: Configure email notifications for certain events, such as user registrations and password changes.
- **Display Settings**: Configure the default portal language and time zone (by default, these are set to English (United States) and GMT, respectively).
The following sections describe how to configure the Dashboard using the Control Panel:

- Section 3.2.1, “Updating Dashboard Administrative Configurations,” on page 29

3.2.1 Updating Dashboard Administrative Configurations

To update main dashboard configurations:

1. From the Control Panel, under **Configuration**, select **Portal Settings**.
2. Use the links that are available in the **Portal Settings** section to update settings as required. For more information about the settings you can configure, see Section 3.2, “Updating Dashboard Administrative Configurations,” on page 28.

**IMPORTANT:** Setting the **Home URL** can cause warnings to appear in the trace logs. For more information, see Section D.2.1, “No Such LayoutSet Exception,” on page 208.

3. Click **Save** to save all updated settings.

3.3 Configuring Auto-Login for Single Sign-On (SSO)

The Dashboard supports Single Sign-On (SSO) capability through its auto-login function. SSO allows users to gain access to multiple systems (that support SSO) with a single login. For more information about implementing auto-login, see Section 3.3.1, “Implementing Auto-Login with Your Web Server,” on page 29. For more information about user access to the Dashboard, see Chapter 4, “User Accounts,” on page 43.

In situations where it is necessary to disable direct access to the Dashboard server or operations client, authentication can be verified against the SSO implementation before users are granted access. For more information, see Section 3.3.2, “Disabling Direct Client Login,” on page 31.

3.3.1 Implementing Auto-Login with Your Web Server

The Dashboard’s auto-login can be used with any mechanism in which HTTP requests include an HTTP header containing the user name to be auto-logged in. It is most commonly used with the Apache Web server set up as a reverse proxy.

When using a Web server reverse proxy, the security plug-in can authenticate incoming HTTP requests based on a certificate for a user name. The Web server can then be configured to pass an HTTP header containing the user name of the authenticated user to the Dashboard. If the Dashboard server has been configured to allow auto-login, the user is automatically logged in, bypassing the need for the user to provide a user name and password.
In the above illustration, a Web server is configured as a reverse proxy. The appropriate auto-login header (such as `remote-user`) is embedded into HTTP requests and the Dashboard server is configured to allow auto-login. Valid Operations Center users (a user that has already been created and exists in Operations Center) are authenticated if the specified HTTP header exists and the Dashboard is configured for auto-login, and the users are automatically logged in to the Operations Center server.

To configure auto-login using the Web server reverse proxy:

   For more information about the `portal-ext.custom.properties` file, see Section 3.9, “Understanding Portal Properties Files,” on page 38.
   1b. Add the following line, but do not change the value of the property:

   ```
   auto.login.hooks=com.mosol.liferay.authenticator.MOAuth
   ```

   1c. Add the following line to specify the Web Server Request URIs that allow auto-login:

   ```
   mo.autologin.request.uris=.*
   ```

   The value defaults to `.*` for all pages, as shown in the code sample above.

   You can configure this property to a specific page, such as `/c/portal/login`. If a user has not yet established a portal login and accesses the `http://dashboard_host:dashboard_port/c/portal/login` page, the auto-login is attempted. However, if any other page is accessed without a previous portal login established, then auto-login is not attempted because the page is not a match for the property’s regular expression.
To specify more than one specific page, use a pipe character (vertical line) to separate the values. For example, /c/portal/login|/c/portal/layout sets the auto-login to the login page and general layout page. If the general layout page is specified (/c/portal/layout, .*, and so on), then logging out of the portal triggers an immediate attempt to auto-login. If successful, the user is automatically logged in and does not see a login portlet.

1d Add the following line to request the header containing the principal to auto-login:

    mo.autologin.header=remote-user

The value of remote-user is an http header only. In this configuration file you do not usually change the line itself or declare specific users.

1e After saving the file, restart the Dashboard Web server.

For more information, see Section 2.3.1, "Starting the Dashboard," on page 25.

2 Configure the Web server to set up the reverse proxy to forward requests from “/” to the Dashboard server URL.

For more information about configuring the Apache Server reverse proxy, contact Technical Support (https://www.netiq.com/support/).

3 Configure a custom HTTP header by adding a remote-user, or the header specified above in Step 1d on page 31, to contain the value of an existing Operations Center user.

4 Set up client certificates between the Web server and the Dashboard.

For more information about setting up a keystore and trust store, see “Communications Security” in the Operations Center Security Management Guide.

For more information about configuring Apache for client certificates, contact Technical Support (https://www.netiq.com/support/).

3.3.2 Disabling Direct Client Login

When direct access should be disabled to the Dashboard server or operations client, user authentication against the auto-login implementation can be forced before access to the Dashboard or the operations client is granted. This approach provides a single authentication pipeline for all users against the target system.

To disable direct client login:

1 Open the Operations_Center_Dashboard_installation_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.custom.properties file in a text editor.

For more information about the portal-ext.properties and portal-ext.custom.properties files, see Section 3.9, “Understanding Portal Properties Files,” on page 38.

2 Add or update the following parameters as shown:

    Client.DisableLogins=true
    Client.DisableLogins.AllowedAccounts=admin,guest

Setting the Client.DisableLogins parameter to True disables logins to the operations client.
The `Client.DisableLogins.AllowedAccounts` parameter defines a comma-separated list of accounts that are allowed to log in when the SSO provider is not available and administrators need access to the system.

3. Save the file, then restart the Dashboard Web server.

### 3.4 Setting Session Timeout

Both the Dashboard and the Operations Center server to which the Dashboard has established a connection times out based on inactivity. For more information about configuring session timeout, see the following sections:

- Section 3.4.1, “Configuring Dashboard Session Timeout,” on page 32
- Section 3.4.2, “Disabling Dashboard Session Timeout,” on page 33
- Section 3.4.3, “Configuring the “Remember Me” Feature and Setting Browser Cookie Lifespan,” on page 33

#### 3.4.1 Configuring Dashboard Session Timeout

Two types of session timeout affect the Dashboard user:

- **Server Connection Timeout:** Dashboard portlets will attempt to reconnect to an Operations Center server that has timed out or stopped as long as the Dashboard application has not timed the user out of the Dashboard session. By default, a connection timeout occurs after 30 minutes of inactivity with the Operations Center server.

- **User Session Timeout:** By default, if a user does not perform any activity in the Dashboard for 30 minutes, the user is warned that the session will expire. The user can remain logged in to the Dashboard for an additional 30 minutes by responding to the notification.

To change Dashboard session timeouts:

1. To configure the server connection timeout, add or update the `mo.remoteserver.context.keepAliveTime` property value in the `Formula.custom.properties` file. Set the property to the number of minutes of inactivity to trigger the connection timeout with the Operations Center server. For information about creating or using the `Formula.custom.properties` file, see “Making Custom Changes” in the *Operations Center Server Configuration Guide*.

2. To set the user session timeout, update the following line in the `Operations_Center_Dashboard_installation_path/server/webapps/ROOT/WEB-INF/web.xml` file for the number of minutes before timeout:

```xml
<session-config>
  <session-timeout>number_of_minutes</session-timeout>
</session-config>
```
### 3.4.2 Disabling Dashboard Session Timeout

By default, session timeout is enabled for the Dashboard. To extend sessions and keep them open as long as the user’s browser is open and a portal page is loaded, update the `portal-ext.custom.properties` file. When extending sessions, a smaller `session.timeout` value, such as 5 minutes, must be set.

**To halt session timeout:**

1. By default, the server connection timeout is set to 30 minutes. Verify the `mo.remoteserver.context.keepAliveTime` property setting in the `Formula.custom.properties` file to adjust the connection timeout with the Operations Center server.
2. Stop the Dashboard server.
3. Add the following line to `Operations_Center_Dashboard_installation_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.custom.properties`:
   ```
   session.timeout.auto.extend=true
   ```
4. Update `Operations_Center_Dashboard_installation_path/server/webapps/ROOT/WEB-INF/web.xml` to set a smaller session timeout:
   ```xml
   <session-config>
     <session-timeout>number_of_minutes</session-timeout>
   </session-config>
   ```
   Five minutes is the recommended value.
5. Start the Dashboard server.

### 3.4.3 Configuring the “Remember Me” Feature and Setting Browser Cookie Lifespan

When using the Remember Me feature for auto-login, you can configure the cookie lifespan to expire after a specific length of time or after each browser session.

By default, the Remember Me feature is enabled in the `portal-ext.custom.properties` file using the `company.security.auto.login` setting.

**To configure Remember Me and cookie lifespan:**

2. To configure cookie lifespan, add the following line and set the value to the length of time (in seconds) to expire:
   ```
   company.security.auto.login.max.age=31536000
   ```
   31536000 sets a lifespan of one year. Specify `-1` to expire after each browser session.
To disable the Remember Me auto-login feature, add the following line:

```
company.security.auto.login=false
```

### 3.5 Changing the Dashboard Account for Persistent Connection

By default, the Dashboard uses the Operations Center **admin** user account to establish a persistent connection to receive user account information and data from the Operations Center server. You can configure the Dashboard to use a different account for the persistent connection. For more information about this account, see Section 2.2.1, "Verifying Your Operations Center Server’s Default Accounts and Configuration Settings," on page 16.

**IMPORTANT:** While you can deactivate the default admin account in the Dashboard, do not delete it. If you deactivate the account, it cannot be used to log in to the Dashboard.

**To change the persistent user account for the Dashboard:**

1. In the Operations Center server console, create the new user account to use for the Dashboard persistent connection with the following properties and permissions:
   - Is a member of the admins group
   - Has both console and Web access
   For more information, see the *Operations Center Security Management Guide*.
2. Log in to the Dashboard using the default admin account.
3. To assign the Administrator role to the new admin account:
   1. From the Control Panel, under **Users**, select **Roles**.
   2. Click **Actions** next to **Administrator**, and then select **Assign Members**.
   3. On the **Users** tab, click the **Available** tab.
   4. Select the new persistent user account.
      - If the user is not available, synchronization has probably not occurred yet. Either wait for the users to be synchronized or log in as the new user to force the account to be synchronized.
      For more information, see Section 4.1.1, "Understanding User and Group Synchronization," on page 44.
   5. Click **Update Associations**.
4 To deactivate the default admin account you no longer plan to use:

4a Log out and log in using the new Administrator account.
4b Select Control Panel from the Admin menu.
4c Under Users, select Users and Organizations.
4d Select the old admin account, and then select Deactivate.

5 Update the Operations Center system account setting in the Operations Center Dashboard Configuration Manager:

5a To access the Operations Center Dashboard Configuration Manager, do one of the following:

- **Windows:** You have two options:
  - Click Start > All Programs > NetIQ Operations Center > Dashboard > Configure Dashboard.
  - From a command prompt, run `customizer` from the `Operations_Center_Dashboard_installation_path\bin` directory.

- **UNIX:** From a command prompt, run `customizer` from the `Operations_Center_Dashboard_installation_path\bin` directory.

5b On the Components tab, click NetIQ Operations Center.

5c Update the following settings:

- **NetIQ Operations Center System User Id:** The user name of the Operations Center admin account that is used for handling the persistent connection for user synchronization between the Dashboard and Operations Center.

  For more information about user and group synchronization and the default admin account, see Section 4.1, “Operations Center and Dashboard Interaction,” on page 43.

- **NetIQ Operations Center System User Password:** The password for the Operations Center admin account specified in the NetIQ Operations Center System User Id field.

5d Click Apply.

6 Restart the Dashboard server.

For more information, see Section 2.3.1, “Starting the Dashboard,” on page 25.

### 3.6 Configuring the Mail Server

The Dashboard requires a mail server to perform the following functionality:

- Users request a new user account and receive an e-mail with account information. Sending this e-mail message requires an SMTP host running on an SMTP server.

- Users request a forgotten password and receive an e-mail with the password. An IMAP host and POP 3 host need to be configured to send this e-mail.

By default, the Dashboard uses localhost for the mail server location.

**To configure the mail server for Dashboard e-mails:**

1 Stop the Dashboard server.

   For more information, see Section 2.3.2, “Stopping the Dashboard,” on page 25.

2 Create a `ROOT.xml` file at `Operations_Center_Dashboard_installation_path/server/conf/Catalina/localhost` and add the following content:
3 Save the file, then restart the Dashboard server.
For more information, see Section 2.3.1, “Starting the Dashboard,” on page 25.

3.7 Configuring the Proxy Server

Some of the portlets utilized by Dashboard users might have links to external web sites. If using a proxy server, configure those Dashboard settings to allow users access to these external web site references. The system.properties file includes default proxy server settings. To override the default settings, you must modify the system-ext.properties file as described in the procedure that follows.

The system.properties file includes the following default proxy server settings:

### HTTP

# Set the location of the HTTP proxy that the portal will use to fetch external content.
http.proxyHost=192.168.0.200
http.proxyPort=4480

# These are read for backwards compatibility and only used if the http.proxyHost and http.proxyPort settings are not specified.
com.liferay.util.Http.proxy.host=192.168.0.200
com.liferay.util.Http.proxy.port=4480

# Set the proxy authentication type.
com.liferay.util.Http.proxy.auth.type=username-password
com.liferay.util.Http.proxy.auth.type=ntlm

# Set user name and password used for HTTP proxy authentication.
com.liferay.util.Http.proxy.username=
com.liferay.util.Http.proxy.password=

# Set additional properties for NTLM authentication.
com.liferay.util.Http.proxy.ntlm.domain=
com.liferay.util.Http.proxy.ntlm.host=

# Set the connection timeout when fetching HTTP content.
com.liferay.util.Http.timeout=5000

For more information about the system.properties file, see Appendix A, “System Properties File,” on page 181.
To update the Dashboard proxy server settings:

1. Open `Operations_Center_Dashboard_installation_path/server/webapps/ROOTWEB-INF/classes/system-ext.properties` in a text editor.

   The `system-ext.properties` file overrides any default settings from the `system.properties` file.

2. Add the HTTP proxy server settings as shown in the above example. Uncomment and modify the appropriate lines for your environment, and then save your changes.

   Do not change any other properties in this file unless you are aware of the consequences.

3. Edit the Web Server startup file to add `-Dsystem.properties.load=true` to the Java JM arguments line:

   - **Windows:** Update `Operations_Center_Dashboard_installation_path/bin/catalina.bat` as follows:

     ```bash
     set JAVA_OPTS=-Xmx768m -XX:MaxPermSize=128m -XX:+PrintHeapAtGC -XX:+PrintGCDetails -Xloggc:%CATALINA_HOME%/logs/mymogc.log -XX:+DisableExplicitGC -Dsystem.properties.load=true -Dfile.encoding=UTF8 -Djava.security.auth.login.config=%CATALINA_HOME%/conf/jaas.config
     ```

   - **UNIX:** Update the `Operations_Center_Dashboard_installation_path/bin/catalina.sh` file:

     ```bash
     JAVA_OPTS="-Xmx768m -XX:MaxPermSize=128m -XX:+PrintHeapAtGC -XX:+PrintGCDetails -Xloggc:$CATALINA_HOME/logs/mymogc.log -XX:+DisableExplicitGC -Dsystem.properties.load=true -Dfile.encoding=UTF8 -Djava.security.auth.login.config=$CATALINA_HOME/conf/jaas.config"
     ```

4. Restart the Dashboard server.

   For more information, see Section 2.3.1, “Starting the Dashboard,” on page 25.

### 3.8 Creating Operations Center Server Profiles

By default, all portlets pull data from the default Operations Center server that was specified during Dashboard installation and configuration. However, the Dashboard supports selecting additional Operations Center servers to use as data sources. To establish communication between the Dashboard and another server, you must create a server profile in the portlet configuration.

All Operations Center portlets except the Refresh portlet use server profiles.

When the Dashboard communicates with an Operations Center server to retrieve data, the Dashboard uses one user license from that server. Each Operations Center server with which the Dashboard communicates should run the same software version, including the same patch release.

Each server profile establishes a connection between the Dashboard and a specific Operations Center server. The Dashboard Default Profile, a server profile for the default Operations Center server, is created during Dashboard configuration using the Configuration Manager. You must use the Configuration Manager to make any changes to the Dashboard connection with this Operations Center server.
You can use the Operations Center Server Profiles portlet to create and edit additional server profiles. Note that you can remove an Operations Center Server Profile portlet from the web page without deleting the server profile from the Dashboard.

**To create or edit a server profile:**

1. If not already available, add the Operations Center Server Profiles portlet to a Dashboard page. For more information about adding portlets, see Section 6.2, “Adding Portlets,” on page 74.

2. In the Operations Center Server Profiles portlet, click the options icon next to the portlet name and select **Preferences**.

3. Click **Create New Profile**.
   To edit a profile, select it from the drop-down list for **Select Profile Name**, then click **Edit This Profile**.

4. Configure the new profile:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Name</td>
<td>Name that displays on the portlet for the option to select an Operations Center server.</td>
</tr>
<tr>
<td>Icon Name</td>
<td>Only default icons for Operations Center are available.</td>
</tr>
<tr>
<td>RMI Host or IP</td>
<td>Communication settings for the Operations Center server.</td>
</tr>
<tr>
<td>RMI Port</td>
<td></td>
</tr>
<tr>
<td>Web Host or IP</td>
<td></td>
</tr>
<tr>
<td>Web Server Port</td>
<td></td>
</tr>
<tr>
<td>Web Server Protocol</td>
<td></td>
</tr>
<tr>
<td>Use logged in user credentials or User Name and Password</td>
<td>Enter a user name and password or select Use logged in user credentials. Use logged in user credentials provides access control because a user can only access data for which the user has permission in the Operations Center server.</td>
</tr>
<tr>
<td>Make this the default profile</td>
<td>If selected, the Operations Center server defined in this profile is the default Operations Center server used by all portlets when they are added to a page in the Dashboard, unless another profile is specified within the portlet.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
   The profile is available for use by any portlets that support selection of different Operations Center servers.

### 3.9 Understanding Portal Properties Files

As with many systems, properties files are used to configure various default settings for the Dashboard. These are not limited to, but include:

- Database settings

  For more information about configuring the database connection, see Section 2.2.3, “Configuring the Dashboard Database,” on page 19.
• Portal time zone
  For more information about setting the time zone, see Section 2.2.4, “Verifying the Dashboard Default Time Zone for User Accounts,” on page 20.

• Auto-login
  For information about configuring auto-login with your web server, see Section 3.3.1, “Implementing Auto-Login with Your Web Server,” on page 29.

• Session timeout
  For information about setting and disabling session timeout, see Section 3.4, “Setting Session Timeout,” on page 32.

• Synchronization with Operations Center
  For information about access control synchronizer settings, see Section 4.1.2, “Updating Access Control Synchronizer Settings,” on page 45.

• Disabling of self-service user account creation, authentication, and notification settings

• Default home pages for user groups
  For information about configuring a home page based on user groups, sites, and organization memberships, see Section 5.8, “Configuring Default Home for User Groups, Sites, and Organizations,” on page 66.

• Configuration settings for Liferay servlets, portlets, and standard functionality
  For example, set the my.places.max.elements property to set the number of items (sites and organizations) shown in the drop-down list under My Sites.

Liferay portal settings are defined in the portal.properties file. Other settings necessary to integrate Operations Center and Operations Center portlets are defined in the portal-ext.properties file. Do not modify this file, as you might overwrite any update process that is already running. Instead, always make custom configurations in the portal-ext.custom.properties file.

Settings in portal-ext.custom.properties always take precedence over settings in portal-ext.properties, which in turn always take precedence over settings in portal.properties.

For information about customizations you can make to the Dashboard through portal-ext.custom.properties, see http://www.liferay.com/community/wiki/-/wiki/MainPortal+Properties+6.2.

3.10 Deploying Portlets to the Dashboard

You can deploy any portlet that adheres to the JSR-168 standard with Operations Center Dashboard. You can deploy portlets, including new versions of Operations Center portlets, by saving the archive file in a specific Dashboard directory or uploading it using Hot Deploy.

Portlets, layout templates, and themes are deployed by bundling the files into an archive file. A .war file is a standard practice based on Servlet 2.4 specification; see the JSR-168 specification for more information about web application archives and portlets.

The following sections describe the methods of deploying a portlet:

• Section 3.10.1, “Deploying a Portlet with an Archive File,” on page 40
• Section 3.10.2, “Deploying a Portlet using Hot Deploy,” on page 40
3.10.1 Deploying a Portlet with an Archive File

Bundle the new or modified portlet into a .war file and save it to the Operations_Center_Dashboard_installation_path/deploy directory.

You can set the directory to deploy new portlets in the Control Panel under Apps > Manage Apps > Install. If portlets do not deploy as expected, verify your settings.

The new portlet is automatically deployed based on the Interval setting. The default is every 10 seconds. However, you can restart the Dashboard server in order to force an immediate update if necessary.

3.10.2 Deploying a Portlet using Hot Deploy

This section describes how to deploy a portlet using Hot Deploy.

To deploy a portlet using hot deploy:

1. In the Control Panel, click Apps > Manage Apps.
2. Click Install, and then select File Upload.
3. Click Browse to locate the .war file to deploy.
4. Click Install to upload the archive file and deploy the portlet.

3.11 Default Portlet Settings

You can modify global default settings for Operations Center portlets by editing the Operations_Center_Dashboard_installation_path/server/webapps/ManagedObjectPortlets/WEB-INF/data/globals.xml file.

You can specify default settings on a per user basis by making a copy of globals.xml, renaming it as username_globals.xml, and saving it in the same directory. Username_globals.xml file settings apply only to portlets that the specified user adds to a page.

In the XML declarations, each portlet is made up of a set of portlet components where each value has an explanation and in brackets shows the accepted values. For example, in the globals.xml file, the following code snippet shows default height and width declarations for Alarm listings.

```xml
<component>
  <name>alarms</name>
  <preferences>
    <entry>
      <string>width</string>
      <string>400</string>
    </entry>
    <entry>
      <string>height</string>
      <string>300</string>
    </entry>
  </preferences>
</component>
```
Table 3-1 shows the default properties that you can set for portlets in the `globals.xml` file.

**Table 3-1 Default Preferences for Portlets**

<table>
<thead>
<tr>
<th>XML Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>layout</td>
<td>Defaults for layout diagrams. Preference declarations include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>width</strong>: The width of the layout diagram.</td>
</tr>
<tr>
<td></td>
<td>- <strong>height</strong>: The height of the layout diagram.</td>
</tr>
<tr>
<td></td>
<td>- <strong>output</strong>: The output of the layout diagram (such as FLASH).</td>
</tr>
<tr>
<td></td>
<td>- <strong>relationships</strong>: The diagram should display the relationships browser (True or False).</td>
</tr>
<tr>
<td>alarms</td>
<td>Defaults for all alarms listings. Preference declarations include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>width</strong>: The width of the embedded alarms control.</td>
</tr>
<tr>
<td></td>
<td>- <strong>height</strong>: The height of the embedded alarms control.</td>
</tr>
<tr>
<td>elementselector</td>
<td>Default element for single element portlets. Preference declarations include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>identity</strong>: The DName of the element to be used as the starting element for all portlets that have an initial element as a starting point. If this option is not set, then the portlet selects the first home element of a user. If a home element has not been specified, then the Services element is used (root=Organizations).</td>
</tr>
<tr>
<td>elementsselector</td>
<td>Default elements for multi-element portlets. If this option is not active, then the list of elements is populated with all of the home elements for the logged in user. If the user does not have a home element, an empty list is displayed. Preference declarations include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>total</strong>: The total number of elements shown.</td>
</tr>
<tr>
<td></td>
<td>- <strong>identity0</strong>: The DName of the first element to be used.</td>
</tr>
<tr>
<td></td>
<td>- <strong>identityX</strong>: Specify additional DNames, defining name as <code>identitynumber</code> where <code>number</code> continues until 1, minus the specified value of total.</td>
</tr>
<tr>
<td>navigation</td>
<td>Default element for all portlets displaying an element navigation tree. There are no preference declarations made by default.</td>
</tr>
<tr>
<td>performance</td>
<td>Defaults for all performance chart portlets. Preference declarations include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>width</strong>: The width of the performance chart.</td>
</tr>
<tr>
<td></td>
<td>- <strong>height</strong>: The height of the performance chart.</td>
</tr>
<tr>
<td></td>
<td>- <strong>chartWidth</strong>: The width of the charts.</td>
</tr>
<tr>
<td></td>
<td>- <strong>chartHeight</strong>: The height of the charts.</td>
</tr>
</tbody>
</table>
3.12 Granting or Denying Access to Portlets

The Dashboard adheres to a JSP standard and is designed to be personalized. It offers many portlet options, including those that leverage Operations Center data as well as other third-party portlets offering various types of functionality. As an administrator, you can grant or restrict access to each portlet.

To restrict the use of a portlet based on user roles:

1. In the Control Panel, select Apps > Plugins Configuration.
2. By default, all portlets have the role User, which allows all users access to the portlet. Complete the following actions to restrict or grant access to a portlet:
   - Click the link for the desired portlet.
   - To make the portlet unavailable to all users, deselect Active.
   - To grant access based on specific roles, specify the role names in the area provided. Users assigned to the roles listed can add the portlet to their web pages.
   - Click Save.

While not a best practice, you can configure permissions for a specific instance of a portlet. For more information, see Section 12.2.2, “Assigning Individual Permissions to a Portlet,” on page 171.
User and group accounts from the Operations Center server are leveraged by the Dashboard so it is important to understand how these accounts are synchronized and configured. The following sections provide important details regarding the interaction between Operations Center and the Dashboard as well as account permissions and user account structure:

- Section 4.1, “Operations Center and Dashboard Interaction,” on page 43
- Section 4.2, “Understanding User Account Requirements,” on page 46
- Section 4.3, “Configuring Dashboard User Account Structure,” on page 47
- Section 4.4, “Managing User Accounts,” on page 54
- Section 4.5, “Understanding User Sign On,” on page 56
- Section 4.6, “User Maintained Account Settings,” on page 56

### 4.1 Operations Center and Dashboard Interaction

User and group accounts from the Operations Center server are leveraged by the Dashboard to give users access to the Dashboard portal pages and Operations Center data via the Dashboard portlets. Limited status information on specific elements can be seen using the Public User End View portlet without logging into the Dashboard.

Operations Center and the Dashboard use the same user and group accounts. User accounts are organized into groups that exist both in Operations Center and in the Dashboard.

Because the same user accounts are used by both Operations Center and the Dashboard, actions performed on a user account in the Dashboard impact the account in Operations Center and vice versa.

While actions performed on user groups in Operations Center impact the groups in the Dashboard, the reverse is not true. Because of this, groups in the Dashboard can be organized into a different structure designed to follow your corporate hierarchy.

User accounts can be managed (created and edited) by administrators and by users themselves.

User accounts have different permissions in the Dashboard and Operations Center. The permissions in Operations Center determine the Operations Center content that the user can access in the Dashboard. Permissions to administer the dashboard, must be set in the Dashboard control panel.

- Section 4.1.1, “Understanding User and Group Synchronization,” on page 44
- Section 4.1.2, “Updating Access Control Synchronizer Settings,” on page 45
- Section 4.1.3, “Understanding the Use of the Default Admin Account,” on page 45
- Section 4.1.4, “Understanding Access and Permissions for User Accounts,” on page 45
4.1.1 Understanding User and Group Synchronization

Both user accounts and groups are synchronized between the Operations Center server and the Dashboard. There are two accounts in the Operations Center server that have a special use in the Dashboard: *admin* and *guest*.

During the first synchronization (on initial Dashboard server start up), all users and groups from the Operations Center server are imported into the Dashboard, setting up the same user/group associations in the Dashboard. Subsequent synchronizations vary based on whether the action is on a user account or group and where the action is taken.

Any Admin accounts imported from Operations Center, must be given Dashboard administrative permissions from the Dashboard control panel. For example, after the initial synchronization of accounts, give the Admin group administrative permissions in the Dashboard.

Table 4-1 details the action or location of a user or group and the resulting synchronization:

<table>
<thead>
<tr>
<th>Action/Location</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>User account actions in Operations Center</td>
<td>Users updated/deleted in Operations Center are updated/deleted in the Dashboard during the next synchronization.</td>
</tr>
<tr>
<td>User account actions in the Dashboard</td>
<td>The following actions taken in the Dashboard immediately have the same effect on the Operations Center server:</td>
</tr>
<tr>
<td></td>
<td>• Add, edit, or delete user accounts</td>
</tr>
<tr>
<td></td>
<td>New users accounts are automatically added to the users group in the Operations Center server.</td>
</tr>
<tr>
<td></td>
<td>• Change user account settings</td>
</tr>
<tr>
<td></td>
<td>For important information about passwords, see Section 4.2.3, “Understanding Password Policy,” on page 47.</td>
</tr>
<tr>
<td></td>
<td>The following actions in the Dashboard have no corresponding effect in the Operations Center server:</td>
</tr>
<tr>
<td></td>
<td>• Deactivate users</td>
</tr>
<tr>
<td></td>
<td>• Restore users</td>
</tr>
<tr>
<td>Group actions in Operations Center</td>
<td>Users removed from groups in the Operations Center server are removed from groups in the Dashboard during the next synchronization.</td>
</tr>
<tr>
<td>Group actions in the Dashboard</td>
<td>Groups that are deleted in the Dashboard are not deleted in Operations Center. Changes made to group membership in the Dashboard are not made to groups in Operations Center. Any groups created in the Dashboard are not maintained and are automatically deleted by the Dashboard.</td>
</tr>
</tbody>
</table>

Dashboard user profiles are assigned a default time zone based upon a global setting in the `system-ext.properties` file. For more about the time zone setting, see Section 2.2.4, “Verifying the Dashboard Default Time Zone for User Accounts,” on page 20. Users can later update this selection manually in their control panel.
4.1.2 Updating Access Control Synchronizer Settings

The first time that the Access Control Synchronizer runs (on initial Dashboard server start up), all the user accounts and groups from the Operations Center server are downloaded to the Dashboard, except those user accounts that have Web access restricted.

The Access Control Synchronizer continues to synchronize with the Operations Center server at specified intervals to maintain all users and groups. When each user logs into the Dashboard, their user account is automatically synchronized.

To update synchronization settings:

   
   For more information about the `portal-ext.custom.properties` file, refer to Section 3.9, “Understanding Portal Properties Files,” on page 38.

2. Add and update synchronizer properties as required:
   
   - `mo.acl.synchronizer.enabled`: Enables the synchronization of users and groups between Operations Center and the Dashboard. Default is True.
   
   - `mo.acl.synchronizer.interval`: The time, in milliseconds, between each synchronization. Default is 300000, which equates to every 5 minutes.

   Because the synchronizer synchronizes all accounts, consider the number of Operations Center users and groups as well as how often user and group information changes when setting this property.

   - `mo.acl.synchronizer.on.login.enabled`: Enables the synchronization of all user accounts whenever any user logs in. If enabled, the login process could take longer depending on the number of Operations Center users. If set to False, only the user's account is synchronized on login.

   - `mo.acl.synchronizer.keepUserGroupSynchronized`: If enabled, actions taken on groups in Operations Center are also taken on groups in the Dashboard the next time synchronization runs. If set to False, groups are update with changes from the Operations Center server.

3. Restart the Dashboard server for the changes to take affect. For more information, see Section 2.3.1, “Starting the Dashboard,” on page 25.

4.1.3 Understanding the Use of the Default Admin Account

The Dashboard uses the default `admin` account to communicate with the Operations Center server. This account must have full privileges in Operations Center. The guest account in Operations Center is also used. For more information, see Section 3.5, “Changing the Dashboard Account for Persistent Connection,” on page 34.

4.1.4 Understanding Access and Permissions for User Accounts

Because the Dashboard and Operations Center use the same user accounts, they are subject to two different sets of permissions in the Dashboard as follows:

- **Dashboard Permissions**: These are relevant to all functionality in the Dashboard.

  When user accounts are created in the Dashboard and thus added to the Operations Center server, the user is automatically added to the users group in the Operations Center server and receives all permissions assigned to the users group. These accounts are automatically set to have restricted access to the Operations Center console. This means that the user can only log
in to the Dashboard or another Operations Center Web client; the user cannot log in to the Operations Center console. For more information on how access is restricted, see the Operations Center Security Management Guide.

Any Admin accounts imported from Operations Center, must be given administrative accounts in the Dashboard, to administer the Dashboard. For example, after the initial synchronization of accounts, you can give the Admin group administrative permissions in the Dashboard.

- **Operations Center Permissions:** These are relevant for determining the data in the Operations Center server that the user can access.

Operations Center permissions cannot be changed in the Dashboard. To change permissions to Operations Center, you must access the permissions in the Operations Center console. For more information on permissions in Operations Center, see the Operations Center Security Management Guide.

When user accounts are added in Operations Center and given access to the portal, these users are automatically assigned to the users group in the Dashboard and are assigned to two roles: User and Power User. For more information on these roles, see Section 12.1, “Assigning Permissions Using Roles,” on page 167.

### 4.2 Understanding User Account Requirements

You need to specify a user name, password, and unique e-mail address for the Dashboard user accounts. For more information about requirements, see the following sections:

- Section 4.2.1, “Understanding User Name Restriction,” on page 46
- Section 4.2.2, “Understanding Unique E-Mails,” on page 46
- Section 4.2.3, “Understanding Password Policy,” on page 47

#### 4.2.1 Understanding User Name Restriction

A user account for the Dashboard cannot have a use name that contains the domain name managedobjects.com. The Dashboard uses this domain name for a reserved user account.

If there is a user with this domain name in the Operations Center server, it does not synchronize with the Dashboard and an error is outputted to the trace logs. For more information, see Section D.1.1, “User ID Exception – Unable to Synchronize User,” on page 205.

#### 4.2.2 Understanding Unique E-Mails

In order for the synchronization of users to occur in the Dashboard with the Operations Center server, the user account in Operations Center must have a unique, valid e-mail address.

**IMPORTANT:** User accounts must contain a valid, unique e-mail address to correctly synchronize between Operations Center server and the Dashboard.

A valid e-mail address follows this pattern: `__@__` where `__` is a character. A valid e-mail address does not contain any spaces and has only one `@` sign.

User accounts in the Operations Center server are not required to have e-mail addresses. When user accounts are synchronized with the Operations Center server, if the Dashboard encounters an account without an e-mail address, it creates an e-mail address similar to the following:

`incrementalcount@NetIQ.com`
During the user synchronization, if the Dashboard encounters a user account with an e-mail address that already matches an e-mail address for an existing account in the Dashboard, the Dashboard attempts to address the problem by adding "generated_" to the beginning of the e-mail address. However, if there are multiple e-mail addresses that are the same, the Dashboard won’t be able to correct them and there will be errors.

### 4.2.3 Understanding Password Policy

The Dashboard uses account information including passwords from the Operations Center server. How the Operations Center server handles passwords depends on the type of account:

- **Native Accounts**: In Operations Center, these accounts are stored and authenticated in the Operations Center server. For these accounts, the Operations Center administrator can set password policies.
- **External Accounts**: These accounts are stored in an external directory that are authenticated using LDAP. For these accounts, Operations Center does not store any password information.

When an account is created in the Dashboard, the account is a native account in Operations Center. The Dashboard enforces the password policy for Operations Center native accounts by default. If a password is entered during the account creation that does not match the password policy, then the account is not created.

Dashboard administrators as well as the users themselves can change passwords for user accounts in the Dashboard if the account is a native account in Operations Center. The Dashboard verifies that the password follows Operations Center password policy and allows the change if it does. If it does not, the Dashboard displays an error message and the password is not changed. If the account is an external account in Operations Center, the Dashboard does not show an option to change the password.

For information on how to create user accounts and change passwords, see Section 4.4, “Managing User Accounts,” on page 54.

### 4.3 Configuring Dashboard User Account Structure

Before a user logs in, all users are considered a guest. The Operations Center guest account is used to display the default home page.

User accounts in the Dashboard are organized two ways:

- By a structure that represents the corporate hierarchy
- By groups

Groups from Operations Center are imported into the Dashboard automatically. Changes made to groups in the Dashboard do not impact the group in Operations Center. However, by default, changes made to groups in Operations Center do impact the group in the Dashboard; this setting can be changed in Section 4.1.2, “Updating Access Control Synchronizer Settings,” on page 45.

The following sections review how you might organize the Dashboard user accounts into corporate hierarchy structure or configure the Dashboard groups:

- Section 4.3.1, “Understanding the Dashboard Portal Architecture,” on page 48
- Section 4.3.2, “Configuring Corporate Hierarchy via Organizations and Locations,” on page 50
- Section 4.3.3, “Configuring Groups,” on page 53
4.3.1 Understanding the Dashboard Portal Architecture

The following addresses the relationship between the various entities that define the portal architecture.

- Portals are accessed by Users.
- Users can be collected into User Groups.
- Users can belong to Organizations.
- Organizations can be grouped into hierarchies, such as Home Office -> Regional Office -> Satellite Office.
- Users, Groups, and Organizations can belong to Sites that have a common interest.

The simplest way to think about this is that you have users and various ways those users can be grouped together. Some of these groupings follow an administratively organized hierarchy, and other groupings can be done by the users themselves (such as different users from multiple organizations starting a site called “Dog Lovers” that has a common interest in dogs). And other groupings can be done administratively via Roles for other functions that might cut across the portal (such as a Message Board Administrators role made up of users from multiple sites and organizations, allowing those users to administer any message board in the portal).

This way of organizing portal concepts can be illustrated in the following manner:

In the illustration above, each arrow can be read as “can be a member of.” So this means that Organizations can be members of Sites, Sites can be members of Roles, Users can be members of anything, and so on. Though this seems very complex, it provides a powerful mechanism for portal administrators to configure portal resources and security in a consistent and robust manner.

It is important to note that the diagram illustrates only users and their collections. Permissions do not flow through all of these collections: permissions can be assigned to roles only.
Users

Users can be collected in multiple ways. They can be members of organization hierarchies, such as Your Company, Inc. > Security > Internet Security. They can be collected into arbitrary user groups, such as Bloggers, which would enable them to create blog entries in their personal space. They can be members of sites which draw together common interests. And they can have roles which describe their functions in the system, and these roles can be scoped by Portal, Organization, or Site.

For more information about the Dashboard user accounts including default user associations, see Section 4.4, “Managing User Accounts,” on page 54.

User Groups

User groups are simple, arbitrary collections of users, created by administrators. They can be members of sites or roles. Permissions cannot be assigned to user groups. Though user groups do not have pages like some of the other collections of users (such as sites or organizations), they do have page templates which can be used to customize users’ personal sets of pages.

For more information about user groups, see Section 4.3.3, “Configuring Groups,” on page 53.

Roles

There are three kinds of roles:

- Portal Roles
- Organization Roles
- Pages Site Roles

These are called role scopes. Roles are used to define permissions across their scope: across the portal, across an organization, or across a site. For example, consider a role which grants access to create a Message Board category. A Portal role would grant that access across the portal, wherever there was a Message Board portlet. A site role would grant that access only within a single site. An Organization role would grant that access only within an Organization.

Because Roles are used strictly for portal security, they also do not have pages, like Sites and Organizations.

Users, User Groups, Sites, or Organizations can be members of a role.

For more information about roles, see Chapter 12, “Portal and Site Permissions,” on page 167.

Organizations

Organizations are hierarchical collections of Users. They are one of the two types of portal resources that can have pages. There is also a special type of Organization called a location, which can define where users are specifically located.

Organizations are useful for defining where a user belongs in a particular hierarchy. For example, if implementing the portal for a large organization, it might help to define user Joe Smith via his position in the organization chart. If Joe Smith is a Sales Engineer located in the New Jersey office, working in the North East division of the Sales department, he might be a member of the following organizations:

- Sales
- North East Division
- New Jersey Location
Then, if you add an Asset Publisher portlet as a static portlet on every user's home page (via a User Group page template) you can inform employees of various announcements via the content management system. If content is tagged appropriately, Joe Smith gets any announcements that are meant for Sales, the North East Division, or the New Jersey location.

Organizations can be members of Sites.

For more information about organizations, see Section 4.3.2, “Configuring Corporate Hierarchy via Organizations and Locations,” on page 50.

Sites

Sites are collections of Users who have a common interest. The Dashboard's default pages are in the Guest site, because everyone—whether they are anonymous or members of the portal—has a common interest in the default, public pages of your site. There are three types of Sites:

- Open
- Restricted
- Hidden

An Open site (the default) allows portal users to join and leave the site whenever they want to, using the Control Panel or a Sites portlet added to a page to which they have access. A Restricted site requires that users be added to the site by a site administrator. Users can use the Control Panel or the Sites portlet to request membership. A Hidden site is just like a Restricted site, with the added concept that it does not show up at all in the Sites portlet or the Control Panel.

For more information about sites, see Chapter 5, “Personal Pages, Page Configurations, and Sites,” on page 57.

4.3.2 Configuring Corporate Hierarchy via Organizations and Locations

Organizations are hierarchical collections of Users. They are one of the two types of portal resources that can have pages. There is also a special type of Organization called a location, which can define where users are specifically located.

An example of an organization is Operations Center USA. Organizations can have any number of sub-organizations or locations. Example locations of the Operations Center USA organization are Operations Center Chicago, Operations Center San Francisco, and Operations Center Los Angeles.

The following sections cover managing organizations and locations:

- “Understanding Organizations and Locations” on page 51
- “Adding an Organization or Location” on page 51
- “Configuring an Organization” on page 52
- “Searching for an Organization” on page 52
Understanding Organizations and Locations

Dashboard organizations are intended to model organizations in real life. They can be used to represent different companies, non-profit organizations, churches, schools, clubs, and so on. They have been used to represent a sports league, with various sports (soccer, baseball, basketball, etc.) and their teams as sub-organizations. If you have a set of users that belong to the same grouping, you can model as an organization.

Your dashboard can have any number of organizations, depending on the kind of site you are building. For example, a corporate site can model its own organization hierarchy, while a social networking site can have users from many various organizations who access the site. Organizations can have a hierarchy to unlimited levels, and Users can be members of one or many organizations—inside of a hierarchy or across hierarchies.

Additionally, Organizations can be associated with Roles. For example, an IT Security group of a company. You can have an organization within your IT organization that handles security for all of the applications company-wide.

If you had users as members of this organization, you could grant the Administrator role you just granted to your own ID to the whole Organization, thereby giving the members of the IT Security organization administrative access to the portal. If a user in this organization later was hired by the Human Resources department, the simple administrative act of moving the user from the IT Security organization to the HR organization would remove this privilege from the user, since the user would no longer be in an organization that has the Administrator role. By adding the user to the HR organization, any roles the HR organization has (such as access to a benefits system in the portal) would be transferred to the user. In this manner, you can design your portal to correspond with your existing organization chart, and have users’ permissions reflect their positions in the chart.

Of course, this is only one way to design it. If you have more complex requirements, you can combine Organizations with User Groups and scoped Roles to assemble the sets of permissions you wish to grant to particular users.

Organizations are one of two types of resources (the other being Sites) that can have its own pages. This allows members of the organizations (if they are granted the Manage Pages permission) to maintain their own pages. They can have a set of public pages which include information and applications appropriate for guests or logged in users who are not members of the Organization to make use of (such as a help desk ticket entry system for an IT page), and they can have a set of private pages with applications for the organization’s own use (such as the back-end portlets of the same ticketing system).

Adding an Organization or Location

To add an organization or location:

1. From the Control Panel, under Users, select Users and Organizations.
2. Click Add and then select Regular Organization or Location.
3. Specify a name for the new organization in the Name field.
4. Specify whether the new organization is a regular organization or location in the Type drop-down list.
5. If the organization is a location, select a Country and Region.
6. To specify a parent organization, click Select. A list opens to select the organization that is the direct parent of the organization. Click the Remove button to remove the currently configured parent.
7 Click Save.

The page shows additional options for entering information. Use the links to provide contact information about the organization: e-mail addresses, mailing addresses, Web sites and phone numbers.

**Configuring an Organization**

To configure an organization:

1 From the Control Panel, under Users, select Users and Organizations.
2 Click Actions next to the organization and select from the options to update and configure the organization.
   - **Edit**: Edit organization information.
   - **Manage Pages**: Lets you create and manage public and private pages for the Organization.
   - **Assign User Roles**: Lets you assign Organization-scoped roles to users. By default, Organizations are created with three roles: Organization Administrator, Organization Member, and Organization Owner. You can assign one or more of these roles to users in the organization. All members of the Organization get the Organization Member role.
   - **Assign Members**: Search and select users in the portal to be assigned to this organization as members.
   - **Add User**: Add new users in the portal who will be a member of this organization.
   - **View Users**: List of users who are members of this organization.
   - **Add Regular Organization**: Add a child organization to this organization to create hierarchies of organizations with parent-child relationships.
   - **Add Location**: Add a child Location, which is a special type of organization that cannot have any children added to it.
   - **View Suborganizations**: View all organizations that are children of this organization.
   - **Delete**: Deletes this organization from the portal. Make sure to verify that the organization has no users in it first.
3 Click Save.

**NOTE**: You are already a member of the organizations you create. By creating an organization, you become both a member and have the Organization Owner role, which gives you full rights to the organization.

**Searching for an Organization**

To search for an organization:

1 From the Control Panel, under Users, select Users and Organizations.
2 Enter the search criteria in the search field.
3 Click Advanced to enter additional information such as address, region, type, or country; and specify how to match. Select All to find organizations that contain all search criteria, or Any to find organizations that contain at least one of the search criteria.
4 Click Search.

The results display at the bottom of the page.
4.3.3 Configuring Groups

Groups are designed to be a convenient mechanism for assigning users to sites and assigning permissions to users. Users can be members of one or more groups.

- “Understanding Groups” on page 53
- “Creating User Groups and Assigning Users” on page 53
- “Configuring Groups” on page 53

Understanding Groups

Groups are created and assigned like user accounts in the Dashboard. User Groups are arbitrary groupings of users. These groups are created by portal administrators to group users together who don't have an obvious organizational or site-based attribute or aspect which brings them together. Groups cannot have permissions like roles, but User Groups can be added to Roles. Why would you use User Groups, then? They come into play when you have complex security requirements and for page templates.

Creating User Groups and Assigning Users

Use the Operations Center console to create user groups and assign users. Any groups manually created in the Dashboard are automatically deleted.

For information on creating users and groups, see “User and Group Accounts” in the Operations Center Security Management Guide.

Configuring Groups

IMPORTANT: Actions taken on groups in the Dashboard (such as creating, updating, or deleting groups) do not impact the group in the Operations Center server. However, by default, changes made to groups in Operations Center do impact the group in the Dashboard.

To configure a group:

1. From the Control Panel, under Users, select User Groups.
2. Click Actions next to the group and select from the options to update and configure the group.
   - **Edit:** Modify the name or description of the group.
   - **Permissions:** Define which Users, User Groups, or Roles have permissions to edit the group.
   - **Manage Pages:** User Groups don't have pages of their own, you can create page templates for a group. When a User Group has page templates, any users added to the group will have the group's pages copied to their personal pages. This allows you to do things like create a Bloggers user group with a page template that has the Blogs and Recent Bloggers portlets on it. The first time users who are added to this group log in to the portal, this page is copied to their personal pages. They automatically have a blog page that they can use.
   - **Assign Members:** Search for and select users in the portal to be assigned to the group.
   - **View Users:** View all users in a group.
   - **Delete:** Deletes the group.
3. Click Save.
4.4 Managing User Accounts

Managing user accounts involves the following:

- Creating users
- Editing user settings including passwords
- Deactivating and activating users
- Deleting users

Administrators can create users for their entity in the corporate hierarchy. The Dashboard also has functionality to allow users to create their own accounts (such as self-service account creation).

User accounts created in the Dashboard are automatically added to the Operations Center server and assigned to the users group. The user account is restricted to accessing only to the Operations Center Dashboard.

If there are specific e-mail addresses and/or user IDs that should not be used, identify them as reserved. These options can be found on the Control Panel under Settings > Reserved Credentials.

**NOTE:** When you create or delete users or alter user settings, the action applies to user accounts in the Operations Center server. Deactivating and activating users impacts the user account only in the Dashboard and has no impact on the user account in Operations Center.

- Section 4.4.1, “Default Associations for User Accounts,” on page 54
- Section 4.4.2, “Creating User Accounts,” on page 54
- Section 4.4.3, “Activating, Deactivating, and Deleting Accounts,” on page 56

4.4.1 Default Associations for User Accounts

It is possible to select a default user group, sites, and roles for all new users that are created in the dashboard.

To automatically assign all new users to one or more user groups, sites, or roles:

1. From the Control Panel, under Configuration, select Portal Settings.
2. On the right, select Users.
3. Select Default User Associations.
   - Automatically assign new users to one or more user groups, sites, or roles. In the applicable fields, enter one or more names, one per line.
4. Click Save.

4.4.2 Creating User Accounts

Administrators can create and edit accounts for users through the Control Panel. By default, all new users are automatically active. Note that most users won’t be able to perform most of the operations or have access to the Control Panel. Only those with administrative can perform all of the functions.

- “Adding a User” on page 55
- “Configuring User Accounts” on page 55
- “Searching for Users” on page 56
Adding a User

To add a new user:

1. From the Control Panel, under Users, select Users and Organizations.
2. Click Add and select User.
3. Specify user details in the fields provided.
   - First name, last name, e-mail address, and screen name are required.
4. Click Organizations to select any organizations and/or locations for the user.
5. Click Save.
   - When the user ID is created, a password is automatically generated and an e-mail message with the password in it is sent to the user if the SMTP mail server connection was setup properly.
6. If you have not yet set up your mail server, click Password to change the default password for the user ID to something you can remember and send to the user.
   - Click Save after making changes.
7. Click Roles to assign administrative rights to the user if necessary. By default, all users are also assigned the Power User role. You can give this role certain permissions if you wish or disable it altogether.
   - Click Select to select any additional roles for the user.
   - Click Save after making changes.

**NOTE:** When a new user is added, the same user account is added to the Operations Center server and is automatically given access to the Operations Center Dashboard and placed in the user’s group.

Configuring User Accounts

To configure a user account:

1. From the Control Panel, under Users, select Users and Organizations.
2. Click Actions next to the user and select from the options to update and configure the user account.
   - **Edit:** Modify the user account.
   - **Permissions:** Define which Roles have permissions to edit the user.
   - **Impersonate User:** Browse the site as though you were the user in a new browser window.
   - **Deactivate:** Deactivate the user account.
3. Click Save.
Searching for Users

When you have a long list of users, you can search for a specific user.

To search for a user:

1. From the Control Panel, under Users, select Users and Organizations.
2. Enter search criteria in the Search field.
   - Click Advanced to define additional search criteria.
3. Click Search to find any users matching the criteria.

4.4.3 Activating, Deactivating, and Deleting Accounts

Using the Control Panel, you can deactivate accounts, which prevents a user from logging in to the Dashboard. You can also restore the account so it is active. These actions do not affect the user account in the Operations Center server.

After an account has been deactivated, you can permanently delete it. A user account deleted in the Dashboard is also deleted in the Operations Center server.

To activate, deactivate or delete a user account:

1. From the Control Panel, under Users, select Users and Organizations.
2. Do any of the following:
   - To deactivate a user account, click Actions and select Deactivate next to the user’s name.
   - To restore a user account that has been deactivated, click No for the Active drop-down list in advanced search options, then click Search to view all deactivated users.
     - Click Actions and select Activate.
   - To delete a user account, first deactivate the account, then in the user list for accounts that are not active, click Actions and select Delete.

4.5 Understanding User Sign On

Users must sign into the portal with user name and password of a valid Dashboard account to access the Dashboard. User name and password can be entered into the Dashboard one of two ways:

- **Sign In portlet:** The Sign In portlet appears on the home page of the Dashboard by default and allows users to enter the user name and password that the Dashboard uses to grant access.
- **Auto-login:** The Dashboard has auto-login functionality that supports Single Sign-On (SSO) capability, which allows users to log in just once into the system and gain access to various resources. If a user has already logged in, that user does not need to log in again to gain access to the Dashboard. Auto-login must be configured. For more information, see Section 3.3.1, “Implementing Auto-Login with Your Web Server,” on page 29.

4.6 User Maintained Account Settings

After a user has logged into the Dashboard, that user can access account settings and make changes. The option to edit your password is only available if the user account is a native account in Operations Center. For important information, see Section 4.2.3, “Understanding Password Policy,” on page 47.
Dashboard pages can be considered as desktops where portlets are added. These include personal pages for individual users and shared pages among multiple users. Shared pages are grouped together into sites. Sites offer content to users with a similar interest or skill.

Users can have both personal and shared pages. They switch between personal pages and sites using a link.

- Section 5.1, "Customizing Default Personal Pages," on page 57
- Section 5.2, "Creating and Maintaining Sites," on page 59
- Section 5.3, "Adding Pages," on page 61
- Section 5.4, "Site Provisioning," on page 62
- Section 5.5, "Assign Users to a Site," on page 63
- Section 5.6, "Changing Page Layout," on page 65
- Section 5.7, "Changing the Look and Feel," on page 65
- Section 5.8, "Configuring Default Home for User Groups, Sites, and Organizations," on page 66
- Section 5.9, "Importing and Exporting Data and Configurations from User Groups, Sites, or Organizations," on page 69

5.1 Customizing Default Personal Pages

Personal pages are Web pages that can be viewed and modified by a single user only. When a user logs in on the Dashboard home page, the user's personal pages appear. Personal pages, and the portlets on them, are accessible only to that user. No other users, including administrators, can access these pages.

NOTE: The information from a portlet in a personal page can only be viewed by the page owner, even if view permissions are granted to other users. For example, in the case of a Calendar portlet, only the page owner could view the events on the calendar. To share information, place portlets on site or public pages.

To have personal pages, a user must be assigned the role of power user. For more information, see Section 12.1, "Assigning Permissions Using Roles," on page 167. For information on how to add pages, customize the look and feel of those pages and add content, see Chapter 6, "Adding Content to a Page Using Portlets," on page 71.
By default, power users have their own personal Web pages.

To modify the default setup of the power users personal Web page:

1. Add the following properties in the `OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.custom.properties` file:

   ```
   ## Default User
   ##
   # Users who have the Power User role must have at least one private
   personal # page. The settings for the initial private page are specified in the
   # following properties.
   #
   # Set the layout name.
   #
   default.user.layout.name=Home
   #
   # Set the layout template id that matches an existing TPL.
   #
   #default.user.layout.template.id=1_2_1_columns
   #default.user.layout.template.id=1_column
   #default.user.layout.template.id=2_2_columns
   #default.user.layout.template.id=2_column_i
   #default.user.layout.template.id=2_column_ii
   #default.user.layout.template.id=2_column_iii
   #default.user.layout.template.id=3_column
   #
   # Set the layout ids for the column specified in the layout template.
   #
   #default.user.layout.column-1=mo_alarms_WAR_ManagedObjectsPortlets,23,61,65,
   default.user.layout.column-2=8,11,36,33,
   default.user.layout.column-3=
   default.user.layout.column-4=
   #
   # Enter either "800x600" or "1024x768" to set the layout resolution.
   #
   default.user.layout.resolution=800x600
   ```

   In the above code, the following lines define the portlets and the columns where the properties can be displayed:

   ```
   default.user.layout.column-1=mo_alarms_WAR_ManagedObjectsPortlets,23,61,65,
   default.user.layout.column-2=8,11,36,33,
   default.user.layout.column-3=
   default.user.layout.column-4=
   ```

2. To find a listing of all Operations Center portlets and determine their names to reference them, look at the `OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/portlet.xml` file.

   Use the `<portlet-name>` in the list followed by `_WAR_ManagedObjectsPortlets` as shown above in the code sample for the mo_alarms portlet.
5.2 Creating and Maintaining Sites

Sites are very much like Organizations except that they are not hierarchical. They are designed instead to be islands to themselves which anyone from any organization (or from no organization at all) can join. Use Sites in any situation where you need to cut across the organizational structure of your portal, or where you have a site that would apply to almost anybody. For example, the home page for the Intranet is probably best placed in a site that any member of the portal can access.

Sites are groupings of pages and users based on shared interests or skills. And, a user can belong to any number of sites. Examples of sites might include:

- A human resources site where staff members discuss issues related to health insurance.
- A tech support site of users who have the skills to provide technical support to an organization.
- A marketing site where marketing personnel shares marketing and corporate information.

The Dashboard default home page is in a site called Guest, and this is where you would put your public web site. As you can see, there are several scenarios in which you would want to use something like a site instead of an organization, and this is why they have a distinct role within Liferay Portal.

Sites can be created and managed in two ways. The first is through the Control Panel, like every other user/page collection. The second is through the My Sites portlet, which can be added to any page. Why two ways? Because the My Sites portlet also doubles as a way to navigate from site to site, and allows users to browse the list of sites.

Permissions can be assigned to users to delegate site management tasks. For more information, see Chapter 12, “Portal and Site Permissions,” on page 167.

Every site must have at least one page (represented by a tab) to be active, but there is no limit on the number of pages that a site can have.

After a site is named, define its characteristics and add content pages. Consider the following:

- Every site must have at least one page (represented by a tab) to be active, but there is no limit on the number of pages that a site can have.
- Pages can be private or public. A public page can be accessed by a guest who has the appropriate URL. A private page can only be accessed by users who are logged in and assigned to the site.
- URLs must be defined for public and private pages.
- A default look and feel can be set for all private and public pages.

NOTE: You are already a member of the organizations you create. By creating an organization, you become both a member and have the Organization Owner role, which gives you full rights to the organization.

To create and configure sites:

- Section 5.2.1, “Creating a New Site,” on page 60
- Section 5.2.2, “Performing Actions on a Site,” on page 60
- Section 5.2.3, “Updating Site Settings,” on page 60
5.2.1 Creating a New Site

To create a site:

1. From the Control Panel, under Sites, select Sites, click Add, and then select Community Site.
2. Name the new site and optionally add a description.
3. Under Membership Type, select one of the following to indicate the type of site:
   - **Open**: Appears in the My Sites portlet and users can join and leave the site whenever they want.
   - **Restricted**: Appears in the My Sites portlet but users must request membership and be approved before joining.
   - **Private**: Does not appear in the My Sites portlet. A site administrator manually adds users.
4. Deselect the Active check box to deactivate the site.
5. Select Categorization and specify keywords in the Tags field to identify the site and leverage the portals tagging feature.
6. Click Save.

5.2.2 Performing Actions on a Site

To configure a site:

1. From the Control Panel, under Sites, select Sites.
2. Click Actions next to the site and select from the options to update and configure the site.
3. Click Save.

5.2.3 Updating Site Settings

Various settings can be configured for each site including a friendly URL, a custom logo, generation of a sitemap structure to notify search engines, and monitoring through Google Analytics.

To update the settings for a site:

1. From the Control Panel, under Sites, select Sites.
2. Click Actions next to the site and select Site Administration.
3. Under Configuration, select Site Settings.
4. Select from the following options to specify settings for the site:
   - **Staging**: Activate staging.
   - **Site URL**: Specify a public and private virtual host that maps to the public and private friendly URL. Also specify a friendly URL that is used for both public and private pages.
   - **Sitemap**: Generate a sitemap to notify Google and Yahoo of the structure of the site pages.
   - **Analytics**: Specify a Google Analytics ID to setup tracking for site pages in an existing Google Analytics configuration.
5. Click Save.
5.3 Adding Pages

Pages can be added to a site in a hierarchy that creates pages under an existing page. It is possible to rearrange the order of child pages. The pages in the top-level of the hierarchy are added as tabs in the site. Pages that are children of a top-level page do not display on the tab unless a Navigation portlet is added to that tab.

Web pages can be personal or associated with a site.

- **Adding**: Add pages to personal or site pages using Manage Pages. Using this option, it is possible to add pages to the current site only. Pages can be added to other sites by using the My Sites portlet.
- **Exporting**: Export the pages of a site using Manage Pages.
- **Importing**: Import pages to a site using Manage Pages or the My Sites portlet. Importing a page overwrites all the pages in the site. Take caution, because importing a page overwrites the current page and thus discontinues access to the Dashboard. For more information on export and import options for a site, see Section 5.2, “Creating and Maintaining Sites,” on page 59.

When building Web pages, particularly when adding portlets to add content, consider how the content is viewed. Users can view dashboard Web pages using a variety of devices, including mobile phones.

A user’s ability to add pages depends on the permissions assigned to the user. For more information, see Chapter 12, “Portal and Site Permissions,” on page 167.

To make it easier to create a page, copy an existing page and save it as a new page using the Copy option. This option is available on the Page tab.

- **Section 5.3.1, “Adding Child Pages,” on page 61**
- **Section 5.3.2, “Editing an Existing Page,” on page 62**

5.3.1 Adding Child Pages

To add child pages:

1. Click the options icon next to the site name, select Admin, and then select Site Administration.
2. Under Pages, select Site Pages.
3. Select the parent page, and then click Add Child Page.
4. Provide the page name.
5. If the page is to be hidden, select Hide from Navigation Menu.
6. Click Add Page.
7. Define additional child pages as required.
8. To specify various settings for child pages including friendly URL, meta tags, and custom JavaScript, select each page and click the options on the right.
9. To change the order of the top-level page tabs, move the page names up and down as required and click Save.
10. Click Look and Feel at any level to set the default theme and colors for all private or public pages or the specific page.
5.3.2 Editing an Existing Page

To edit an existing page:

1. Click the options icon next to the site name, select Admin, and then select Site Administration.
2. Under Pages, select Site Pages.
3. Select the page to edit.
4. Edit the settings as necessary:
   - To copy the contents of another page to the selected page, click Copy Applications, select an existing page from the Copy from Page drop-down list, and then click Copy. Existing content on the page is overwritten.
   - To delete a page, select it and then click Delete.
5. Click Save.

5.4 Site Provisioning

Sites are ideal workspaces for teams to collaborate on common projects. They provide an isolated area where a group of people can place all of their data pertaining to a particular topic, and many organizations have used them for this purpose. It is a far better way to share data than using e-mail and a shared folder on a network. Instead,

- The Document Library portlet (under Content Management) empowers users to access and update documents simultaneously, and all versions of the documents are preserved.
- A Calendar portlet (under Collaboration) can be used to keep track of the team's appointments and meetings, and can send notifications out to the team.
- A Wiki portlet (under Collaboration) can be used to document the project as it progresses.
- A Message Boards portlet (under Collaboration) can be used to keep all team discussions in one place.

The ad-hoc creation of sites for this purpose allows portal administrators to create sites based on templates. What this means is that you can create a template site that has a pre-defined set of pages and portlets, and then use that template to very quickly create multiple sites that are pre-populated with those pages and portlets. Defining site templates streamlines the site creation process for administrators, making it very easy to quickly create sites for teams.

Templates can be created for open, restricted, and private sites. Additionally, create a default template that applies to all kinds of sites.

To setup a site template:

1. From the Control Panel, under Sites, select Site Templates.
2. Provide a name and description for the template, and then click Save.
3. Click Actions next to the site template and select Manage.
4. Click Pages and then select Site Pages.
5. Click Pages and then click Add to create pages in the template.
   - Use View Pages to view the pages you are creating, to add portlets, and to change layouts.
For more information about adding pages and portlets to a site, see Section 5.3, “Adding Pages,” on page 61.

Any future sites that you create will have the same layouts and portlets as what you have defined based on the default template and any templates defined for that site type.

5.5 Assign Users to a Site

Users must be assigned to a private site in order to gain access to it. After assigned, the user accesses the site via the site’s URL. Users who do not have personal pages go directly to the site pages on login.

Open sites allow users to join and leave at any time without approval from an administrator. Restricted sites force users to request membership which is approved by an administrator. Private sites only receive new members who are assigned by an administrator either individually or by association.

Site administrators can assign users to sites in two ways:

- **Directly**: Assign users directly to a site by assigning their user account to the site.
- **Indirectly**: Assign users indirectly by first assigning them to entities, such as groups, organizations, or locations, then assign these entities to a site. Users who belong to a group, organization, or location that is assigned to a site are also assigned to the site.

All site members, regardless of whether they were assigned directly or indirectly, have access to the same functionalities.

For more information about setting default sites for users, see Section 4.4.1, “Default Associations for User Accounts,” on page 54.

**TIP:** If the list of available users, user groups, organizations, or locations is long, use the Search function to locate specific entities.

- Section 5.5.1, “Assign Users Directly to a Site,” on page 64
- Section 5.5.2, “Assign Groups, Organizations, or Locations to a Site,” on page 64
- Section 5.5.3, “Remove Users,” on page 64
5.5.1 **Assign Users Directly to a Site**

To assign users directly to a site:

1. Navigate to the desired site.
2. Click Users and then click Site Memberships.
   The Site Memberships page displays the users currently assigned to the site.
3. Click Add Members and select User to view a list of users that are available for assigning to the site.
4. Select the check box next to the user names to add to the site, and then click Save.

5.5.2 **Assign Groups, Organizations, or Locations to a Site**

To assign groups, organizations, or locations to a site:

1. Navigate to the desired site.
2. Click Users and then click Site Memberships.
3. Click Add Members and select User Groups or Organizations to view a list of groups or organizations that are available for assigning to the site.
4. Select the check box next to the entities to assign to the site, and then click Save.

5.5.3 **Remove Users**

Site administrators can remove users from any site. If a user is a member of the site through membership in a group, organization, or location that is assigned to the site, you need to do one of two things:

- “Removing Users Directly Assigned to a Site” on page 65
- “Removing A Group, Organization, or Locations Assigned to a Site” on page 65
Removing Users Directly Assigned to a Site

1. Navigate to the desired site.
2. Click Users and then click Site Memberships.
3. Click Add Members and select User.
4. Deselect the users to remove from the site, and then click Save.

Removing A Group, Organization, or Locations Assigned to a Site

1. Navigate to the desired site.
2. Click Users and then click Site Memberships.
3. Click Add Members and select User Group or Organization.
4. Deselect the groups or organizations to remove from the site, and then click Save.

5.6 Changing Page Layout

By default, a dashboard page uses the two-column layout to display content on the Web page. The page can be easily changed to use another page layout using various page layout templates.

To change the layout of a page:

1. Navigate to the page and click Details.
2. Select the desired layout, and then click Save.

5.7 Changing the Look and Feel

Themes are used to set the look and feel for a page. To set these options, navigate to the desired page and click Look and Feel. A child page inherits the look and feel of a parent page unless it is specifically changed.

The default Operations Center theme is simple, yet modern with lots of white space. Portlet icons become visible when the cursor is moved over the portlet's title bar.

The Dashboard comes with a small library of themes and color schemes.

The following sections describe how to change the Dashboard theme as well as install additional themes:

- Section 5.7.1, “Changing the Dashboard and Page Theme,” on page 66
- Section 5.7.2, “Installing Additional Themes,” on page 66
5.7.1 Changing the Dashboard and Page Theme

To set the look and feel (such as theme and color scheme):

1. From the Dashboard site, click **Pages** and then select **Site Pages**.
2. Do one of the following:
   - To apply the theme change to all pages, click the appropriate tab and then click **Look and Feel**.
   - To apply the theme change for a specific page, click the page and then click **Look and Feel**.
3. Select a theme and, if applicable, a color scheme.

5.7.2 Installing Additional Themes

New themes can be downloaded from the Liferay Marketplace at [http://www.liferay.com/marketplace](http://www.liferay.com/marketplace). Or, if you have a custom theme, you can upload and install it using a `.war` file.

To install new themes:

1. Navigate to the site where you want to install the theme, click **Pages**, and then click **Site Pages**.
2. Click the appropriate tab, and then click **Look and Feel**.
3. Click **Install More**.
4. Click **Themes/Site Templates**, and then click **Install**.
5. Browse for the `.war` file to install or specify the URL of a theme to install, and then click **Install**.
6. Return to the site and click **Look and Feel**.
   - The new theme is available for selection.

5.8 Configuring Default Home for User Groups, Sites, and Organizations

By default, the standard *Welcome* page is displayed on login for all users. However, specific landing pages can be defined for user group, site, or organization; by adding property settings to the `portal-ext.custom.properties` file. Depending on your requirements, it may require setting a **Friendly URL** in the page’s Control Panel settings.

In the following example, using the simplest of declarations, a user is directed to the landing page for the first site that he is a member of. If not a part of any site, it directs him to the first organization that he is a member of. If not part of any organization, it directs him to the default landing page which is the guest home page. In all cases, it looks for `/home` pages.

```
login.events.post=com.mosol.liferay.authenticator.LoginPostAction,
com.liferay.portal.events.DefaultLandingPageAction,
com.mosol.liferay.portal.events.OrganizationLandingPageAction,
com.mosol.liferay.portal.events.siteLandingPageAction
```

In the next example, if a user belongs to one of three groups, he is directed to that group's landing page. If the user belongs to more than one group, the *operator* group is given preference over *dba*, and *dba* is given preference over *analyst*. If the user does not belong to any of the groups, he is directed to the default landing page which is the guest home page.
Remember the following when configuring the portal-ext.custom.properties file for landing pages:

- A home page is designated when there is a /home page is defined for a user group, site or organization. Or when another page URL is explicitly set in the properties file.
- If page.name and landing.page property values are not specified, they default to /home.
- The property file is evaluated line-by-line and in order. The last successful match wins, so define the broadest evaluations first, and then narrow down to the most specific cases.
- If the specified URL cannot be found, the Dashboard shows a 404 error.
- If a user is not a member of a specified group, site or organization; the last valid match determines the user’s home page.

While these configurations can be made complex, the simplest configuration would be to make sure each user group, site and organization in your Dashboard configuration has an existing /home page. Then specify the order of evaluation in the properties file, and set properties for group priority and ignore lists for sites and organizations.

Refer to the portal-ext.properties file for additional information and examples. For more information about the portal-ext.custom.properties file, refer to Section 3.9, “Understanding Portal Properties Files,” on page 38.

To configure the home page for a user:

1. In the Operations Center console, configure your users, groups sites and organizations.
   For information on creating users and groups, see “User and Group Accounts” in the Operations Center Security Management Guide.
2. Verify there is a home page for user groups, sites, or organizations as required.
   For information on adding pages, see Section 5.3, “Adding Pages,” on page 61. For information on importing pages, see Section 5.9, “Importing and Exporting Data and Configurations from User Groups, Sites, or Organizations,” on page 69.
   - Navigate to the page and note the URL. The value you will need is the part of the URL after the last slash (/).
   - To change the URL for any page, set the Friendly URL:
     1. From the Dashboard, click Welcome and select Control Panel.
     2. Under Portal, select User Groups, Sites, or Organizations.
     3. Click Actions next to the desired group, site or organization; and select Manage Pages.
     4. Under Pages, create or select the page to be the default home page for the group.
     5. Click Page, then type /home or the new page name URL in the Friendly URL field.
        If changing pages for the /home URL, modify the Friendly URL for the existing /home page before you set the URL as /home on the new page.
     6. Click Save.
   Repeat these steps for each group, organization, or site that you wish to configure.
3 Configure the `/OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.custom.properties` file.

3a Add the following required lines as an initial declaration of comma delimited entries:

```
login.events.post=com.mosol.liferay.authenticator.LoginPostAction,
com.liferay.portal.events.DefaultLandingPageAction

login.events.post=com.mosol.liferay.authenticator.LoginPostAction is required for Operations Center authentication.
com.liferay.portal.events.DefaultLandingPageAction takes the user to the guest home page if no other option is defined.
```

Optionally, add any of the following lines in the desired evaluation order:

```java
com.mosol.liferay.portal.events.UserGroupLandingPageAction redirects the user to his group's home page on login. Then define additional properties related to user group in Step 3b.

com.mosol.liferay.portal.events.OrganizationLandingPageAction redirects the user to his site's home page on login. Then define additional properties related to user group in Step 3b.
```

3b Add and define any of the additional properties to customize.

- **To customize by user group:**
  ```
  dashboard.UserGroupLandingPageAction.group.order=groupName1,groupName2,groupName3
  
  dashboard.UserGroupLandingPageAction.page.name=/home lists (no spaces) of all groups in order of priority in case a user belongs to more than one.
  
  dashboard.UserGroupLandingPageAction.page.name=/home is the landing page URL to use if the user does not belong to any of the listed groups.
  ```

- **To customize by site:**
  ```
  site.landing.page=/home is the site home page.
  
  site.landing.path=/web specifies the start of the URL to use for the landing page.
  
  site.landing.ignoreList=Guest,TestSite comma delimited list (no spaces) of sites to ignore.
  ```

- **To customize by organization:**
  ```
  organization.landing.page=/home is the organization home page.
  
  organization.landing.path=/web specifies the start of the URL to use for the landing page. `/web` is the location for public pages and `/group` is the location for private pages.
  
  organization.landing.ignoreList=Engineers,Finance is a comma delimited list (no spaces) of organizations to ignore.
  ```

4 Restart the Dashboard server for the changes to take affect. For more information, see Section 2.3.1, “Starting the Dashboard,” on page 25.
5.9 Importing and Exporting Data and Configurations from User Groups, Sites, or Organizations

Various data can be imported and exported for sites using LAR files. Import and export options include pages, portlet configurations, permissions, themes, and categories.

Even though a LAR file might contain all data from a site, a partial import can be accomplished by disabling the data you do not wish to import.

**IMPORTANT:** Imported pages overwrite all existing pages.

To import pages:

1. Do one of the following:
   - If you are importing to a site, go to a page that has a My Sites portlet.
   - Click Welcome and select Control Panel. Under Portal, select Sites, User Groups, or Organizations.
2. Click Actions next to the desired group, organization, or site and select Manage Pages.
3. Select the Public Pages or Private Pages tab.
4. Select the Export / Import tab.
5. Select the Import tab.
6. Click the Browse button to select the LAR file to import.

**WARNING:** Imported pages replace all existing pages in the site.
7. Specify the data to import by selecting the desired check box options.
8. Click Import.

To export pages:

1. Do one of the following:
   - If you are exporting to a site, go to a page that has a My Sites portlet.
   - Click Welcome and select Control Panel. Under Portal, select Sites, User Groups, or Organizations.
2. Click Actions next to the desired site and select Manage Pages.
3. Select the Public Pages or Private Pages tab.
4. Select the Export / Import tab.
5. Select the Export tab.
6. Specify the name of the LAR file where the data is to be saved.
7. Specify the data to export including pages, portlets, permissions, theme and categories by selecting the desired check box options.
8. To export, click Export.
Adding Content to a Page Using Portlets

Any dashboard page can be customized by changing the layout, selecting themes for the “look and feel”, adding content via portlets, and adding navigation or other functionality to the page. These changes are saved between sessions. The various actions that a user can take depend on the permissions assigned. For more information about permissions, see Section 3.12, “Granting or Denying Access to Portlets,” on page 42.

Because some portlets rely on receiving information from other sources on the Internet, such as the RSS portlets, users must have Internet access in order for them to work properly.

Content from other sources can be added to the Dashboard using portlets. The Dashboard leverages portlets that are JSR-168 compliant and any third-party portlets built with this standard can be deployed in the Dashboard. For more information, see Section 3.10, “Deploying Portlets to the Dashboard,” on page 39.

The following sections list the various portlets or web applications that are available; and describe how to add them, share them as well as add various other features to a page:

- Section 6.1, “Understanding Available Content via Portlets,” on page 71
- Section 6.2, “Adding Portlets,” on page 74
- Section 6.3, “Understanding Sharing Portlets,” on page 76
- Section 6.4, “Adding a Site Map, Breadcrumbs, or Navigation to a Page,” on page 76
- Section 6.5, “Adding a Refresh Feature to Pages,” on page 77
- Section 6.6, “Integrating Reports from External Reporting Tools Using iFrames,” on page 77

6.1 Understanding Available Content via Portlets

The Dashboard ships with many default portlets that can be added to a Web page to add content to the page. You can disable portlets or restrict their use based on user permissions. For more information, see Section 3.12, “Granting or Denying Access to Portlets,” on page 42.

The Dashboard includes:

- A library of standard Liferay portlets, including basic page navigation features.
  For more information about the Liferay portlet library, see the Liferay 6.2 documentation. Some portlets might require the installation of third-party software; check the software documentation for more information. For support for any third-party portlets, including Liferay portlets, contact the vendor that provided the portlet.
- Operations Center portlets that expose Operations Center Service Management content, such as alarms
  For information, see Chapter 7, “Exposing Operations Center Content,” on page 79.
Table 6-1 lists Operations Center portlets, followed by default Liferay portlets:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description/Available Portlets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operations Center</td>
<td>Operations Center portlets allow you to surface Service Management data:</td>
</tr>
<tr>
<td></td>
<td>• Alarms</td>
</tr>
<tr>
<td></td>
<td>• Chart Builder</td>
</tr>
<tr>
<td></td>
<td>• Charting</td>
</tr>
<tr>
<td></td>
<td>• Element Properties</td>
</tr>
<tr>
<td></td>
<td>• Layout</td>
</tr>
<tr>
<td></td>
<td>• Operations Center server Profiles</td>
</tr>
<tr>
<td></td>
<td>• Navigation</td>
</tr>
<tr>
<td></td>
<td>• Performance</td>
</tr>
<tr>
<td></td>
<td>• Properties Table</td>
</tr>
<tr>
<td></td>
<td>• Public End User View</td>
</tr>
<tr>
<td></td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• Root Cause</td>
</tr>
<tr>
<td></td>
<td>• Search</td>
</tr>
<tr>
<td></td>
<td>• Show Impacted</td>
</tr>
<tr>
<td></td>
<td>• Starter</td>
</tr>
<tr>
<td></td>
<td>• Status</td>
</tr>
<tr>
<td></td>
<td>• Summary</td>
</tr>
<tr>
<td></td>
<td>• Tree Map</td>
</tr>
</tbody>
</table>

For more information, see Chapter 7, “Exposing Operations Center Content,” on page 79 and Chapter 8, “Configuring Operations Center Portlets,” on page 101.

<table>
<thead>
<tr>
<th>Collaboration</th>
<th>Collaboration portlets facilitate interaction among coworkers:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Blogs</td>
</tr>
<tr>
<td></td>
<td>• Blogs Aggregator</td>
</tr>
<tr>
<td></td>
<td>• Calendar</td>
</tr>
<tr>
<td></td>
<td>• Message Boards</td>
</tr>
<tr>
<td></td>
<td>• Recent Bloggers</td>
</tr>
<tr>
<td></td>
<td>• SMS Text Messenger</td>
</tr>
<tr>
<td></td>
<td>• Wiki</td>
</tr>
<tr>
<td>Category</td>
<td>Description/Available Portlets</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Site</strong></td>
<td>Site portlets allow the sharing of information among people with a similar skill, interest, or task to perform:</td>
</tr>
<tr>
<td></td>
<td>- Bookmarks</td>
</tr>
<tr>
<td></td>
<td>- Directory</td>
</tr>
<tr>
<td></td>
<td>- Invitation</td>
</tr>
<tr>
<td></td>
<td>- My Sites</td>
</tr>
<tr>
<td></td>
<td>- Page Comments</td>
</tr>
<tr>
<td></td>
<td>- Page Ratings</td>
</tr>
<tr>
<td>For more information on sites, see Section 5.2, “Creating and Maintaining Sites,” on page 59.</td>
<td></td>
</tr>
<tr>
<td><strong>Content Management</strong></td>
<td>Content Management System (CMS) portlets help manage documents and images and publish content. Some add navigation functionality to a page.</td>
</tr>
<tr>
<td></td>
<td>- Asset Publisher</td>
</tr>
<tr>
<td></td>
<td>- Breadcrumb</td>
</tr>
<tr>
<td></td>
<td>- Categories Navigation</td>
</tr>
<tr>
<td></td>
<td>- Document Library and Document Library Display</td>
</tr>
<tr>
<td></td>
<td>- Image Gallery</td>
</tr>
<tr>
<td></td>
<td>- Navigation</td>
</tr>
<tr>
<td></td>
<td>- Nested Portlets</td>
</tr>
<tr>
<td></td>
<td>- Polls Display</td>
</tr>
<tr>
<td></td>
<td>- Recent Documents</td>
</tr>
<tr>
<td></td>
<td>- Site Map</td>
</tr>
<tr>
<td></td>
<td>- Tags Navigation</td>
</tr>
<tr>
<td></td>
<td>- Web Content Display, List and Search</td>
</tr>
<tr>
<td></td>
<td>- XSL Content</td>
</tr>
<tr>
<td>For generic instructions on how to add a portlet to a page as well as instructions for adding a site map, breadcrumbs and navigation to a page, see Chapter 6, “Adding Content to a Page Using Portlets,” on page 71.</td>
<td></td>
</tr>
<tr>
<td><strong>Finance</strong></td>
<td>Finance portlets include tools and informative content:</td>
</tr>
<tr>
<td></td>
<td>- Currency Converter</td>
</tr>
<tr>
<td></td>
<td>- Loan Calculator</td>
</tr>
<tr>
<td><strong>News</strong></td>
<td>News portlets display or share news information:</td>
</tr>
<tr>
<td></td>
<td>- Alerts</td>
</tr>
<tr>
<td></td>
<td>- Announcements</td>
</tr>
<tr>
<td></td>
<td>- RSS</td>
</tr>
</tbody>
</table>
Portlets can be added to pages. When you add a portlet to a site, generally the objects in the portal belong to that site only. For example, if a Message Board is added to the Support site, all of the topics created through that portlet belong to the Support site only. The admin portlets (Enterprise Admin, Organization Admin, and Location Admin) are the exception because they span all sites and thus can be accessed through multiple sites.

- Section 6.2.1, “Adding a Portlet,” on page 75
- Section 6.2.2, “Moving Portlets on a Page,” on page 75
- Section 6.2.3, “Configuring Portlet “Look and Feel”,” on page 75
6.2.1 Adding a Portlet

To add a portlet:

1. Click the options icon next to the site name, click Add, and then and click Add Application.
2. Click a category to open a list of portlets.
   For Service Management portlets, expand Operations Center.
3. To add a portlet to the page, do one of the following:
   - Click Add next to a portlet.
   - Click the portlet name and drag to the desired position on the page.
4. Add more portlets as needed.

6.2.2 Moving Portlets on a Page

In the dashboard, new portlets are automatically added at the top of the page above any existing portlets (unless you’ve strategically placed it when dragging over from Add Applications onto the page). A portlet can be moved to a new location depending on the page layout. For example, if the page layout has two columns, a portlet can be moved from the left column into the right column.

To reposition a portlet to a different location on the same page, Click the portlet title bar and drag the portlet to a new location on the page.

6.2.3 Configuring Portlet “Look and Feel”

After a portlet is added to a page, you can configure its appearance including:

- General portlet settings such as title and disable borders
- Text, background, and border styles
- Background styles
- Margin and padding
- Custom css for advanced styling
- WAP Styling

In addition to appearance, some portlets have other configuration options.

To configure the look and feel for a portlet:

1. Click Options and select Look and Feel.
2. Select one of the following tabs:
   - Portlet Configuration: Set portlet title options, disable borders, and link portlet URLs to pages:
   - Text Styles: Define styles for portlet text including alignment, line height, and spacing.
   - Background Styles: Set the color for the portlet background.
   - Border Styles: Set color and spacing styes for the portlet border.
   - Margin and Padding: Set margin and spacing for the portlet.
   - Advanced Styling: Define any custom css.
   - WAP Styling: Set options for the portlet when viewed by a wireless device.
3. Make any changes, then click Save.
6.3 Understanding Sharing Portlets

Some portlets allow information to be shared among dashboard users. For users to access a portlet, the following is required:

- The user must be assigned a role that has permission to the portlet.
  
  For more information, see Chapter 12, “Portal and Site Permissions,” on page 167.
- The portlet must be on a public page or a page governed by one of the roles the user is assigned.

6.4 Adding a Site Map, Breadcrumbs, or Navigation to a Page

Site Map, Breadcrumb, and Navigation portlets are available to add navigational features to any the dashboard page.

To add a site map, breadcrumb, or a navigation to a page:

1. Click the options icon next to the site name, click Add, and then click Add Application.
2. To add a Site Map portlet, do the following:
   - Under Content Management, click and drag Site Map to a location on the page.
   - Click the options icon next to Site Map and select Configuration to configure the following options on the Site Map portlet:
     - Root Page: The page where the site map begins.
     - Display Depth: The number of child levels displayed on each page.
     - Click Save.
   
   The Site Map portlet adds a hierarchical listing of all pages in a site.
3. To add a Breadcrumb portlet, do the following:
   - Under Content Management, click and drag Breadcrumb to a location on the page.
   - Click the options icon next to Breadcrumb and select Configuration to configure the following options:
     - Display Style: Select Horizontal or Vertical.
     - Click Save.
   
   The Breadcrumb portlet displays the current page, plus links back to the preceding parent pages.
4. To add a Navigation portlet, do the following:
   - Under Content Management, click and drag Navigation to a location on the page.
• Click the options icon next to Navigation and select Configuration to configure the following:
  
  Bullet style: Varies the lines between the pages in the list.
  Display style: Indicates how the page names are presented.

  Click Save.

  The Navigation portlet displays a listing of links to all pages within the current portlet.

6.5 Adding a Refresh Feature to Pages

Add the Refresh portlet to the Web page in order to allow the user to refresh the page on demand or by scheduling a refresh as designated intervals.

To refresh data in a the dashboard Web page:

1. Click the options icon next to the site name, click Add, and then click Add Application.
2. Under Operations Center, click and drag Refresh to a location on the page.
3. Click Refresh in the Refresh portlet to reload the page.
4. To schedule automatic refresh, do the following:
   4a. Click the options icon next to Refresh and select Preferences to configure the Refresh portlet.
   4b. Select the desired interval to schedule the page refresh in the Refresh Interval list. Select None to disable automatic refresh.
   4c. Click Save.

If a scheduled refresh is set, the date and time of the last refresh, as well as a countdown to the next refresh, are displayed.

If a scheduled refresh interval is not set, then a message displays, indicating the automatic refresh option is disabled.

6.6 Integrating Reports from External Reporting Tools Using iFrames

If you have reports from third-party reporting tools that include Operations Center data, you can now access and run these through the dashboard pages using iFrames.

This section explains how to integrate reports from Crystal Reports as an example. Sample reports leveraging Operations Center data are available in /OperationsCenter_install_path/database/examples/mosql. For more information about using Business Objects Crystal Reports for queries and reporting of Operations Center data, see the Operations Center SQL Views Guide.

To integrate with Business Objects Crystal Reports from the Dashboard:

1. Add the iFrame portlet to a page.
   Select iFrame under Sample in Add Applications. For more information on adding portlets to a page, see Section 6.2.1, “Adding a Portlet,” on page 75.
2. Click the configuration link inside the portlet.
3. Specify the URL of the reporting program in the Source URL field.
4. Specify other settings for the portlet as required.
5 Click Save.
6 Click the Return to Full Page link to display the page from the reporting tool.
7 Select and view the desired report.
7 Exposing Operations Center Content

The data that can be viewed in a Operations Center portlet depends on the permissions the user has in Operations Center. This is true for all portlets except the Public End User View portlet, which can be configured so guest users can see limited status information about selected elements. For more information about permissions in Operations Center Script Debugger, see the Operations Center Security Management Guide.

Review the following sections to

- Section 7.1, “Understanding the Operations Center Portlets,” on page 79
- Section 7.2, “Configuring Portlet View Links,” on page 83
- Section 7.3, “Configuring Home and Starting Elements,” on page 83
- Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84
- Section 7.5, “Creating Custom Right-Click Menus or Dashboard JavaScript Operations,” on page 86
- Section 7.6, “Configuring URL Linking for the Layout Portlet,” on page 91
- Section 7.7, “Viewing Source Data for Charts,” on page 92
- Section 7.8, “Setting Technical Configurations for Operations Center Portlets,” on page 92
- Section 7.9, “Installing Third-Party Software,” on page 100
- Section 7.10, “Troubleshooting Operations Center Portlets,” on page 100

7.1 Understanding the Operations Center Portlets

Operations Center portlets are added to a page in the same way as other content. Configuring the look and feel of these portlets is also the same as for other portlets. For more information, see Chapter 6, “Adding Content to a Page Using Portlets,” on page 71.

- Some data, such as alarms, can be viewed in real time with automatic updates from the Operations Center server. Operations that are performed on alarms on the Operations Center console can also be performed in the Dashboard.
- Element status data from Operations Center is available in the Dashboard using Operations Center portlets. For some portlets, you can select the Operations Center server as the source for displayed content.
- Some portlets support custom condition/severity colors as set in the Operations Center console.
- The defaults for Operations Center portlets are read from an XML file that can be modified.
- For some portlets to display correctly, a third-party plug-in must be installed on the user’s computer.

Review the following sections to understand data types in Operations Center and how to set options for portlets:

- Section 7.1.1, “Understanding Data Types in Operations Center,” on page 80
- Section 7.1.2, “Understanding Custom Colors in Portlets,” on page 82
- Section 7.1.3, “Setting Options for a Portlet,” on page 82
7.1.1 Understanding Data Types in Operations Center

Table 7-1 lists the types of data and views from Operations Center that can be displayed in the Dashboard:

Table 7-1 Operations Center Portlets by Portlet Type

<table>
<thead>
<tr>
<th>Type</th>
<th>Description/Available Portlets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>Information overview for an element, showing various types of related data based on preferences. Included data can include element properties, list of parents and children, alarm summary, alarms, layout/relationship diagrams, root cause and show impacted information. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Information</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Information Portlet (page 111).</td>
</tr>
<tr>
<td>Element Status</td>
<td>Visual representation of the current condition of elements. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Status</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Status Portlet (page 128).</td>
</tr>
<tr>
<td></td>
<td>• Information</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Information Portlet (page 111).</td>
</tr>
<tr>
<td></td>
<td>• Public End User View</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Public End User View Portlet (page 123).</td>
</tr>
<tr>
<td>Properties</td>
<td>Properties specified for an element. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Properties Table</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Properties Table Portlet (page 121).</td>
</tr>
<tr>
<td></td>
<td>• Element Properties</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Element Properties Portlet (page 111).</td>
</tr>
<tr>
<td></td>
<td>• Information</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Information Portlet (page 111).</td>
</tr>
<tr>
<td>Alarms</td>
<td>Both historical alarms and real-time alarms in either a full view or summary view. Operations can also be performed for real-time alarms in the full view. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Summary</td>
</tr>
<tr>
<td></td>
<td>For more information, see See Understanding the Summary Portlet (page 130).</td>
</tr>
<tr>
<td></td>
<td>• Alarms</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Alarms Portlet (page 101).</td>
</tr>
<tr>
<td></td>
<td>• Information</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Information Portlet (page 111).</td>
</tr>
<tr>
<td>Visual representation of alarms, both historical and real time. Related portlets include:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Tree Map</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Tree Map Portlet (page 130).</td>
</tr>
<tr>
<td>Type</td>
<td>Description/Available Portlets</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Root cause/Show impacted</td>
<td>The cause of an element’s state or the elements affected by the selected element. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Root Cause</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Root Cause Portlet (page 124).</td>
</tr>
<tr>
<td></td>
<td>• Show Impacted</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Show Impacted Portlet (page 127).</td>
</tr>
<tr>
<td></td>
<td>• Information</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Information Portlet (page 111).</td>
</tr>
<tr>
<td>Performance Charts</td>
<td>A chart of performance metrics, SLA data, availability and downtime. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Charting</td>
</tr>
<tr>
<td></td>
<td>For more information, see Section 8.2, “Configuring the Charting Portlet,” on page 108.</td>
</tr>
<tr>
<td>Layout/Relationships</td>
<td>Visual representation of element relationships. Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Layout</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Layout Portlet (page 116).</td>
</tr>
<tr>
<td></td>
<td>• Information</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Information Portlet (page 111).</td>
</tr>
<tr>
<td>Navigation/Element Selection</td>
<td>Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• Navigation</td>
</tr>
<tr>
<td></td>
<td>Displays the hierarchy from the Operations Center server with an indicator for status and controls the elements shown on the other portlets on the page.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Navigation Portlet (page 119).</td>
</tr>
<tr>
<td></td>
<td>• Starter</td>
</tr>
<tr>
<td></td>
<td>Displays an element with an indicator for status and controls the elements shown on the other portlets on the page.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Configuring the Starter Portlet (page 127).</td>
</tr>
<tr>
<td></td>
<td>• Search</td>
</tr>
<tr>
<td></td>
<td>Locate elements in Operations Center and display properties for the found elements. Found elements can also be selected to control the elements shown in other portlets on the page.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Search Portlet (page 124).</td>
</tr>
<tr>
<td>Service Level Agreements</td>
<td>Related portlets include:</td>
</tr>
<tr>
<td></td>
<td>• SLA Compliance</td>
</tr>
<tr>
<td></td>
<td>For more information, see Section 9.2, “Configuring the SLA Compliance Portlet,” on page 134.</td>
</tr>
<tr>
<td></td>
<td>• SLA Status</td>
</tr>
<tr>
<td></td>
<td>For more information, see Section 9.3, “Configuring the SLA Status Portlet,” on page 139.</td>
</tr>
</tbody>
</table>
7.1.2 Understanding Custom Colors in Portlets

As an option, users can select a custom color palette used for condition and severity colors in the Operations Center console. Only some portlets support this custom color selection.

The following portlets support custom color settings:

- Alarms
- ChartBuilder (all examples except the Element Property Gauge
- Charting
- Information (Alarms list only)
- Performance
- Search
- SLA Status & Compliance Portlets (Compliance and Charts tabs only)
- Summary
- Tree Map (Element name labels only)

There are no configurations required to the portlets. However, current users must logout and re-login to see new severity colors after settings are changed in the Operations Center console.

For more information on custom color settings, see “Managing Condition/Severity Colors” in the Operations Center User Guide.

7.1.3 Setting Options for a Portlet

Data is displayed using components within portlets. Some of the components allow data to be updated automatically when the Operations Center server receives new data.

Options for data content and formatting are set within each portlet.

To set options for any portlet:

1. Click the options icon and select Preferences.
2. Make changes to the options, and then click Save.
7.2 Configuring Portlet View Links

Nearly all Operations Center portlets, those that contain actual data from a Operations Center server, include multiple views within the portlet. When available and enabled, these views are accessible to the user via an Actions link at the top of the portlet:

- Performance  
- Alarms  
- Layout  
- Treemap  
- Root Cause  
- Impacted  
- Properties  
- Properties Table  
- Chart Builder

The Actions link and the portlet view links settings are only applicable for the above portlets.

To disable/enable the Actions and view links for a portlet:

1. Click the options icon and select Preferences.
2. Click the Advanced tab, and then click the Common tab.
3. To hide the Actions menu link at the top of the portlet, select the Actions Menu option under Portlet View Links.
4. To add a Home link at the top of the portlet, deselect the Home option under Portlet View Links. By default this option is selected and a Home link does not appear on the portlet.
5. To hide any of the portlet links, select the undesired options under Portlet View Links. Select from Performance, Alarms, Layout, Treemap, Root Cause, Impacted, Properties, Properties Table, and Chart Builder. By default these options are deselected and all links appear on the portlet.
6. Click Save.

The options for components vary depending on the portlet.

In addition to showing links to components in the main section of the portlet, links to other components can also be available through a right-click context menu. The right-click context menu can be used to add functionality to portlets.

7.3 Configuring Home and Starting Elements

The home element (starting element) for each user is set within the user or group account settings in the Operations Center console. The home element is used to populate element-based Service Management portlets if a starting element has not been defined for that portlet.

**NOTE:** The SLA reporting, Performance, and Chart Builder portlets require configuration steps, beyond setting a Home or Starting element, in order to display data.
Starting elements can be changed "on the fly" for most portlets when Navigation Mode, or drive functionality, is configured. For more information, see Section 7.4, "Using Navigation Mode to Drive Multiple Portlets," on page 84.

- Section 7.3.1, "Changing the User’s Default Home Element," on page 84
- Section 7.3.2, "Configuring Starting Elements for Portlets," on page 84

7.3.1 Changing the User’s Default Home Element

The Home setting is found on the user’s or group’s property page in the Operations Center console. By default, all users start with the Enterprise element. The elements that a user can view depend on the user’s permissions in Operations Center.

To set a user’s or group’s default starting element:

1. From the Operations Center console, in the Explorer pane, expand Enterprise > Administration > Security > Users (or Groups).
2. Right-click the user or group, then click Properties.
3. Select the User (or Group) property page.
   - The Home field shows the default starting element.
4. To select a new starting element click Browse.
   - Consider the user’s or group’s permissions for specific elements in the hierarchy when selecting the new starting element.

7.3.2 Configuring Starting Elements for Portlets

By default, portlets use the user’s home element as their starting element.

To change the starting element for a portlet:

1. Click the options icon and select Preferences.
2. Click the Element tab.
3. Do one of the following:
   - Use the Search tab to search for elements. The search is by name and allows for the use of wildcards (*).
   - Use the Navigate tab to select an element from the hierarchy by clicking + and – to expand and contract the list.

7.4 Using Navigation Mode to Drive Multiple Portlets

By default, the “drive” or “navigation mode” configuration allows you to select an element in one portlet and automatically update content in other portlets (when available) on the same page. Or, you can configure the portlet to drive one or more specific portlets on the page.

For example, if we have a Navigation, Element Properties, Alarms and Information portlets on the same Dashboard page; when we click the Administration > Server element in the Navigation portlet, the other portlets (Element Properties, Alarms, and Information) update to show related information about the Server element.
The following sections describe more about enabling drive functionality as well as configuring only specific portlets to drive.

- Section 7.4.1, “Understanding Drive Configuration,” on page 85
- Section 7.4.2, “Tagging Portlets to Drive Specific Portlets,” on page 85

7.4.1 Understanding Drive Configuration

By default, the following portlets are used to drive other portlets without any configuration:

- Navigation
- Search
- Starter
- Status

When enabled, the following portlets can be used to drive other portlets:

- Alarms
- Information
- Layout

**NOTE:** Not all portlets can be driven. For example, the Navigation, Search, Starter, SLA reporting, and Chart Builder portlets are among the portlets that cannot be driven.

To enable or disable “drive” or “navigation mode”, see the configuration instructions for the portlet type you are configuring in Chapter 8, “Configuring Operations Center Portlets,” on page 101.

In addition, an element’s right-click context menu can used to perform this same drive functionality and update content on the page. For instructions on creating right-click menus, continue to Section 7.5.1, “Adding Right-Click Context Menus,” on page 87.

7.4.2 Tagging Portlets to Drive Specific Portlets

In order to contain the drive functionality to specific portlets on a page, each driven portlet must be tagged, and then referenced by the driving portlet.

To enable specific portlets to be driven by element selection:

1. To set up identifiers for the portlets to be driven, do the following for each portlet to be driven:
   1a. Click the options icon and select Preferences.
   1b. Click the Advanced tab, then click the Common tab.
   1c. Under Element Link Action, in the Portlet Tag field, specify a unique name for the portlet. For example, if it is the Alarms portlet, you might enter Alarms.
   1d. Click Save, then exit the preferences for the portlet.

2. To setup a portlet to drive the above portlet(s), do the following for the portlet that is the driver:
   2a. Click the options icon and select Preferences.
   2b. Verify the portlet is setup to “drive” other portlets. In most, this requires the Navigation Mode option to be selected.
      For specific instructions, see the portlet’s configuration section in Chapter 8, “Configuring Operations Center Portlets,” on page 101.
2c Click the **Advanced** tab, then click the **Common** tab.

2d **Under Element Link Action**, in the **Tags of Portlets to Drive** field, specify the identifier/tags set up in the previous procedure.

For example to reference and drive the Alarms portlet in the example setting from the previous step, we might enter **Alarms**.

When referencing more than one portlet, use commas to separate the entries without any extra spaces.

2e Click **Save**, then exit the preferences for the portlet.

3 The driver portlet (Step 2) now drives the referenced portlets (Step 1) when an element is clicked.

### 7.5 Creating Custom Right-Click Menus or Dashboard JavaScript Operations

A right-click context menu can be created, edited and used in the Navigation, Search, Show Impacted, Status, and Root Cause portlets. Using context menus, you can:

- Update the contents of Operations Center portlets on a page to show the selected element’s information
- Open additional components, such as the Alarms view, Layout view, Root Cause view, Performance view, and so on
- Open any URL and send context-sensitive information to the URL
- Execute custom JavaScript commands
- Execute operations

The following sections cover the creation of right-click menus in any portlet that supports right-click menu functionality. Menus can be used to access URLs, issue JavaScript commands, view other portlet, or perform Operations Center server-side operations.

- Section 7.5.1, “Adding Right-Click Context Menus,” on page 87
- Section 7.5.2, “Accessing URLs from Right-Click Menus,” on page 88
- Section 7.5.3, “Issuing JavaScript Commands from Right-Click Menus,” on page 89
- Section 7.5.4, “Adding Portlet View Links to Right-Click Menus,” on page 90
- Section 7.5.5, “Performing Operations Center Server-Side Operations from Right-Click Menus,” on page 90
- Section 7.5.6, “Creating Dashboard JavaScript Operations,” on page 90

In addition, you can use Dashboard JavaScript operations to create operations with custom user interfaces. Dashboard Javascript operations can submit data into server script operations, providing a mechanism for invoking operations on elements or alarms and creating custom user interfaces, as necessary, using the elements or alarms to prepopulate some data in the user interface and subsequently invoke server script operations to perform additional actions, such as submitting requests into third-party systems, starting new custom workflows, or updating element properties within Operations Center. For more information, see Section 7.5.6, “Creating Dashboard JavaScript Operations,” on page 90.
7.5.1 Adding Right-Click Context Menus

While it is possible to create multiple menus for a portlet, only one menu can be active at a time. Multiple menu options can be grouped together on the right-click context menu under a submenu if a grouping title is specified.

To create a right-click menu:

1. Click the options icon and select Preferences.
2. If creating a context menu to drive page content, verify the portlet is enabled for “drive” or Navigation Mode functionality.
   
   For specific information about this configuration option, see the portlet’s configuration section in Chapter 8, “Configuring Operations Center Portlets,” on page 101.
3. Click the Advanced tab, then click the Common tab.
4. Click Create New Menu.
5. Specify a unique name for the menu, then click Create.
   
   If the name already exists, a message indicates the menu failed to save. After a name has been entered, it cannot be changed.
6. Do one of the following to determine the menu item text that displays in the right-click menu:
   
   • Enter text in the Menu Title.
   • Select the Use element name for the title of the menu check box to show the element’s name as the menu name.
   
   If neither option is specified, no title is displayed.
7. To provide a menu option to update other portlets on the page:
   
   7a. Under Drive Page Content, select the Display a menu item to drive the contents on the page with the selected element check box.
   
   7b. Specify a name for the menu option in the Menu Item Text box.
      
      For information about driving other portlets, see Section 7.3.2, “Configuring Starting Elements for Portlets,” on page 84, and be sure the portlet is enabled for “drive” or Navigation mode as mentioned in Step 2 on page 87.
8. To provide menu options that open common portlet components; such as Charting, Performance, Layout, Treemap, Root Cause, Impacted, and Properties Table:
   
   8a. Under Component Links, select the Display a menu item for each common component check box.
   
   8b. Specify a name under which to group these menu options in the Category Name box.
      
      For information about portlet component links, see Section 7.2, “Configuring Portlet View Links,” on page 83.
9. Enter options to open URLs, execute JavaScript commands, or execute operations by adding custom links and operations.
10. To group the menu items, enter a title for the group in the associated Category Name option.
11. Click Save.

After you have created a menu, it is available for use and editing in all portlets that support the right-click menu functionality. If you make changes to the menu in one portlet, those changes are applicable for all instances of the menu in all portlets.

To later edit or remove operations, return to the Common tab under Advanced. Under Current Menu, select the operation name and then click Edit Menu. To remove a link, click Remove.
7.5.2 Accessing URLs from Right-Click Menus

URLs can be included as menu options in portlet right-click context menus. These links can open any URL and send context sensitive information to it. This is a powerful way of launching third-party applications and allowing for context-sensitive display (such as display a remedy ticket associated with a particular element).

Parameters can be passed from the Dashboard to the new URL to customize what appears in the Web page that the URL opens. Parameters can be based on the element from which the user accessed the right-click content menu and can include the DName, element name, and a specified element property, which are all stored in the Operations Center server. For more information on elements including DName and properties, see Viewing Element Properties in the Operations Center User Guide.

To create a menu option to a URL and optionally pass parameters:

1. Click the options icon and select Preferences.
2. Click the Advanced tab, then click the Common tab.
3. Do one of the following:
   - Select the desired existing menu from the Current Menu list, and click Edit Menu.
   - Click Create New Menu to create a new menu.
     For basic steps about defining a new menu, see “Adding Right-Click Context Menus” on page 87.
     Specific steps for defining a custom link are detailed in the remaining steps.
4. Under Custom Links, click Create New Link.
5. To specify basic link information to create the menu link and to set properties for the browser window that the URL will load in, do the following:
   - Specify the name of the option in the Menu Option Name field.
   - Specify a fully qualified URL for the link in the Link URL field.
   - Leave the Enable JavaScript for the URL above check box deselected.
   - Specify the name of the browser window to open the URL in the Target field.
     Enter _blank if it is to always open in a new window.
   - Specify a comma delimited list of parameters to control the size and location of the window in the Parameters field.
     For example, toolbar=no,location=no.
6. (Optional) To hide the URL link when a specific property value exists, select the Show this link only when the name-value below is matched check box.
   Specify the property name and property value expression in the fields provided.
7. (Optional) To set up parameters that are passed by the URL, do the following as necessary:
   - To pass the element DName to the URL, select the Send the element dname as a parameter to the URL check box.
     Specify the parameter expression that is appended to the URL in the field provided (such as dname=dname_value).
   - To pass the element name to the URL, select the Send the element name as a parameter to the URL check box.
     Specify the parameter expression that is appended to the URL in the field provided (such as name=name_value).
To pass an element property name/value pair to the URL, select the Send an element property as a parameter to the URL check box and/or to append the URL with an element property, select the Append element property to the url check box.

Then specify:

- The parameter name to be used for the passed or appended property in the Parameter field.
- The property name to match for in the element’s properties in Operations Center in the Operations Center Property field.

8 Click Create.

The new link definition displays under Custom Links.

### 7.5.3 Issuing JavaScript Commands from Right-Click Menus

JavaScript commands can be executed by menu options in portlet right-click context menu. Links for JavaScript commands are created and edited the same way as URL links.

To create a right-click menu that issues a JavaScript command:

1 Click the options icon and select Preferences.
2 Click the Advanced tab, then click the Common tab.
3 Do one of the following:
   - Select the desired existing menu from the Current Menu list, and click Edit Menu.
   - Click Create New Menu to create a new menu.
   
   For basic steps about defining a new menu, see "Adding Right-Click Context Menus" on page 87.
4 Under Custom Links, click Create New Link.
5 To specify basic link information to create the menu link and to set properties for the browser window that the URL will load in, do the following:
   5a Specify the name of the option in the Menu Option Name field.
   5b Specify the JavaScript command, including any parameters in the Link URL field.
   5c Select the Enable JavaScript for the URL above check box.
   
   For help in determining the parameters for the JavaScript to use elements and properties of an element from Operations Center, click Replacement Keys.
   
   5d Specify the name of the browser window to open the URL in the Target field.
   
   Enter _blank if it is to always open in a new window.
   5e Specify a comma delimited list of parameters to control the size and location of the window in the Parameters field.
   
   For example, toolbar=no,location=no.
6 Click Create to save the menu.

The new JavaScript command definition displays under Custom Links.
7.5.4 Adding Portlet View Links to Right-Click Menus

Links that open other components (different portlets) can be included in portlet right-click context menus. When selected, the new portlet uses the element from which the right-click menu was accessed as the starting element.

The options for configuring the components links on the right-click context menu are available when creating a new menu or editing an existing menu. For basic steps about defining a new menu, see “Adding Right-Click Context Menus” on page 87.

To add component links, select the Display a menu item for each common component check box under Component Links. Each component name then appears on the right-click context menu.

7.5.5 Performing Operations Center Server-Side Operations from Right-Click Menus

Server-side operations defined in Operations Center can be added to portlet right-click context menus. For more information on operations, including how to define operations on the Operations Center console, see Modifying Element and Alarm Menus in the Operations Center Server Configuration Guide.

Custom operations can be added as Dashboard right-click menu options. However, they require custom development to interface with the Dashboard. Contact Support (https://www.netiq.com/support/) for more information.

To create a menu option that runs a server-side operation:

1. In the Operations Center console, create or note the operation you wish to access from the Dashboard.
   Take note of the Menu Text specified for the operation definition.
   For details on creating operations, see Modifying Element and Alarm Menus in the Operations Center Server Configuration Guide.
2. On the Dashboard portlet, on the portlet title bar, click the options icon and select Preferences.
3. Click the Advanced tab, then click the Common tab.
   For basic steps about defining a new menu, see “Adding Right-Click Context Menus” on page 87.
4. Click Create New Menu.
   To edit the menu later, use Edit Menu.
5. In the Menu dialog box, enter the menu name, then click Create.
6. In the Wizard dialog box, select Show Operations, and then click Save.
7. Verify the newly-created menu is selected under Current Menu on the Advanced > Common tab, and then click Save.
   The new menus are available in the right-click context menus for the portlet.

7.5.6 Creating Dashboard JavaScript Operations

Use Dashboard JavaScript operations to create operations with custom user interfaces. Dashboard Javascript operations can submit data into server script operations, providing a mechanism for invoking operations on elements or alarms and creating custom user interfaces, as necessary, using the elements or alarms to prepopulate some data in the user interface and subsequently invoke
server-side script operations to perform additional actions, such as submitting requests into third-party systems, starting new custom workflows, or updating element properties within Operations Center.

**To create a Dashboard JavaScript operation:**

1. Use the Operations Center Console to create a custom operation, and paste the contents of the `PrintScopeVariables.js` script (available in the `OperationsCenter_install_path/database/scripts/dashjs` directory) in the text area of the operation definition.

   For more information about creating a custom operation, see Customizing Monitored Elements and Alarms in the Operations Center Server Configuration Guide.

2. To invoke a server operation from the Dashboard JavaScript operation, use the following JavaScript:

   ```javascript
   NOCOOperations.perform({
     identity: identity, 
     alarmId: alarmID, 
     name: '<server-side_operation_name>', 
     opParam: '<string_parameter_for_the_server_script_operation>'
   });
   ```

   `NOCOperations.perform` takes an object as a parameter that must have the following fields:

   - **identity** - identity of the element on which to invoke the server operation
   - **alarmId** - alarm ID or a comma-delimited list of IDs on which to execute the operation
   - **name** - name of the server-side script operation to invoke
   - **opParam** - string that contains data that you want to pass as a parameter to the server-side script operation. This parameter will be available to the server-side script operation as `args[0]`.

   The `OperationsCenter_install_path/database/scripts/dashjs` directory includes two scripts that provide examples of the functionality.

   The contents of `CreateAlarmsClient.js` provide an example of defining the custom operation using Dashboard JavaScript, and the contents of `CreateAlarmsOperation.fs` provide an example of defining the server-side script operation. The Universal Adapter is a good choice to use as an example.

   To prevent the server-side script operation from displaying as an option on the element or alarm, select the option to mark it as hidden. The operation will still be available, but will not appear on an element’s operation menu.

---

**7.6 Configuring URL Linking for the Layout Portlet**

Clicking an element in the Layout portlet can open a Web page using a fully qualified URL, instead of the expected behavior of drilling into the element’s hierarchy.

URL linking requires the definition of a custom `layoutFollowURL` property for these elements in the Operations Center console. Instead of manually creating and defining this property on each individual element, use Metamodel Property Pages to create the new property, then dynamically associate the property page with elements through behavior models via class, or directly to behavior models using match expressions.

To configure navigation to a URL from a Layout portlet element:

1. Decide how you will propagate the new property via Administration > Metamodel features.

   Metamodel classes, behavior models and property pages are defined in the Operations Center console.
Choose one of the following:

- Attach a new property page to a new (or existing) Behavior Model that uses matching rules for selecting elements.
- Attach a new property page to a new (or existing) Behavior Model that is attached to a Class which can be assigned to elements.

For information about Service Model classes, behavior models and property pages, see “Defining Classes, Behavior Models, and Property Pages” in the Operations Center Service Modeling Guide.

2 When creating the new `layoutFollowURL` property for the desired Property Page, do the following:

2a Click the Create a Property icon and name the property `layoutFollowURL`.
   The property must be named `layoutFollowURL` for this feature to function correctly.

2b Specify a fully qualified URL as desired.
   In the illustration example above, we’ve defined a computed field property that uses a script expression to append the URL with the element name.

3 In the Dashboard Layout portlet, click the element to open the URL.

### 7.7 Viewing Source Data for Charts

Various charting-type portlets contain the ability to access the raw data used to generate the chart:

- Charting
  For more information about the Charting portlet, see Section 8.2, “Configuring the Charting Portlet,” on page 108.

- Information, Charts tab
  For more information about the Information portlet, see Section 8.4, “Configuring the Information Portlet,” on page 111.

- Chart Builder
  For more information about Chart Builder portlet, see Chapter 10, “Chart Builder Portlet,” on page 145.

Clicking the `d` link or using the Chart Data option displays source data used to generate the chart.

### 7.8 Setting Technical Configurations for Operations Center Portlets

The following sections provide details on technical configurations that can be made to configure or increase performance for Dashboard portlets:

- Section 7.8.1, “Configuring Default Alarms Limits Returned from the Operations Center Server,” on page 93
- Section 7.8.2, “Configuring Performance Data Point Retrieval from the Operations Center Server,” on page 93
- Section 7.8.3, “Configuring Regular Expression Look Up for the Charting Portlet,” on page 94
- Section 7.8.4, “Selecting an Alternate Operations Center Server Connection,” on page 95
7.8.1 Configuring Default Alarms Limits Returned from the Operations Center Server

There is a default limit of 1000 historical alarms, outages, and breaches when using the SLA or Alarms portlets. This limit is set on the Operations Center server. If there are more historical alarms (Alarms portlet) or outages/breaches (SLA Compliance portlets) and you want them to be accessible via the dashboard, this limit needs to be appropriately set using the HyperQuery.NumPoints.SizeLimit property.

To increase the maximum number of alarms that are returned from the Operations Center server:

1 Open the /OperationsCenter_install_path/config/Formula.custom.properties file in a text editor.
   If the Formula.custom.properties file does not exist, create it. For more information about the Formula.custom.properties file, see "Making Custom Changes" in the Operations Center Server Configuration Guide.
2 Add the following property and customize the value:
   HyperQuery.NumPoints.SizeLimit=30000
3 Stop and restart the Operations Center server for the changes to take effect.

7.8.2 Configuring Performance Data Point Retrieval from the Operations Center Server

The amount of data points returned for a performance chart can increase or decrease rendering performance. The Operations Center server uses an algorithm to determine how many data points to return for the Charting portlet when charting raw data. Using a setting the mo-settings.xml file, you can configure the aggressiveness of the algorithm to reduce the number of data points used to draw a line while preserving the natural line shape.

This setting is only applied when the Charting portlet is charting raw data.

To configure the level of data point retrieval for the Charting portlet:

1 Stop the Dashboard.
   For information on stopping the Dashboard, see Section 2.3.2, “Stopping the Dashboard,” on page 25.
2 Edit the /OperationsCenter_Dashboard_install_path/server/webapps/ManagedObjectsPortlets/WEB-INF/mo-settings.xml file to add the following:
   <entry>
     <string>performance.charts.ldpreduce.rpd.epsilon</string>
     <string>desiredvalue</string>
   </entry>
Where desiredvalue is the level of aggressiveness between 0 and 1.0. Set to 0 to turn the algorithm off and return all data points. We recommend increasing the value slowly, if at all, in increments of .05. The default value is 0.1.
3 Start the Dashboard.

For information on stopping the Dashboard, see Section 2.3.1, “Starting the Dashboard,” on page 25.

7.8.3 Configuring Regular Expression Look Up for the Charting Portlet

Optionally, you can setup a list of regular expressions to be available for look up when configuring the Charting portlet. This requires adding code to the globals.custom.xml file.

**NOTE:** The regular expressions list is only loaded from the globals.custom.xml when the Charting portlet is created. If you wish to use this list with existing Charting portlets, you’ll need to recreate the portlet reload new or modified look up lists.

To create a regular expression lookup list for Charting Portlet configurations:

1 Open the /OperationsCenter_Dashboard_install_path/server/webapps/ManagedObjectsPortlets/WEBINF/data/globals.custom.xml file in a text editor.

   If the globals.custom.xml file does not exist, create it.

2 Modify the globals.custom.xml file to incorporate the following code:

   ```xml
   <globals>
       <data>
           <components>
               <component>
                   <name>charting</name>
                   <preferences>
                       <entry>
                           <string>regularExpressions</string>
                           <map>
                               <entry>
                                   <string>expression_name</string>
                                   <string>regular_expression</string>
                               </entry>
                           </map>
                       </entry>
                   </preferences>
               </component>
           </components>
       </data>
   </globals>
   ``

   If creating a new globals.custom.xml file, you will need to paste in the entire example.

   If an entry for the charting component already exists, paste in only the code for the regularExpressions entry, which goes inside the <preferences> tag.

   Replace expression_name with a name for the regular expression entry and regular_expression with the actual regular expression code.

3 Add as many entries as needed inside the <map> tag to fully populate the look up list:
4 Save the file.
5 Restart the Dashboard.

For more information about starting and stopping the Dashboard, see Section 2.3, “Starting and Stopping the Dashboard,” on page 25.

7.8.4 Selecting an Alternate Operations Center Server Connection

By default, all Operations Center portlets retrieve data from the default Operations Center server. Within some portlets, it is possible to poll a different Operations Center server. In this case, a different server profile is selected for the portlet.

Server profiles are used by the Alarms, Charting, Element Properties, Information, Layout, Navigation, Performance, Properties Table, Root Cause, Search, Show Impacted, Starter, Status, Summary, and Tree Map portlets. For information about creating a server profile, see Section 3.8, “Creating Operations Center Server Profiles,” on page 37.

To select a server profile for a portlet:

1 Click the options icon and select Preferences.
2 Click the Advanced tab, then click the Common tab.
3 From the Select the Operations Center server profile where this portlet retrieves its data option, select the server that serves up Operations Center data for the portlet.
   The default establishes a connection with the default Operations Center server.
   For steps on creating a new Operations Center server connection, see Section 3.8, “Creating Operations Center Server Profiles,” on page 37.
4 Because each server profile has an icon associated with it, select to display this icon on the portlet to help distinguish the server from which data is retrieved by selecting the Display the Operations Center server profile icon check box.
   When the server profile icon is enabled to be displayed, hovering over this icon while viewing the content of a portlet shows the profile name in a tooltip.
5 Click Save.
7.8.5 Scheduling Portlets

Cached versions portlet reports can improve performance when viewing portlets by updating the data at scheduled intervals only; not upon every request to view the portlet. Note that the data displayed in a scheduled portlet is no longer real-time because it is serving up.

The following sections describe how to define schedules for portlets:

- “Understanding Portlet Scheduling” on page 96
- “Defining the Schedule” on page 97
- “Forcing a Manual Refresh of Cached Data” on page 98
- “Understanding Cron Strings” on page 98

Understanding Portlet Scheduling

Scheduled reports are useful when information needs to be published and shared with users on a regular basis. For example, a report could be scheduled to run every Monday morning at 6:00 a.m. so that when users log in first thing Monday morning, it is quick and easy to view the latest status.

A portlet can be scheduled to run hourly, daily, weekly, monthly; or a custom schedule specified by a Cron string, such as “every Friday at noon”, or “every weekday and 9:30 am”, or even “every 5 minutes between 9:00 am and 10:00 am on every Monday, Wednesday, and Friday”.

Only some portlets have the Scheduling feature. When available, a Scheduling tab will be available under the Advanced tab in Preferences.

Note the following important aspects and tips on portlet scheduling:

- Portlet data displays in Real-Time until a schedule is set and applied.
- Cached versions created by a schedule only save and cache data for the primary (home) view of the portlet. The extent of the cached data does vary by portlet. However, if a portlet contains links to other views, reports or portlets; these other pages are serving up live data, not cached data.
- When scheduling reports, we recommend running the report before scheduling it, so that a cached version is available in the portal page for the lapse of time before the next scheduled report generation.
- Subsequent changes to the preferences of a scheduled portlet does not take effect until the next scheduled run. To regenerate the report immediately after changes in Preferences, go to Advanced > Scheduling and click Run Now.
- Schedule portlets to run as infrequently as possible, as long as it provides meaningful data. For example, if you only care about data accurate to the hour, there is no need to schedule it more than once per hour. Also consider how long a scheduled portlet is taking to run so that the next scheduled run doesn’t overlap with an existing job for the same portlet. And lastly, minimize the overall load by scheduling portlets in a way that it will not stress the server. For example, with larger reports that run once a day, schedule them during non-peak hours and stagger the start times.
- To confirm a schedule is defined and active for a portlet, go to Preferences > Advanced > Scheduling. If active, the following type of status information displays including the last time the portlet was run and the next scheduled time.
- Scheduled portlets use the associated Operations Center Profile user account. In most cases, this is default profile, which uses the admin account.
When the scheduling job is kicked off in the background, it first logs in with the user account specified in the profile. If the user account is deleted, scheduled jobs fail. Therefore, it is recommended that you set up a profile with a common user that is not associated with a any specific person, so that this user account is always present in the system.

To change the Operations Center profile for the portlet, go to Preferences > Advanced > Common, and select a different profile. For information about creating new profiles, see Section 3.8, “Creating Operations Center Server Profiles,” on page 37.

- The time a scheduled portlet takes to run can vary. To determine how long it is taking, look for the following debug category messages in the formula.trc log file:

  time.log4j.category.com.mosol.portlet.schedule.PortletJob

  An entry is logged when the job is kicked off and when it logs in and out of Operations Center. Calculate the time difference between the login and logout to find how long the job is running to produce the report.

  For information about the formula.trc file, see “Understanding Trace Logs and Content” in the Operations Center Server Configuration Guide.

**Defining the Schedule**

To define a schedule for a portlet:

1. Click the options icon and select Preferences, then click Advanced.
2. Click Scheduling.
   The report scheduler displays.
3. Select one of the Select Schedule radio buttons: Hourly, Daily, Weekly, Monthly, or Cron.
   Depending on the time frame selected, specify the calendar day of the week, day of the month, hour, and minute values, or specify a cron string.
   For more information about cron strings, see “Understanding Cron Strings” on page 98.
4. Click Start Schedule to begin using the schedule.
   The report is now generated based on the selected schedule. The screen provides some basic information about the schedule, when it was created, when it last ran and when it is expected to run again. This screen also provides two possible actions:
   - Run Now: Forces the portlet to re-cache its data immediately.
   - Stop: Unschedules the portlet.
   At this time, the Job Name is used internally only by the scheduling mechanism and should be left as the default, which uses the unique portlet namespace.
5. Click Save.
   If you exit Preferences without clicking Save, your changes are lost.
Forcing a Manual Refresh of Cached Data

To define a schedule for a portlet:

1. Click the options icon and select Preferences, then click Advanced.
2. Click Scheduling.
3. Click Run Now to generate a new version of the cached report.

Understanding Cron Strings

Cron expressions are strings that are actually made up of seven sub-expressions, that describe individual details of the schedule. These sub-expression are separated with white-space, and represent:

1. Seconds
2. Minutes
3. Hours
4. Day-of-Month
5. Month
6. Day-of-Week
7. Year (optional)

Cron expressions use the following special characters:

- * Use to select all values within a field.
- ? Use to declare no specific value. Use to specify something in one of the two fields in which the character is allowed, but not the other. For example, to fire on a particular day of the month (say, the 10th), but it doesn’t matter what day of the week it happens to be, put "10" in the day-of-month field, and "?" in the day-of-week field.
- - Use to specify ranges within a sub-expression. For example, "10-12" in the hour field means "the hours 10, 11 and 12".
- , Use to specify additional values. For example, "MON,WED,FRI" in the day-of-week field means "the days Monday, Wednesday, and Friday".
- / Use to specify increments. For example, "0/15" in the seconds field means "the seconds 0, 15, 30, and 45". And "5/15" in the seconds field means "the seconds 5, 20, 35, and 50". You can also specify "" after the " character - in this case " is equivalent to having ’0’ before the ‘/’. ‘1/3’ in the day-of-month field means "fire every 3 days starting on the first day of the month".
- L (Last) has different meaning in each of the two fields in which it is allowed. For example, the value "L" in the day-of-month field means "the last day of the month" - day 31 for January, day 28 for February on non-leap years. If used in the day-of-week field by itself, it simply means "7" or "SAT". But if used in the day-of-week field after another value, it means "the last occurrence of that day in the month" - for example "6L" means "the last friday of the month". When using the 'L' option, it is important not to specify lists, or ranges of values, as you'll get confusing results.
- W (Weekday) Use to specify the weekday (Monday-Friday) nearest the given day. As an example, if you were to specify "15W" as the value for the day-of-month field, the meaning is: "the nearest weekday to the 15th of the month". So if the 15th is a Saturday, the trigger fires on Friday the 14th. If the 15th is a Sunday, the trigger fires on Monday the 16th. If the 15th is a Tuesday, then it fires on Tuesday the 15th. However if you specify "1W" as the value for day-of-
month, and the 1st is a Saturday, the trigger fires on Monday the 3rd, as it doesn’t ‘jump’ over the boundary of a month’s days. The ‘W’ character can only be specified when the day-of-month is a single day, not a range or list of days.

- # Use to specify "the nth" XXX day of the month. For example, the value of "6#3" in the day-of-week field means "the third Friday of the month" (day 6 = Friday and "#3" = the 3rd one in the month). Other examples: "2#1" = the first Monday of the month and "4#5" = the fifth Wednesday of the month. Note that if you specify "#5" and there is not 5 of the given day-of-week in the month, then no firing occurs that month.

<table>
<thead>
<tr>
<th>Schedule fires...</th>
<th>Cron Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every 5 minutes.</td>
<td>0 0/5 * * * ?</td>
</tr>
<tr>
<td>Every 5 minutes, at 10 seconds after the minute (i.e. 10:00:10 am, 10:05:10 am, etc.).</td>
<td>10 0/5 * * * ?</td>
</tr>
<tr>
<td>Exactly at 10:30, 11:30, 12:30, and 13:30, on every Wednesday and Friday.</td>
<td>0 30 10-13 ? * WED,FRI</td>
</tr>
<tr>
<td>Every half hour between the hours of 8 am and 10 am on the 5th and 20th of every month. Note that the trigger will NOT fire at 10:00 am, just at 8:00, 8:30, 9:00 and 9:30.</td>
<td>0 0/30 8-9 5,20 * ?</td>
</tr>
<tr>
<td>At 10:15am on the last Friday of every month.</td>
<td>0 15 10 ? * 6L</td>
</tr>
</tbody>
</table>

For additional information on the format of the Cron string, consult the Quartz Enterprise Job Scheduler Web site (http://www.quartz-scheduler.org/docs/tutorials/crontrigger.html).

### 7.8.6 Automatic Data Updates with Push Technology

Using push technology, the Dashboard can receive data updates as they occur in the Operations Center server instead of having the Dashboard request updates on a regularly scheduled interval. When enabled, push technology ensures that data is refreshed in the Dashboard only when an event occurs, such as a state change.

Push technology is available for the following portlets: Alarms (except SLA alarms), Information, Layout, Navigation, Properties Table, Status, and Tree Map. By default, these portlets are enabled to refresh content automatically from the Operations Center server. This feature can be disabled in the configuration settings for each portlet (or any portlet that utilizes these portlets as views/links).

Push technology can be enabled globally for all portlets in the Operations Center Dashboard Configuration Manager. See Section 2.2.5, “Configuring the Dashboard, Operations Center Server, and the Image Server,” on page 20. The settings within each portlet override the global setting in the Operations Center Dashboard Configuration Manager.
7.9 Installing Third-Party Software

Some of the portlets in the Dashboard rely on plug-ins or third-party software to display properly.

- Section 7.9.1, “Flash Player,” on page 100

7.9.1 Flash Player

Portlet charts can be rendered in 3D by using the Flash format. However, the Adobe Flash* player does not support a 64-bit Internet Explorer (IE) browser, so when you configure any charting portlet to display Flash graphics, the charts do not display properly in 64-bit Internet Explorer.

You are prompted to install the Flash player. However, if you manually install the player and restart browser, the 64-bit Internet Explorer still asks you to install the plug-in.

Refer to Flash Player support on 64-bit operating systems (http://www.adobe.com/cfusion/knowledgebase/index.cfm?id=6b3af6c9) for more information on this issue.

7.10 Troubleshooting Operations Center Portlets

- Section 7.10.1, “Operations Center server Unavailable,” on page 100

7.10.1 Operations Center server Unavailable

The Operations Center server is currently not accessible. message displays when the Operations Center server is not available. Contact your Operations Center administrator to see when the server is available again. After the Operations Center server is back up, you must log out of the Dashboard and log back in to the Dashboard to see current data.
The following sections contain descriptions and details about Operations Center portlets:

- Section 8.1, “Configuring the Alarms Portlet,” on page 101
- Section 8.2, “Configuring the Charting Portlet,” on page 108
- Section 8.3, “Configuring the Element Properties Portlet,” on page 111
- Section 8.4, “Configuring the Information Portlet,” on page 111
- Section 8.5, “Configuring the Layout Portlet,” on page 116
- Section 8.6, “Configuring the Navigation Portlet,” on page 119
- Section 8.7, “Configuring a Network View Portlet,” on page 120
- Section 8.8, “Configuring the Properties Table Portlet,” on page 121
- Section 8.9, “Configuring the Public End User View Portlet,” on page 123
- Section 8.10, “Configuring the Root Cause Portlet,” on page 124
- Section 8.11, “Search Portlet,” on page 124
- Section 8.12, “Configuring the Show Impacted Portlet,” on page 127
- Section 8.13, “Configuring the Starter Portlet,” on page 127
- Section 8.14, “Configuring the Status Portlet,” on page 128
- Section 8.15, “Understanding the Summary Portlet,” on page 130
- Section 8.16, “Configuring the Tree Map Portlet,” on page 130

8.1 Configuring the Alarms Portlet

The alarms portlet shows a detailed listing of alarms that allows you to click and open the alarm’s properties. A total alarm count indicates the total number of alarms for the element while severity indicators show the number of alarms for each severity. As in the Operations Center console, alarm operations can be performed (when available), alarm filters can be created and applied, and alarm data can be exported to an Excel or PDF file.

The Alarms portlet returns a maximum number of alarms based on a property set on the Operations Center server. For instructions on configuring this property, see Section 7.8.1, “Configuring Default Alarms Limits Returned from the Operations Center Server,” on page 93.
The Alarms Portlet can also be used to set the starting element for other portlets on the Web page, similar to the Navigation portlet. To configure the Alarms portlet to drive other portlets using Navigation, see Step 3 on page 103 and Section 7.4, "Using Navigation Mode to Drive Multiple Portlets," on page 84.

The Alarms portlet is also available as a view from other Operations Center portlets including Layout, Tree Map, Element Properties, Properties Table, Show Impacted, Root Cause, Chart Builder, Performance, and Summary. Click Actions and select Go to > Alarms from any of these portlets.

The following sections cover various Alarm portlet functionality:

- Section 8.1.1, "Viewing Alarms," on page 102
- Section 8.1.2, "Performing Alarms General Configuration," on page 103
- Section 8.1.3, "Applying and Creating Alarm Filters," on page 104
- Section 8.1.4, "Performing Alarm Operations," on page 108

### 8.1.1 Viewing Alarms

The actual alarms shown in the portlet/view depend on various factors set in the configuration options:

- **Alarm Type:** Displays the following types of real-time events:
  - alarms
  - audit events
  - service level breaches
  - service level metrics

  For more information on alarms, see Filtering and Managing Alarms in the Operations Center User Guide.

  For more information on service level breaches and metrics, see the Operations Center Service Level Agreement Guide.

- **Severity:** Displays alarms of varying severities.

  For more information on alarm severities, see Viewing Alarm Severity in the Operations Center User Guide.

- **Alarm Filters:** Limits the number of alarms shown. You can check to see which alarm filters are enabled.

To view the Alarms listing:

1. Do any of the following:
   - Click a severity color indicatory to hide or show matching alarms.
   - Click any column heading to sort the rows in the table in either ascending or descending order.
   - Use the arrow or number buttons to move through data in either the alarm properties or the alarms listing.
   - Click the Pause button, or click on any alarm to pause alarms.
   - Right-click an alarm to access additional options, such as properties, add comments, and driving other portlets (if enabled).
Double-click any alarm to open a list of all alarm properties in a new window.

*(NetIQ AppManager elements only)* Use the three tabs to view a summary of alarm information, all details for the alarm, and even add a comment to the alarm. For more information, see “AppManager Operations Portal Features for NetIQ AppManager Alarms” in the *NetIQ AppManager Operations Portal Getting Started Guide.*

If the Alarm Properties window becomes hidden behind the main browser window when another alarm is clicked, switch back to the Alarm Properties window to view properties on the new alarm.

- Click **Refresh** to refresh data.
- Click the Excel or PDF icons to export the alarm data to an Excel or PDF file.
  
  If the file download window does not open, check your browser settings to see if pop-up dialog boxes are blocked.

### 8.1.2 Performing Alarms General Configuration

To configure preferences for the Alarms portlet:

1. Click the options icon, select **Preferences**, and update settings on the **General** tab.
   
   For other portlets, the **Alarms** tab is found under the **Advanced** tab.

2. Specify the following options:
   
   - **Alarm Table Height**: The number of rows displayed at one time in the table; expressed in pixels. **Defaults to** *auto*.
   
   - **Filter by Severity**: Specify a comma separated list of severities (such as “CRITICAL,MINOR”) to hide alarms with specific severity levels. Leave this field empty to show all alarms. In addition to this option, you can also filter alarms by severity using the colored bar when viewing the alarms.
   
   - **Alarm Columns**: Specify a comma separated list of alarm columns to display (and hide all other columns). Leave blank to display all columns. Columns available to display are dependent on the source of the alarms.
     
     When alarms are currently listed in the portlet, click the browse (...) button to select columns from a list based on a sampling from the current alarms. If no alarms are displayed in the portlet, the selector is unable to show columns to select from. Use the left and right arrow buttons to move a column name between the **Available** list and the **Selected** list. Use the up and down arrows to reorder column names.
   
   - **Sort Alarms by**: Specify a column name to use as a sort key for displayed alarms. Severity is the default sort key. You can also change the sort key while viewing the alarms table by clicking a column heading.
   
   - **Alarms per Page**: Specify the maximum number of alarms to show on each page.

3. Select or deselect the following check box options:
   
   - **Show alarm selectors and filter options**: Selected by default. Shows alarm selectors at the top of the alarms portlet. This includes alarm type drop-down lists and update/pause buttons to apply, alarm filters by severity and options to select or unselect all alarms. Deselect the check box to hide these options.
   
   - **Sort alarms in ascending order by default**: Selected by default. Deselect the check box to initially sort in descending order. Use this option or click column headings when viewing the table to change the sort order.
Highlight alarm rows with severity color: Not selected by default; only the alarm severity column is shaded in each row. When selected, shades the entire row the same color as the severity.

Enable alarm operations: Selected by default. Enables alarm operations to be performed in the Dashboard as they are on the Operations Center console. Deselect the check box to prevent users from performing alarm operations.

Show PDF/Excel export links: Selected by default; allows exporting alarms. Deselect to remove the export options.

Refresh portlet when updates occur: Selected by default. Enables the Dashboard to receive automatic updates from the Operations Center server as content changes occur. Deselect to manually control updates. Note that the Alarm portlet does not support push updates for SLA alarms.

Pause alarms when selecting or driving alarms: Selected by default. Incoming alarms are halted when an alarm is selected. To resume alarms, click the Resume alarms link.

Enable navigation mode: When selected, right-click an alarm and select Drive affected element to drive the content in other portlets. A single-click pauses alarms and a double-click opens alarm properties regardless of whether this option is enabled or not. For more information about setting up portlets to be driven by other portlets, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

Enable historical alarms: By default, real-time alarms are shown. To show real-time audit events, service level breaches, or service level metrics; select Enable historical alarms, then select the alarm type and date range.

4. Click Save.

8.1.3 Applying and Creating Alarm Filters

View a subset of alarms by applying a filter based on one or more alarm properties, such as severity, element ID, or date/time stamp. For example, apply a filter to display only those alarms with a specific severity message or class, or alarms received within a specific date and time range. Each filter consists of one or more conditions, combined using AND or ANY logic.

- “Understanding Alarm Filters” on page 104
- “Enabling an Alarm Filter” on page 105
- “Creating an Alarm Filter” on page 105
- “Understanding Operators and Alarm Values” on page 107
- “Editing and Deleting Filters” on page 108

Understanding Alarm Filters

Note the following important rules about Alarm filters on portlets:

- Alarm Filters are shared by all Alarm portlets: A single list of alarm filters is available to users of any alarm portlet.

- Applying an alarm filter does not change the total alarm count for each severity: At the top of the alarms portlet (if the Show Alarm Options check box is selected on the General tab). For example, if there are a total of 100 CRITICAL alarms, but an applied filter removes these alarms from the table, 100 still displays next in the red severity button.

- Filters are applied in the order in which they are listed: Multiple filters are applied using the AND operator, meaning the resulting set of alarms must match all the active filters.
• **The Alarms portlet supports date-based drive events from the Charting portlet:** The events contain a From and To date that Operations Center uses to filter the existing alarms table by the supplied date range. The filter is applied based on the last update timestamp of the given alarm. A message at the top of the Alarms portlet indicates when the date filter is active and provides an option to clear the filter.

When **Show alarm selectors and filter options** is enabled in portlet **Preferences**, alarm count totals displays at the top of the alarms component. These alarm count totals in the filter button do not change when the filter is applied.

**Enabling an Alarm Filter**

To enable an alarm filter (or to see what is enabled):

1. Click the options icon and select **Preferences** to open the **Filters** tab.
   Note that for other portlets, open the **Advanced** tab to get to the **Alarms** tab.
2. Select the **Active** check box next to filters that should be applied.
   Only the active filters are applied to the alarms; other filters are ignored.
3. From the **Type** drop-down list, specify if matching alarms should be included in the view or excluded from the view by selecting **Include** or **Exclude**.
4. Click **Save** to apply the settings, then click the **Return to Full Page** link to return to the alarms view.
   The active filters are applied and the filtered alarms display.

**Creating an Alarm Filter**

To create an alarm filter:

1. Click the options icon and select **Preferences** to open the **Filters** tab.
   Note that for other portlets, open the **Advanced** tab to get to the **Alarms** tab.
2. On the **Filters** tab, click **New Filter Wizard** to open the Alarm Filter dialog box.
3. In the **Filter Name** field, specify a name for the filter.
4 Click **Add** to display a filter condition row.

5 Define the condition statement by selecting the following:

- **Alarm Column**: Click the **Select Alarm Column** link to specify the alarm column whose values are considered.

  The available alarm column selectors vary depending on adapter and currently selected elements. The input field at the bottom can be used to enter a column name that is not listed. This could be used later for alarms that originate from other elements, because filters are shared by all Alarm portlets.

- **Operator for Comparison**: An operator is used to compare the alarm column value to a specified value (greater than, less than, and so on).

  Operators and comparison value selectors vary depending on the alarm column type and adapters. For more information, see "Understanding Operators and Alarm Values" on page 107.

- **Comparison Value**: A comparison value is used to determine whether an alarm is selected.

  When Severity is the selected alarm column, a drop-down list of severity codes and colors displays in the right column. The codes vary among adapters.

  For a specific date/time comparison, use the calendar selector to select a date. In some cases, a relative “rolling” date/time comparison is necessary. For example, a filter could select alarms that are within 30 days of the current date/time. Use the “is less than” or “is more than” operator to specify the time interval for comparing the current date and time. Also specify whether the filter should pull alarms that are before or after the current date/time.

- **Text-Type Columns**: Specify case-sensitive matching for text-type alarm columns. Select the check box to match exactly each letter in the alarm column with the string entered in the filter field.

6 To define another condition, click **Add**.

   The filter matches alarms with a date and time stamp before the specified date/time and a CRITICAL severity.

7 Select the **Match any of the following** or **Match all of the following** radio button to determine whether alarms must meet any (OR logic) or all (AND logic) of the condition statements defined for the filter.

8 Click **Create** to create the filter.

   Don’t forget to enable the filter! See "Enabling an Alarm Filter" on page 105.
### Understanding Operators and Alarm Values

Table 8-1 provides an overview of the relationships among the three fields used to define alarm filters. The available operators depend on the type of alarm column.

**Table 8-1  Relationships Among Alarm Filter Values**

<table>
<thead>
<tr>
<th>Alarm Column Type</th>
<th>Operators</th>
<th>Match Criteria</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text-based (such as Element, Class, Status, Description)</td>
<td>contains</td>
<td>Specify appropriate value based on selected alarm column.</td>
<td>• For exact matches, use is/is not.</td>
</tr>
<tr>
<td></td>
<td>does not contain</td>
<td></td>
<td>• For partial matches anywhere in an alarm value, use contains/does not contain.</td>
</tr>
<tr>
<td></td>
<td>is</td>
<td></td>
<td>• For partial matches using the first or last characters, use begins with/ends with.</td>
</tr>
<tr>
<td></td>
<td>is not begins with matches regex</td>
<td></td>
<td>• To match column content with a Java Regular Expression, use matches regex and specify the expression in the far right field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• In regular expressions, standard wildcards (?) and (*) are allowed, as well as standard operators, such as OR and BETWEEN.</td>
</tr>
<tr>
<td>Date, Time</td>
<td>is</td>
<td>Specify Date/Time.</td>
<td>To select a date range, create a before and an after statement, joined by the Match all operator.</td>
</tr>
<tr>
<td></td>
<td>is not</td>
<td></td>
<td>For example, to match dates that are within 30 days earlier than the current date, use the criteria: date/time is less than 30 days before the current date.</td>
</tr>
<tr>
<td></td>
<td>is before</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is after</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td>Specify a date/time interval to compare with current time. This is a relative date/time comparison.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is more than</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Severity</td>
<td>is</td>
<td>Select from severity levels appropriate to the adapter.</td>
<td>Use is to not exclude all but one severity code.</td>
</tr>
<tr>
<td></td>
<td>is not</td>
<td>To select a contiguous range of severity codes, create two statements using higher than and lower than, joined by the Match all operator.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is higher than</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is lower than</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeric</td>
<td>begins with</td>
<td>Enter the number.</td>
<td>For exact matches, use is/is not.</td>
</tr>
<tr>
<td></td>
<td>contains</td>
<td></td>
<td>For partial matches anywhere in an alarm value, use contains/does not contain.</td>
</tr>
<tr>
<td></td>
<td>does not contain</td>
<td></td>
<td>For partial matches using the first or last characters, use begins with/ends with.</td>
</tr>
<tr>
<td></td>
<td>ends with</td>
<td></td>
<td>To select a contiguous range of values, create two statements using greater than and less than, joined by the Match all operator.</td>
</tr>
<tr>
<td></td>
<td>is</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is not</td>
<td></td>
<td>After placing the cursor in the filter value column (the last column in the row), enter a value. Otherwise, it is not possible to edit the other columns or close the Alarm Filter dialog box. An error message prompts for a numeric value.</td>
</tr>
</tbody>
</table>
**Editing and Deleting Filters**

Alarm filters can be edited and deleted.

**IMPORTANT:** Ask other users who might share an alarm filter before you modify or remove it.

To edit or delete filters:

1. To edit a filter:
   1a. Edit the filter.
   1b. Click **Save**.
   1c. Click **Edit** next to a filter name to open the Alarm Filter dialog box.

2. To delete a filter:
   2a. Click **Remove** next to a filter name to display a confirmation dialog box.
   2b. Click **OK** to confirm the deletion.

   The filter disappears from the Alarm Filter pane.

### 8.1.4 Performing Alarm Operations

With the alarms portlet, you can perform many of the same operations against alarms that can be performed in the Operations Center console. In some cases, as with Service Level Breaches, alarm operations available in the Dashboard are not identical to those available in the Operations Center console.

Alarms operations are enabled by default in the alarm portlet configuration. The Dashboard has a global option to show alarm operations in all portlets that is set in the Operations Center Dashboard Configuration Manager. However, the configuration options in each portlet override the settings in the Operations Center Dashboard Configuration Manager.

To perform alarm operations:

1. (Optional) Select more than one alarm by selecting the check boxes for the desired alarms.
2. Right-click the selected rows, then select the alarm operation.

   If multiple alarms are selected, the alarm operation applies to all currently selected alarms.

   The operations available depend on the source of the alarm(s). For more information about alarms, see Filtering and Managing Alarms in the Operations Center User Guide.

### 8.2 Configuring the Charting Portlet

The Charting portlet allows you to graphically measure up to 10 metrics from any of these types of data:

- **Element Performance Metrics:** shows element performance or alarm data over time.
- **Availability:** shows element availability (not in a CRITICAL state) during a period of time.
- **Downtime:** shows element downtime (in a CRITICAL state) during a period of time.
- **SLA Compliance:** view SLA data charts to determine if the objectives of a Service Level Agreement are being met.

It creates line, area, column bar, or condition charts that allow you to easily navigate and compare performance over time, and view raw data points if required.
The Charting portlet has the convenience of a left settings panel to configure the chart without having to go back and forth between view-side and edit-side preferences. Once your chart is configured, you can collapse or hide the left panel.

When configured and more than one metric is requested, the chart displays using two scales for y-axis points: one on the left, and the other on the right. There are two ways to check the corresponding y-axis for a metric:

- In the tooltips, arrow indicators show next to metrics that are charted using the right y-axis scale.
- In the legend, metric indicators display to the right of metric names for those that are charted with the right y-axis scale.

To view charts:

1. Do any of the following to configure your chart:
   - Click the Manage Elements link to add or remove metrics from the chart.
     - Click a parent or child element to navigate through the element hierarchy.
     - Select specific metrics to chart, or configure metrics matchers using a regular expression. If more than 10 metrics are selected or found, only the first 10 found are charted.

   When selected element or metric identifiers are not always predictable, it is best to use a regular expression to match profile expressions. For example, when the portlet is driven by another portlet, the selected element will not be fully predictable and a regular expression can match a number of predicted expressions for the element. For instructions on driving, see Step 3 on page 110.

   Or, if the selected profile captures metrics against a correlated service model created by an SCM definition, regular expressions are necessary to match a number of predicted expressions because expression identifiers for correlated metrics are renamed during the Operations Center server restart process or if the correlated service model element is renamed. Correlated metrics are easily recognizable by their naming convention of Correlated Element_Name: Unique_Identifier.

   - For manually selected metrics:
     - Change the metric name, type, line color, thickness and fill for any of the selected metrics.
     - A ✓ next to the metric name indicates this metric is used to populate the data display in the preview slider bar. Click the grayed icon next to a different metric to change the display.
   - Click the Basic tab to configure titles, threshold, y-Axis value range, auto-refresh, and hide or show various chart features.

   Select Allow multiple axis for the chart to use two sets of axis points (an additional y-axis is added on the right side of the chart) when there is a request for more than one metric. If y-Axis minimum and maximum values are configured or if you use the custom y-Axis option, this feature is automatically disabled.

   If the administrator disabled all of the Time Intervals Visibility options in the portlet preferences, the Show time buttons option is not available.

   If the administrator disabled the Enable Calendar option in the portlet preferences, the Show date range option and the associated calendar is not available.
Click the panel's arrow button to collapse the left panel, widening the chart viewing area. Click the arrow button again to expand the left panel.

- Hide the left configuration panel. On the portlet title bar, click Options, select Preferences, and select Hide View Side Options.
- Click Update to view changes in your chart. Click Publish to save changes and push them out to users.

Non-published changes are not persisted between sessions. Only administrators and owners have permissions to publish.

2 Do any of the following when viewing data in the chart:

- Use the preview slider bar to zoom in, click any of the range buttons, or select new dates and times from the date range.
- Select a smaller charting range when data is summarized or incomplete.
  When a request exceeds the maximum number of data points that can be charted at one time, Operations Center generates an automatic representation of existing data and trending. When information can be summarized (for example, when values are numbers and not element conditions), the chart uses averaged data points from the original data and displays a message that there is summarized data. If the data cannot be averaged, metric data is clipped to the maximum number of points possible and the chart displays a message that there is incomplete data.
- Click any metric name in the legend to hide it from the chart.
- Click the icon and select Chart Data to view a list of values for all data points currently showing in the chart. Any hidden metrics are excluded.
  *(NetIQ AppManager elements only)* Click on a specific data point to open a Details dialog showing more information about the data point in that series. Currently, this is only available for NetIQ AppManager elements:
  - The chart display format is FLASH. Data point details are not available for JPEG or PNG outputs.
  - The chart type is line. Data point details are not available for bar charts.
  - The Plot actual data points, instead of normalizing data option is enabled.

When charting raw data, increase performance by reducing the number of data points returned while preserving the natural shape of the line. For more information about configuring this custom setting, see Section 7.8.2, “Configuring Performance Data Point Retrieval from the Operations Center Server,” on page 93.

For more information, see “AppManager Operations Portal Features for Charting NetIQ AppManager Data” in the NetIQ AppManager Operations Portal Getting Started Guide.

3 Use the Charting portlet in drive mode:

3a Configure your metrics using a regular expression.

While it is not required to use a regular expression when driving, it is likely the most effective way to configure the matcher since metric names are usually slightly different even if similar. By casting a wider net, there is a better chance metrics can be found from element to element.

3b The next to the element name shows that this is the configuration to use when driving. Click the grayed icon next to different configuration to change driving configurations.

3c Click a new element in a Navigation, Search, Starter, or Status portlet to update the chart. If data is found for that element using the driving configuration, data shows in the chart.
For information about driving, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

3d Click \( \rightarrow \) to exit drive mode and return to the configuration point.

### 8.3 Configuring the Element Properties Portlet

The Element Properties portlet displays all the properties of the selected element.

Property information can be exported from the Element Properties portlet into Excel and PDF formats. Click the Excel or PDF icon to export the data.

The Element Properties portlet is also available as a view from other Operations Center portlets including Alarms, Layout, Performance, Tree Map, Properties Table, Show Impacted, Root Cause, Chart Builder and Summary. Click Actions and select Go to > Properties from any of these portlets.

To configure the Element Properties portlet:

1. Click the options icon and select Preferences.
2. Click the Element tab to select the element to display.

The only configuration option for the properties component is selecting the element to display.

### 8.4 Configuring the Information Portlet

The Information portlet provides a summarized view of an element’s status. It might also include a graphical display of the element’s layout view and/or an alarms chart.

Based on its settings, the portal can also allow navigation down to any children or up to the parent’s view and displays the current condition and status. Various information is available via tab views including element properties, alarms, layout, root cause, impacted elements, charts, jobs (NetIQ AppManager only), and custom properties (NetIQ AppManager only).

In the Alarms tab, as in the Operations Center console, alarm operations can be performed (when available), alarm filters can be created and applied, and alarm data can be exported to an Excel or PDF file.

In the Charts tab, as in the Operations Center console’s Performance view, view a chart of performance and service level metrics. A preview slider bar allows you to see data trending and easily adjust the selected range. When a metric exceeds the maximum number of data points that can be charted at one time, Operations Center automatically generates the best representation of the data as possible, either by summarizing when data points are numeric values or clipping the data. In either case, you can narrow the chart range to display additional data.

All options are configurable to create a custom display.

The Information portlet is optimized to display at a resolution of 1280 (or greater) in width, and inside a column layout that expands to 50% or greater. For smaller configurations, scroll bars will be implemented on components, such as performance charts.
The Information Portlet can also be used to set the starting element for other portlets on the Web page, similar to the Navigation portlet. To configure the Information portlet to drive other portlets using Navigation, see Step 3 on page 103 and Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

The following sections provide detailed information about the Information portlet:

- Section 8.4.1, “Viewing Element Information,” on page 112
- Section 8.4.2, “Configuring the Information Portlet,” on page 113

8.4.1 Viewing Element Information

The actual information shown in the portlet/view depend on various settings in the configuration options:

- **Element Status**: Displays the condition of the element with date/time of last update.
- **Parents/Children**: Displays simple lists of both parents and children. Click an element name to update the Information portlet for that element.
- **Information Tabs**: View element properties, alarms, alarm summary information, layout/relationship diagrams, network, root cause, and impacted elements; as well as chart any available performance metrics. In addition, view custom properties and jobs (for AppManager elements only).

**NOTE**: Data in the Layout tab displays based on the time zone of the Operations Center server, and not the time zone configured for the Dashboard.

To view element information:

1. Do any of the following:
   - Click the arrow button to close the left panel, expanding viewing area for information in tabs. Click the arrow button again to open the left panel.
   - Click a parent or child element to update the portlet information and navigate through the element hierarchy.
   - Click any of the tabs to view additional information about the current element.
   - In the Alarms, Root Cause, Impacted, and Charts tabs, click the Refresh button to force an update of the information.

2. In the Charts tab, do any of the following:
   - Click the metrics selected link to add or remove metrics from the chart.
   - Select a smaller charting range when data is summarized or incomplete. Use the preview slider bar to zoom in, click any of the range buttons, or select new dates and times from the date range.

   If the administrator disabled the Enable Calendar option in the preferences for the Charts tab, the ability to select new dates and times is disabled.

When a request exceeds the maximum number of data points can be charted at one time, Operations Center generates an automatic representation of existing data and trending. When information can be summarized (for example, when values are numbers and not element conditions), the chart uses averaged data points from the original data and displays a message that there is summarized data. If the data cannot be averaged, metric data is clipped to the maximum number of points possible and the chart displays a message that there is incomplete data.
• Click any metric name in the legend to hide it from the chart.
• Click the icon and select Chart Data to view a list of values for all data points currently showing in the chart. Any hidden metrics are excluded.

3 In the Network tab, do any of the following to configure the diagram:
• Click severity filter boxes to toggle elements in/out of the diagram by state.
• Select the number of levels of children to show in the diagram.
• Select the type of diagram.
• Click the icon and select Revert to Default Settings to reset the diagram.

4 **AppManager Only** In the Jobs tab, view a list of jobs for the machine(s). Double-click a job to view settings and details about the job, even add a comment. For more information, see “AppManager Operations Portal Features for Viewing NetIQ AppManager Jobs” in the *NetIQ AppManager Operations Portal Getting Started Guide*.

5 **AppManager Only** In the Custom Properties tab, view a list of custom properties for the machine(s) or logical servers. If you have manage permissions, you can edit the custom properties and apply the changes to AppManager.

### 8.4.2 Configuring the Information Portlet

To configure preferences for the Information portlet:

1 Click the options icon, select Preferences, and update settings on the Information tab.

2 To change the default view for the portlet, select a new tab name from the Default Tab drop-down list.

3 Deselect the Refresh portlet when updates occur option to manually control updates. When selected, enables the Dashboard to receive automatic updates from the Operations Center server as content changes occur. Note that the Alarm portlet does not support push updates for SLA alarms.

4 Deselect the Enable navigation mode to disable the portlet from updating other portlets on the page when an element is selected in the Information portlet.

When Navigation mode is enabled, the Information portlet functions as a driver for the content displayed in other portlets except for the Navigation portlet. Selecting an element in the Information portlet displays information about the element in other portlets on the page. This feature is only available when using SVG on IE, and is not supported on Firefox. For more information about setting up portlets to be driven by other portlets, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

5 Under Status Panel, select or deselect the following options for the left-side status and navigation panel:

  • **Show left-side status and navigation panel:** Unselected by default. Select to show the left panel with status information and parent/children navigation lists.
  • **Show element notes:** Selected by default. Deselect to hide element notes in the header.
  • **Show condition indicator:** Selected by default. Deselect to hide the element's condition indicator in the status panel.
  • **Show last updated date/time:** Selected by default. Deselect to hide the date and time of the last update.
  • **Show parents:** Selected by default. Deselect to hide the list of parent elements.
Then, select or deselect the following check box options for parents:

- **Allow navigation above originating element**: Selected by default. Deselect to restrict upward navigation to the selected element in portal preferences.

- **Filter parents via originating element**: Selected by default. Shows the parent element whose DName partially matches the selected element; this is the parent where the selected element was originally created in the Operations Center hierarchy. Deselect the option to show all parents -- this includes any parents under Service Models where the element is linked.

  For example, if the selected element is from a NetIQ AppManager adapter, and is also linked from three Service Model elements, we would see only one parent listed (the parent element in the NetIQ adapter hierarchy) when this option is selected. We would see a total of four parents listed (the parent in the NetIQ adapter hierarchy, plus the three parents in the Service Model hierarchy) when this option is unselected.

**Show children**: Selected by default. Deselect to hide the list of children elements.

Then, specify the following options for children:

- **Halt navigation**: Specify the number of levels of children that are available for navigation under the selected element in portal preferences.

6 Under **Properties Tab**, select or deselect the following options for element properties:

**Show Properties tab**: Selected by default. Deselect to hide the Properties tab.

7 Under **Custom Properties Tab**, select or deselect the following check box options for custom properties:

**Show Custom Properties tab**: Selected by default. Deselect to hide the Custom Properties tab.

8 Under **Alarms Tab**, select or deselect the following options for alarms:

**Show Alarms tab**: Selected by default. Deselect to hide the Alarms tab.

**Default View**: Specify the type of alarm information to show. Select between Alarm Summary and Alarm Listing.

**Filter by Severity**: Specify a comma separated list of severities (such as “CRITICAL,MINOR”) to hide alarms with specific severity levels. Alarms with matching severities will not show in the information portlet. Leave this field empty to show all alarms. In addition to this option, you can also filter alarms by severity using the colored bar when viewing the alarms.

**Alarm Columns**: Specify a comma separated list of alarm columns to display (and hide all other columns). Leave blank to display all columns. Columns available to display are dependent on the source of the alarms.

If alarms are currently displayed in the portlet, click the browse (...) button to select columns from a list based on a sampling from the current alarms. If no alarms are currently displayed in the portlet, the selector is unable to show columns to select from. Use the left and right arrow buttons to move a column name between the Available list and the Selected list. Use the up and down arrows to reorder column names.

**Sort Alarms by**: Specify a column name to use as a sort key for displayed alarms. Severity is the default sort key. You can also change the sort key while viewing the alarms table by clicking a column heading.

**Alarms per Page**: Specify the maximum number of alarms to show on each page.

Then, select or deselect the following check box options for alarms:

**Sort alarms in ascending order by default**: Selected by default. Deselect to initially sort in descending order. Use this option or click column headings when viewing the table to change the sort order.
Highlight alarm rows with severity color: Not selected by default; only the alarm severity column is shaded in each row. When selected, shades the entire row the same color as the severity.

Enable alarm operations: Selected by default. Enables alarm operations to be performed in the Dashboard as they are on the Operations Center console. Deselect to prevent users from performing alarm operations.

Show PDF/Excel export links: Selected by default; allows exporting alarms. Deselect to remove the PDF and Excel options.

Under Layout Tab, select or deselect the following options for layout diagrams:

Show Layout tab: Selected by default. Deselect to hide the Layout tab.

Then, specify the following options for the layout diagram:

- **Layout Type**: Specify the type of layout to display. Select between Classic and Relationships.
- **Output Type**: Specify the type of technology used to display the diagram. Select between SVG and Flash.
- **Show layout type selector in view mode**: Selected by default to allow the user to toggle between layout types in view mode.
- **Diagram Width**: Determines the size of the diagram within the portlet and is expressed as a percentage. The default is 100%.
- **Diagram Height**: Determines the height of the diagram within the portlet and is expressed as pixels. The default is auto.
- **Automatically scale diagram**: Select this option to resize the diagram to fit it inside the specified Diagram Width and Diagram Height. When this option is selected and Diagram Height is set to auto, the diagram fills the horizontal space, and then expands vertically as needed. If the Diagram Height is set to a fixed size, the diagram reduces in size until it fits in the space. Deselect this option to render the diagram without resizing; scroll bars are added as needed to view the diagram.

Under Network Tab, select or deselect the following options for the network display of elements:

Show Network tab: Selected by default. Deselect to hide the Network tab.

Then, specify the following options for the layout diagram:

- **Diagram Width**: Determines the size of the diagram within the portlet and is expressed as a percentage. The default is 100%.
- **Diagram Height**: Determines the height of the diagram within the portlet and is expressed as pixels. The default is auto.
- **Automatically scale diagram**: Select this option to resize the diagram to fit it inside the specified Diagram Width and Diagram Height. When this option is selected and Diagram Height is set to auto, the diagram fills the horizontal space, and then expands vertically as needed. If the Diagram Height is set to a fixed size, the diagram reduces in size until it fits in the space. Deselect this option to render the diagram without resizing; scroll bars are added as needed to view the diagram.

Under Root Cause/Impacted Tabs, select or deselect the following options for root cause and impacted elements:

Show Root Cause tab: Selected by default. Deselect to hide the Root Cause tab.

Show Impacted tab: Selected by default. Deselect to hide the Impacted tab.

Under Charts Tab, select or deselect the following check box options for charts:

Show Charts tab: Selected by default. Deselect to hide the Charts tab.
Then, specify the following options for the chart:

- **Default Range**: Select the length of time shown in the chart when it initially loads.
- **Default Metrics**: Specify a regular expression to select and chart performance metrics to chart by default. If specified, the Information portlet attempts to find and charts metrics based on the regular expression. If no matching metrics are found for the selected element, you can manually select metrics applicable to that element. If matching metrics are found, the chart renders the first 10 metrics found. The chart can then be edited to change the selected metrics.

13 **Under Jobs Tab**, select or deselect the following check box options for jobs:

- **Show Jobs tab**: Selected by default. Deselect to hide the Jobs tab.
14 Click **Save**.

### 8.5 Configuring the Layout Portlet

The Layout component displays either the **Layout View** or the **Relationship View** (created in the Relationship Browser window) from the Operations Center console. For more information about the **Layout View**, see the *Operations Center Custom Drawing and Layout Guide*. For information on the Relationship Browser drawings, see the *Operations Center Service Modeling Guide*.

The Layout portlet is also available as a view from other Operations Center portlets including Alarms, Performance, Tree Map, Element Properties, Properties Table, Show Impacted, Root Cause, Chart Builder and Summary. Click **Actions** and select **Go to > Layout** from any of these portlets.

By default, **Figure 8-1** shows the element’s **Layout View** and is **automatically updated** when the element changes in the Operations Center server:

*Figure 8-1 Layout Portlet showing a Layout view for an Adapter*

---

**NOTE**: Data in the Layout portlet displays based on the time zone of the Operations Center server, and not the time zone configured for the Dashboard.

To view and configure the Layout portlet:

- **Section 8.5.1**, “Navigating in the Layout Portlet,” on page 117
- **Section 8.5.2**, “Configuring the Layout Portlet,” on page 117
- **Section 8.5.3**, “Adjusting the Scale for Layout Diagrams,” on page 118
8.5.1 Navigating in the Layout Portlet

While viewing the Layout portlet, do any of the following:

- Click an element to drill down.
- Click the home icon to return to the element first displayed.
- Click the back icon to view the previous element or other previously viewed parent elements.
- When defined, click the element to open a Web page or URL.

This feature requires a custom property definition configuration in the Operations Center console. For information, see Section 7.6, “Configuring URL Linking for the Layout Portlet,” on page 91.

- When a predefined tool tip or pop-up dialog was configured in the Layout View of the Operations Center console, hover the mouse over an element to show the tool tip or pop-up:

For information on how to define a tool tip/pop-up dialog, see "Adding Tooltips or Pop-Ups to Portlets in the Dashboard" in the Operations Center Custom Drawing and Layout Guide.

8.5.2 Configuring the Layout Portlet

To configure the Layout portlet/view:

1. Click the options icon and select Preferences.
2. Click the Layout tab.

For other portlets other than Layout, the Layout tab is found under the Advanced tab.

3. Specify the following options:

   **Diagram Width**: Determines the size of the diagram within the portlet and is expressed as a percentage. The default is 100%.

   For SVG diagrams, for changes to the diagram width to take effect, you must also select the Automatically scale diagram option.

   **Diagram Height**: Determines the height of the diagram within the portlet and is expressed as pixels. The default is auto.
Maximum Auto Height: If you set Diagram Height to auto, the maximum vertical space for the portlet, in pixels.

Output Format: Select SVG or Flash. Note that custom background colors are not rendered when using Flash output.

4 Select or deselect the following check box options:

Show the relationships instead of Layout diagram: By default, this option is not selected and the layout diagram displays. Select the check box to show relationships between the current element and other elements.

Show navigation options: Selected by default. Displays the home and back/history icons in the diagram. Deselect to hide the options.

Automatically scale diagram: Select this option to resize the SVG diagram to fit it inside the specified Diagram Width and Diagram Height. When this option is selected and Diagram Height is set to auto, the diagram fills the horizontal space, and then expands vertically as needed. If the Diagram Height is set to a fixed size, the diagram reduces in size until it fits in the space. Deselect this option to render the diagram without resizing; scroll bars are added as needed to view the diagram.

Enable navigation mode: If selected, enables the Layout portlet to function as a driver for the content displayed in other portlets except for the Navigation portlet. Selecting an element on the Layout drawing displays information about the element in other portlets on the page. This feature is only available when using SVG on IE, and is not supported on Firefox. For more information about setting up portlets to be driven by other portlets, see Section 7.4, "Using Navigation Mode to Drive Multiple Portlets," on page 84.

Then, specify additional options for navigation mode:

- Allow drill-down when clicking on elements: If selected, updates the Layout diagram to display children of a selected element. If not selected, the diagram does not change. Navigation mode must be enabled for this option to apply.

- Portlet Identifiers: Specify a comma-separated list of portlet tags corresponding to other portlets on the page that should update to display information related to an element selected on the Layout portlet. For information on tagging portlets, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

Refresh portlet when updates occur: Selected by default. Enables the Dashboard to receive automatic updates from the Operations Center server as content changes occur. Deselect to manually control updates.

Refresh portlet every X Seconds/Minutes/Hours: If selected, forces a refresh of layout portlet content. Specify the time interval to perform the refresh action. When using SVG, and containing charts with a refresh interval (configured in Operations Center), the chart refresh interval is used if set to be more frequent than the Refresh portlet setting above. If there is more than one chart in the layout, the shortest (most frequent) refresh interval configuration is used for the portlet.

5 Click Save before exiting the configuration options.

8.5.3 Adjusting the Scale for Layout Diagrams

Various configuration settings are available to customize how custom drawings and diagrams display in the Layout portlet. For example, we suggest the following settings in the portlet’s edit-side options:

- Diagram Width to 100%
- Diagram Height to auto
- Select the Automatically scale diagram option
These selections display the diagram in the horizontal space provided, then adjusts the height proportionally. If the drawing is naturally too big for the space, it will scale down to fit. However,

If Diagram Height is set to a fixed size when the Automatically scale diagram option is enabled, the diagram will reduce in size as much as it needs to fit into the space.

In either case, the drawing will not ever be displayed larger than it’s natural size. And, on occasion, a custom drawing can feel too small in the portlet space, as compared to other elements on the page or other layout diagrams when driving the Layout portlet. When this occurs, do the following:

1. In the Operations Center console, open the custom drawing in the Layout view.
2. Switch the view to Edit Mode.
3. Right-click the background, select Enable Dashboard Fit-to-Space Scaling.
4. Save the drawing.

### 8.6 Configuring the Navigation Portlet

Use the Navigation portlet to set the starting element for other portlets on a page. The Navigation portlet displays an element hierarchy with icons show the element’s current condition. For more information on element status, see Monitoring Elements and Element State in the Operations Center User Guide.

The elements displayed depend on the user’s permissions in Operations Center. Click the + and – icons to expand and collapse the element hierarchy displayed on the Navigation portlet.

By default, the element selected on the Navigation portlet is the element shown in all portlets on the page (where applicable). This is similar to the Configuring the Starter Portlet (page 127). The default starting element is the user’s home element.

If both a Navigation portlet and a Starter portlet exist on the same page, either portlet can be used to drive other portlets on the page. However, after a portlet is set up to be driven by the Navigation portlet, it is no longer driven by the Starter portlet (and vice versa), unless set up on the Starter portlet, too.

To configure the Navigation portlet:

1. Click the options icon and select Preferences.
2. In the Height field, specify the height in pixels, or auto to allow the portlet to grow vertically as needed.
3. From the Indicator Image drop-down, select a status icon shape, or select None to hide status indicators.
4. From the Element Link Behavior drop-down, select the expected behavior to happen when element name links are clicked:
   - **Expand and Drive**: Expands the tree to show any element children and updates the content on the page.
   - **Expand Only**: Expands the tree to show any element children.
   - **Drive Only**: Updates the content on the page.
When the **Element Link Behavior** is set to drive other portlets, the Navigation portlet updates all other portlets on the page when clicking on an element name. To drive only specific portlets on the page, you need to reference those portlets in the Advanced options. For instructions, see *Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,”* on page 84.

5 Deselect the **Refresh portlet when updates occur** option to manually control updates to the portlet. This option is selected by default and enables the Dashboard to receive **automatic updates** from the Operations Center server as content changes occur.

6 Click **Save**, then exit the preferences for the portlet.

### 8.7 Configuring a Network View Portlet

The Network View Portlet renders an enhanced layout of the element hierarchy, including relationships between such objects as technology and service components. The Network portlet provides similar functionality as the Network tab found in the Operations Center console.

- Click an element node to drill-down. Click the back or home button to navigate upwards.
- Using condition buttons, filter elements in and out based on severity.
- Select the depth of child elements to show.
- Connector styles correspond to relationship type:

<table>
<thead>
<tr>
<th>Basic parent-child</th>
<th>One element is a natural child of the other element, meaning it was created directly under its parent. This occurs most often in relationships between elements under the <strong>Elements</strong> root element.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Linked parent-child</th>
<th>One element is a linked child of the other element. This occurs in the <strong>Services</strong> hierarchy when a child element is linked using the <strong>Link</strong> option. It contributes to the condition of the linked parent.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Dependency</th>
<th>One element is dependent on the other element. This occurs when dependency relationship information is available, mostly through the use of Discovery Tools.</th>
</tr>
</thead>
</table>

For information about the discovery tools that Operations Center supports, see the *Operations Center Adapter and Integration Guide*.

- Select from various preset layout styles including circles, compact tree, diagrammatic, left to right, legacy network, molecular, network, and top down. These presets types are available to all users (GLOBAL), for a user only (USER), or for a single element (ELEMENT).
To configure the Network portlet:

1. Click the options icon and select Preferences.

2. In the Diagram Width field, specify the height in pixels, or auto to allow the portlet to grow vertically as needed.

3. In the Diagram Height field, specify the height in pixels, or auto to allow the portlet to grow horizontally as needed.

4. Select or deselect the following check box options:
   - **Show navigation options**: Selected by default. Displays the home and back/history icons in the diagram. Deselect to hide the options.
   - **Automatically scale diagram**: Select to render the SVG diagram using the specified width and height. Deselect the check box to render the diagram using the dimensions calculated by the software, which, in general, provide the best scaled view.
   - **Enable navigation mode**: If selected, enables the Network portlet to function as a driver for the content displayed in other portlets except for the Navigation portlet. Selecting an element on the Network portlet displays information about the element in other portlets on the page. This feature is only available when using SVG on IE, and is not supported on Firefox. For more information about setting up portlets to be driven by other portlets, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

   Then, specify additional options for navigation mode:
   - **Allow drill-down when clicking on elements**: If selected, updates to display children of a selected element. If not selected, the diagram does not change. Navigation mode must be enabled for this option to apply.
   - **Portlet Identifiers**: Specify a comma-separated list of portlet tags corresponding to other portlets on the page that should update to display information related to an element selected on the Network portlet. For information on tagging portlets, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84.

   **Refresh portlet when updates occur**: Selected by default. Enables the Dashboard to receive automatic updates from the Operations Center server as content changes occur. Deselect to manually control updates.

   **Refresh portlet every X Seconds/Minutes/Hours**: If selected, forces a refresh of Network portlet content. Specify the time interval to perform the refresh action.

   When using SVG, and containing charts with a refresh interval (configured in Operations Center), the chart refresh interval is used if set to be more frequent than the Refresh setting above. If there is more than one chart in the layout, the shortest (most frequent) refresh interval configuration is used for the portlet.

5. Click Save, then exit the preferences for the portlet.

### 8.8 Configuring the Properties Table Portlet

The Properties Table portlet provides a summary view of an element and its children. It can be customized for the number of properties shown and the order that they display.

Property table information can be exported from the Properties Table portlet into Excel and PDF formats. Click the Excel or PDF icon to export the data.
The Properties Table portlet is also available as a view from other Operations Center portlets including Alarms, Layout, Tree Map, Element Properties, Show Impacted, Root Cause, Chart Builder, Performance and Summary. Click Actions and select Go to > Properties Table from any of these portlets.

- Section 8.8.1, “Viewing the Properties Table Listing,” on page 122
- Section 8.8.2, “Configuring the Portlet Properties Table,” on page 122

8.8.1 Viewing the Properties Table Listing

To view the Properties Table listing:

1. To sort data by severity, click the Condition heading.
2. To sort the data in descending or ascending order according to that property, click any column heading.
3. Click the Excel or PDF icons to export the element property data to an Excel or PDF file.
   If the file download window does not open, check your browser settings to see if pop-up dialog boxes are blocked.

8.8.2 Configuring the Portlet Properties Table

- “Configuring Columns for the Properties Table” on page 122
- “Adding Properties” on page 123

Configuring Columns for the Properties Table

To configure column heading for the Properties Table:

1. Click the options icon and select Preferences.
   The columns currently displayed appear on the Current tab.
2. Deselect the Refresh portlet when updates occur option to manually control content updates to the portlet. This option is selected by default and enables the Dashboard to receive automatic updates from the Operations Center server as content changes occur.
3. Deselect the Hide parent element from display option to show the parent element in the properties table.
4. Make changes to the property columns included in the portlet:
   - To remove the column from the Properties Table display without deleting it from Preferences, select the option’s Disable check box.
   - To edit any of the properties, click the associated Edit Property link.
     For instructions, see “Adding Properties” on page 123.
   - To delete a property column from Preferences, select the option’s check box, and click Remove.
5. After making the necessary configurations, click Save.
Adding Properties

To add a new property to the Properties Table:

1. Click Add Properties.
2. Specify the following options:
   - **Property Name**: Specify the name to display on the portlet.
   - **Operations Center Property**: Specify the name of the Operations Center property.
   - **Text Before**: (Optional) Specify any text to display in front of the property’s value. For example, $.
   - **Text After**: (Optional) Specify any text to display after the property’s value. For example, %.
3. Specify the following check box options:
   - **Highlight property background when the following conditions are met**: If enabled, use the selectors to set a value at which the background is highlighted, then specify a background color.
     The colors are mapped to conditions on the Operations Center console. For more information, see Managing Condition/Severity Colors in the Operations Center User Guide.
4. Click Add Property.
5. Click the Current tab to specify the display order for the new property.

8.9 Configuring the Public End User View Portlet

The Public End User View portlet provides a quick indication of status to guest users (not logged into the Dashboard and Operations Center).

Elements display with a graphical status indicated by a weather condition graphic.

For more information on elements and their various states, see Monitoring Elements and Element State in the Operations Center User Guide.

When this portlet is added to a private or site page, logged in users can see the elements for which they have View permissions in the Operations Center server. They can also configure the elements displayed using the Elements tab in the preferences.

To enable guest users view the Public End User View portlet:

1. Log in to the Dashboard.
2. Add the portlet to a public dashboard Web page.
3. To set the log in credentials for the portlet on the Home tab of the preferences:
   3a. On the portlet title bar, click Options and select Preferences.
   3b. Click the Home tab.
   3c. Specify the Login and Password for a user who has the permissions required to view the selected elements.
   3d. Click Save.
4 To set the configuration option for the portlet to allow guest users to view the portlet:
   4a On the portlet title bar, click the options icon and select Configuration. The Permissions tab displays.
   4b Configure Guest permissions as desired.
   4c Click Submit.
5 Select the elements to be displayed using the Elements tab of the preferences.

8.10 Configuring the Root Cause Portlet

The Root Cause portlet displays both a summary and details regarding the cause of the selected element’s current state.

The Root Cause portlet is also available as a view from other Operations Center portlets including Alarms, Layout, Tree Map, Element Properties, Properties Table, Show Impacted, Chart Builder, Performance and Summary. Click Actions and select Go to > Root Cause from any of these portlets.

Element state is indicated by a status icon, the color of which corresponds to the element’s current condition that is mapped to colors in the Operations Center server. For more information about element condition settings, see Managing Condition/Severity Colors in the Operations Center User Guide.

Element details can vary by the type of element and the alarms associated with it. Details, which is a configuration turned off by default, can include the number of active alarms, the highest alarm severity, the alarm id numbers, and so on.

To configure the Root Cause portlet:

1 Click the options icon and select Preferences.
2 Click the Root Cause tab.
   For other portlets other than Root Cause, the Root Cause tab is found under the Advanced tab.
3 Select the Display Notes check box to display more details for each element.
4 Click Save.

8.11 Search Portlet

The Search portlet is used to find elements in the Operations Center hierarchy. The Search portlet returns only native elements within the Operations Center hierarchy, and does not return any linked instances of an element.

View information about the properties of found elements in the search results. Or, use it to update the starting elements in other portlets by selecting one of the found elements. In addition, you can:

- Section 8.11.1, “Configuring Search Parameters,” on page 125
- Section 8.11.2, “Configuring Properties for Found Elements,” on page 126
8.11.1 Configuring Search Parameters

To configure search parameters:

1. To search for elements, enter the element name or a portion of the name and a wildcard (*), then click Search.
   This is the default type of search.
   Define other types of searches using the search parameters.
2. To set search parameters, click the options icon and select Preferences.
3. Click the Search tab, then click the Configuration tab.
4. Configure the following options that are available to portlet users:
   - **Element Name Label**: Creates a label that shows next to the element name field.
   - **Property**: (Optional) Creates a new search field on the specified element property. Type the property name as it appears in Operations Center. Also specify a text description of the property in the Property Label field; this can aid users in knowing what to enter for the search.
   To look up a property name in the Dashboard, use the Element Properties portlet or Information portlet. For information on looking up element properties in the Operations Center console, see "Viewing Element Properties" in the Operations Center User Guide.
   - **Enable Max Results option**: (Optional) Provide users with the option of setting a maximum number of results before conducting the search.
     - **Max Results Label**: (Optional) Add a text description for the Max Results option. The description displays on the Search portlet. Defaults to Max Results when not specified.
5. To narrow the search, add the following search constraints:
   - **Class**: To limit the search to elements of a specific class, enter the class name as it appears in Operations Center. The search results include elements in that class only. For more information about classes, see the Operations Center Service Modeling Guide.
   - **Condition**: To limit the search to elements of a specific condition, enter the condition as it appears in Operations Center. For more information on element conditions, see Managing Condition/Severity Colors in the Operations Center User Guide.
   - **Scope**: Restrict the search to only the top level at which the element is first found by selecting ONELEVEL. To include child elements of the first found element, select SUBTREE.
   - **Depth**: Select the number of levels to search for elements. The default is 10.
   - **Timeout**: To prevent the search from running indefinitely, add a timeout value as the number of minutes. The default is 1.
   - **Default Results**: The number of search results to display. Defaults to 20. If set to 0, then no limit is set and all results are returned.

   **TIP**: Consider implementing options that sets limits on search results. Restricting the search results can be helpful to reduce the amount of time it takes for users to obtain results.
6. Click Save.
8.11.2 Configuring Properties for Found Elements

By default, elements found using the Search portlet display the element condition, including both the condition severity text and associated color. Other properties associated with an element in the Operations Center server might also be displayed.

For information on properties in Operations Center, see Viewing Element Properties in the Operations Center User Guide. For instructions on creating custom element properties for service model elements, see Defining Properties for a Property Page in the Operations Center Service Modeling Guide.

To configure properties for found elements:

- “Adding Properties Displayed in Search Results” on page 126
- “Setting the Order in Which Properties are Displayed” on page 127

Adding Properties Displayed in Search Results

To add properties displayed for elements found after a search:

1. Click the options icon and select Preferences.
2. Click the Search tab, then click the Add Properties tab.
3. Specify the following options:
   - **Property Name:** Enter the name to display in the column to describe the property. This field is required. It can be any text.
   - **Operations Center Property:** Enter the property name as it appears in Operations Center. The name is required, is case-sensitive and must match exactly.
   - To look up a property name in the Dashboard, use the Element Properties portlet or the Information portlet. For information on looking up element properties in the Operations Center console, see “Viewing Element Properties” in the Operations Center User Guide.
   - **Text Before:** To display anything before the property value, such as a dollar sign ($), enter it here.
   - **Text After:** To display anything after the property value, such as a % sign, enter it here.
4. Specify the following check box options:
   - **Highlight property background when the following conditions are met:** If enabled, use the selectors to set a value at which the background is highlighted, then specify a background color.
     - The colors are mapped to conditions on the Operations Center console. For more information, see Managing Condition/Severity Colors in the Operations Center User Guide.
5. Click Add Property.
6. Click the Current tab to specify the display order for the new property.
7. Click Add Property.
Setting the Order in Which Properties are Displayed

To set the order that the properties are displayed and edit the properties displayed:

1. Click the Current tab.
2. After selecting properties to display for elements found after a search, edit a property by clicking Edit Property.
   The options are the same as when you added the property. The properties display in a table after the search is complete according to the order that they were added.
3. Click the up and down arrows next to the property to change the order.
4. Click Save after making any changes.
5. To remove a property, select it, then click Remove.

**WARNING:** This option cannot be undone. When you remove a property, you must add it again in order to see it in the portlet.

6. Click Update to save all changes.

8.12 Configuring the Show Impacted Portlet

The Show Impacted portlet shows the elements that are affected by the current state of the selected element in both a summary view and a detailed view.

The Show Impacted portlet is also available as a view from other Operations Center portlets including Alarms, Layout, Tree Map, Element Properties, Properties Table, Root Cause, Chart Builder, Performance and Summary. Click Actions and select Go to > Impacted from any of these portlets.

Element state is indicated by a status icon, the color of which corresponds to the element’s current condition that is mapped to colors in the Operations Center server. For more information about element condition settings, see the Managing Condition/Severity Colors in the Operations Center User Guide.

Element details can vary by the type of element and the alarms associated with it. Details, which is a configuration turned off by default, can include the highest child condition, the highest alarm severity, the number of active alarms, the number of active critical alarms, and so on.

To configure the Impacted portlet/view:

1. Click the options icon and select Preferences.
2. Click the Impacted tab.
   For portlets other than Show Impacted, the Impacted tab is found under the Advanced tab.
3. Select the Display Notes check box to display more details for each element.
4. Click Save.

8.13 Configuring the Starter Portlet

The element displayed on the Starter portlet is the starting element for all the portlets on the page. The Starter portlet initially shows the home element for the user.

Additional elements can be added to the Starter portlet to create a flat list of elements and their statuses. Clicking any of the elements, drives other portlets on the page.
You can customize the icon used as the status indicator for the element. The color of the icon identifies its current condition. The color is based on the colors set for condition in the Operations Center server. For more information, see Managing Condition/Severity Colors in the Operations Center User Guide.

To configure the Starter portlet:

1. Click the options icon and select Preferences.
2. Do the following to change the starting element, or add additional elements:
   2a. Click the Elements tab. The current start element displays with any additional configured elements.
   2b. Click the Available Element(s) tab.
   2c. Use the Search or Navigate tabs to locate, then select one or more elements.
   2d. Click Add Element(s).
   2e. Click Save.
3. Click the Starter tab to select the status indicator icon, and then click Save.

8.14 Configuring the Status Portlet

The Status portlet shows the current condition of one or more elements. The condition color is the same severities as shown on the Operations Center console. For more information about element condition and the color indicators, see Managing Condition/Severity Colors in the Operations Center User Guide.

The Status Portlet can also be used to set the starting element for other portlets on the Web page, similar to the Navigation portlet. To configure the Status portlet to drive other portlets, see Section 8.14.2, “Configuring the Status Portlet,” on page 129 and Section 7.3.2, “Configuring Starting Elements for Portlets,” on page 84.

- Section 8.14.1, “Using the Status Portlet,” on page 128
- Section 8.14.2, “Configuring the Status Portlet,” on page 129

8.14.1 Using the Status Portlet

While viewing a Status portlet:

- Hover the mouse over the name of the element to view any available element information or any menu options.
  You might see the date and time that the element was last updated, notes for the element, and links to other portlet components.
- If the Status Portlet is being used as a driver portlet, click any element to update other portlets on the page.
8.14.2 Configuring the Status Portlet

You can configure the type of icon displayed shown on the Status portlet. By default, the condition is automatically updated when the element’s condition changes in the Operations Center server. You can turn off this option in the preferences.

To configure the Status portlet:

1. Click the options icon and select Preferences.
2. Use the options in the Status tab to configure portlet features. For portlets other than Status, the Status tab is found under the Advanced tab.
   2a Specify the following options to configure the Status portlet to display the condition of an element:
      Show Elements: Show selected elements only, selected elements with children elements, or selected elements children elements only. Regardless of the selection, the Dashboard implements user permissions as assigned in Operations Center. A user must have permission to view an element in order to see its status. For more information on permissions, see the Operations Center Security Management Guide.
      Status Indicator: Select a square, oval, or arrow for the type of icon to display the current condition. The default is a square.
      Number of Columns: Enter a number and the portlet calculates how to display the elements using the specified number of columns. The default is 3.
      Status Title: Specify a description for the portlet information in the Status Title text area. HTML coding is accepted in the text description. Use HTML for additional formatting, such as font style or line breaks. Select the Hide title check box to remove the title description on the portlet.
      Align Status Title: Select left, right, or center to display the descriptive text horizontally.
   2b Select the following options to enable mouse-over options on elements:
      Select Date/time of last update to show the last date and time that the element was updated, when the mouse hovers over the element.
      Select Element notes to show all comments saved for the element on the Operations Center console, when the mouse hovers over the element. For more information on comments associated with elements, see Monitoring Elements and Element State in the Operations Center User Guide.
      Select Links to view element in different portlet to show links to additional components, when the mouse hovers over the elements. Then expand the option to select the actual components to show links for. Click the Advanced tab to configure the options for each component.
   2c Select Refresh portlet when updates occur to enable automatic updates of the condition of elements displayed. The condition of an element changes automatically when the condition changes in the Operations Center server. Deselect the check box to control updates manually.
   2d Click Save.
3. Click the Elements tab to select the elements to display.
4. For options to use the Status portlet to set the starting element of other portlets on the Web page, click the Advanced tab, then click the Common tab.
   For information about making these configurations, see Using Navigation Mode to Drive Multiple Portlets (page 84).
5. Click Save.
8.15 Understanding the Summary Portlet

The Summary portlet has two views. The Alarm Summary view shows the total number of alarms for the element by severity, along with the percentage of alarms for each severity. The Alarm Listing view provides the total alarm count for the element along with severity indicators that show the number of alarms for each severity. You can select individual or multiple alarms to perform actions such as view alarm properties or add comments, create and apply alarm filters, and export alarm data to an Excel or PDF file. To configure the Summary portlet, click the options icon and select Preferences, click Advanced, and then click Alarms. For information about the configuration options, see Section 8.1.2, “Performing Alarms General Configuration,” on page 103.

8.16 Configuring the Tree Map Portlet

A tree map allows you to visualize data significance. The size of a square provides an indication of the data element’s importance either by condition or alarm count. And, the color of each square represents its severity.

The Tree Map portlet is also available as a view from other Operations Center portlets including Alarms, Layout, Element Properties, Properties Table, Show Impacted, Root Cause, Chart Builder, Performance, and Summary. Click Actions and select Go to > Treemap from any of these portlets.

- Section 8.16.1, “Changing the Tree Map Portlet Display,” on page 130
- Section 8.16.2, “Configuring the Tree Map,” on page 130

8.16.1 Changing the Tree Map Portlet Display

While viewing a Tree Map portlet:

- To hide elements based on their color, click the color in the color bar.
  The color indicators for severity are set on the Operations Center console. For more information, see Managing Condition/Severity Colors in the Operations Center User Guide.
- To specify the number of levels traversed to calculate the value for the weight of the element, change the Element Depth selection.
- To change how the element is evaluated to determine the size of the square, click the Size Area by list to select between Condition or Alarm Count.
- To drill down into the hierarchy, click the name in a square.

8.16.2 Configuring the Tree Map

To configure the Tree Map portlet/view:

1. Click the options icon and select Preferences.
2. Click the Tree Map tab.
For other portlets other than Tree Map, the Tree Map tab is found under the Advanced tab.

3 Specify the following options:

   **Width**: Sets the width of the tree map within the portlet and is expressed as pixels. Set to auto to automatically allow the dashboard to set the width of the tree map. The default is 400.

   **Height**: Sets the height of the tree map within the portlet and is expressed as pixels. Set to auto to automatically expand the height of the tree map and portlet as large as the page allows. The default is 300.

   **Element Depth**: Sets the default number of levels the tree is traversed and the default depth option when viewing the tree map.

   **Size Area by**: Sets the default weight value which determines the area for each element’s rectangle in the tree map.

4 Select the Refresh portlet when updates occur option to enable automatic updates for element condition. Deselect the option to control updates manually.

5 Click Save.
This section describes how to use portlets that are designed to create reports using Service Level Agreement (SLA) data from Operations Center. For more information about SLAs, see the Operations Center Service Level Agreement Guide.

- Section 9.1, “Understanding the SLA Reporting Portlets,” on page 133
- Section 9.2, “Configuring the SLA Compliance Portlet,” on page 134
- Section 9.3, “Configuring the SLA Status Portlet,” on page 139

### 9.1 Understanding the SLA Reporting Portlets

The Service Level Manager (SLM) is required in Operations Center to store and use data related to SLAs. For more information about the SLM, see the Operations Center Service Level Agreement Guide.

Reports related to SLA compliance and availability provide data on the compliance/health, availability, and downtime for Service Level Agreements and objectives. You can use predefined portlets in the Dashboard to create the following types of reports that use data related to SLAs compliance and availability:

- **SLA Compliance**: a detailed view that shows health, downtime, availability, outages, and breaches related to SLAs for specified elements over a specified interval of time.
- **SLA Status**: shows the compliance/availability from a status or summary perspective with links to SLA Compliance reports.

SLA data from Operations Center can also be accessed via the Alarm portlet and the Charting portlet. For more information about the Alarms Portlet, see Section 8.1, “Configuring the Alarms Portlet,” on page 101. For more information about the Charting portlet, see Section 8.2, “Configuring the Charting Portlet,” on page 108.

### 9.1.1 Generating SLA Report Portlets

The SLA-related portlets allow you to set when the report data is generated (for example, when the portlet receives new data from the Operations Center server). The options are:

- **Live**: Whenever the user clicks on the portlet, the report data is generated in real-time.
- **Scheduled**: You set when the portlet generates report data. Data is cached for better performance.
  
  For more information about scheduling, see Section 7.8.5, “Scheduling Portlets,” on page 96.

- **Ad hoc**: *(SLA Compliance Portlet only)* Allows a user to run a report again, on-the-fly, with new selections for time categories, date range/date interval and exception-based reporting options. These selections do not affect saved portal report setup and are not retained after the user logs out of the portal. See Section 9.2.3, “Regenerating the Report with Ad-Hoc Options,” on page 138.
If you do not set a report to be either live or scheduled, the data in the report is current as of the time of the initial report display. For example, if the report is run at 4:16 p.m., all of the tabs show data as of 4:16 p.m.

9.1.2 SLA Report Portlet Options

These reports have the following helpful options for configuring SLA reporting:

- *(SLA Status Report Only)* Allow the user to select the element to use by configuring a Starter portlet, Navigation portlet, Search portlet, or Status portlet to dynamically control element selection for a SLA Status portlet implemented within the same portal page.

  For more information about setting up user navigation to drive the SLA Status portlet, see Section 9.3.3, “Setting Up User Navigation to Drive an SLA Status Portlet,” on page 143.

- Report scheduling to set when data for the report is generated.

  For more information about report scheduling, see Section 7.8.5, “Scheduling Portlets,” on page 96.

- *(SLA Compliance Report Only)* Allow the user to rerun the report with new selections for time categories, date range/date interval and exception-based reporting options.


- Time zone setting to customize data display for international users.

9.2 Configuring the SLA Compliance Portlet

The SLA Compliance portlet displays compliance/agreement health or availability/downtime data, outage counts, breaches counts, root cause, and a detailed listing of all outages and breaches for specified intervals of time.

Health/compliance, availability, or downtime for agreements and objectives (OLA) are shown in a calendar view. This report can include charts of the agreement health or downtime or availability, lists of outages, and lists of breaches. Data can be shown at various levels of detail (for example, year, month, week, day, hour, minute). The Show Key Metric feature can chart the objective value being measured as a percentage or inverted value.

The report portlet can reveal up to six reports, or tabs, of information for the user: Compliance/Availability, Root Cause, Breaches, Details, Charts, and Outages. These tabs can be hidden from display with report settings found in Preferences.

For samples of other tabs in this report, see the Operations Center Service Level Agreement Guide

Table 9-1 describes the icons and indicators that are used by the SLA Compliance to show levels of data availability, compliance, and relevance.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📈📊📊📊📊📊</td>
<td>Data Available</td>
<td>Indicates the amount of data available for the measured period of time. Icons indicate specific value targets or ranges of values, such as 0%, 0.1%–33%, 33.1%–65.9%, 66%–99.9%, 100%.</td>
</tr>
</tbody>
</table>
For more information about the data displayed in this report, particularly information about outage duration, see the *Operations Center Service Level Agreement Guide*

Note the following tips and information when setting up the SLA Compliance report:

- There are three main types of reports: compliance/health, availability, and downtime. Each one has slightly different options to select in Preferences. When creating any of these reports, select a calendar from Operations Center to filter the display based on time category selection.

- To create a report on health and compliance, select the objective definition option for the calculation rules, then select an agreement and objective. For this type of report, the calendar for the agreement is always used. By default, the time defined in the objective is used to calculate compliance.

- For downtime reports, time category filtering does not affect the summary metrics.

- To allow users to change the calendar and other various report parameters on-the-fly, enable Show Options. The calendar appears as one of the options when the user clicks Options. In Preferences, you must select both the Show Options option and the Show Calendar option for the user to see both the Options link in the portlet view and the calendar within those options.

- When specifying a time span for any type of report, make sure to specify one that is reasonable for reporting. Users typically want to look at a year’s worth of data in months or weeks, rather than hours or minutes, with the ability to drill down into hours or minutes.

- The SLA Compliance portlet returns a maximum number of outages and breaches based on a property set on the Operations Center server. For instructions on configuring this property, see Section 7.8.1, “Configuring Default Alarms Limits Returned from the Operations Center Server,” on page 93.

- Setup a schedule to run the report at specified intervals. Users view a cached version for improved performance. Cached versions are saved for the main tabbed reports. If drilling into data, views at that level are real-time and not cached.

For more information about scheduling, see Section 7.8.5, “Scheduling Portlets,” on page 96.

The following sections cover how to configure the SLA Compliance portlet settings, using the portlet at run-time and ad-hoc options:

- Section 9.2.1, “Setting Up the SLA Compliance Portlet,” on page 136
- Section 9.2.2, “Using the SLA Compliance Portlet,” on page 138
- Section 9.2.3, “Regenerating the Report with Ad-Hoc Options,” on page 138

<table>
<thead>
<tr>
<th>Icons</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌿</td>
<td>Compliance Grades</td>
<td>Indicates a level of compliance from A–F based on compliance percentage. Icons indicate the range where, by default, green is 80–100%, blue is 70–89%, yellow is 60–69%, orange is 50–59%, and red is any compliance less than 50%.</td>
</tr>
<tr>
<td>🌿</td>
<td>Data Relevance</td>
<td>Indicates the relevancy of data to the reported period of time. For instance, there can be data available, but it is not considered (relevant) if the associated Time Category is filtered out (for example, a blackout). Icons indicate specific value targets or ranges of values, such as 0%, 0.1%–33%, 33.1%–65.9%, 66%–99.9%, 100%.</td>
</tr>
</tbody>
</table>
### Setting Up the SLA Compliance Portlet

To configure the SLA Compliance Portlet:

1. Click the options icon and select **Preferences**.
2. Click the **Elements** tab to select the element for the report to generate data on.
   
   The default element selection is **Enterprise**. For more information on selecting the element, see Section 7.3.2, “Configuring Starting Elements for Portlets,” on page 84.
3. Click the SLA Compliance tab to specify report parameters and options.
4. Configure the report title by doing the following:
   - Specify the report title in the **Report Title** field.
   - Select the **Use default title** check box to use the default title for all displays.
   - Select the **Hide title** check box to not show a title in the report.
5. Under **Selected Element**, select whether the report is to be run for a specific agreement, or on availability, or downtime in the **Agreement** drop-down list.
6. If reporting on an agreement, select **All** or select a specific objective from the **Objective** drop-down list.
   
   If a specific objective is selected, do any of the following:
   - Select the **Calculate Health Using the Time Indicators as Objective Interval** check box to have the specified time indicators used as the interval over which the objective is evaluated to determine compliance.
   - Select the **Display Key Metric Values** check box to use any of the following sub-options:
     - Select **Show Key Metric as a Percentage** check box to display the key metric as a percentage value.
     - Select **Show Inverse of Key Metric** check box to display the inverse value of the key metric.
7. If reporting on availability or downtime, do the following:
   - Click the **Calendar** drop-down list, then select a calendar.
   - Specify Availability/Downtime calculation rules by selecting one of the following radio button options:
     - **Use Element Outages** to calculate outages in the report.
     - **Specify Outage Definition** which requires specifying a minimum outage duration and threshold condition.
       
       Specify the minimum duration (in seconds) for outages to include in this report in the **Minimum Outage Duration** field.
       
       Select the lowest severity level to include in this report from the **Outage Threshold Condition** list.
     - **Apply Agreement Definition** which requires selecting an agreement and an objective.
       
       Select an agreement from the **Agreements** list. If the selected element has no associated agreements, then no agreement names display. Remote agreements are listed with the prefix “Remote.”
       
       Select an objective from the **Objective** list, or select **All** to display all objectives. If the selected agreement has no associated objectives, no objective names display.
8. Under **Time Control**, select one of the following time selectors:
**Use Interval:** Use the various options to select an interval range for the report to run against. Time intervals are always determined relative to the time that the report is run.

**Use Date Range:** Use the various options to select a specific start and end time for the report to run against. Click the (Calendar) icon to select a date/time.

**Use Real-Time:** (Agreements only) Reports on real-time data (only available if reporting on health and compliance and an agreement is selected in the Agreement/Availability drop-down list).

9 Under **Time Categories**, indicate the time categories for the report to run against by selecting the check boxes.

10 Click the **Home Page** drop-down list, then select the tab for the report to use as the default report page.

11 Select any of the **Display Options** check boxes options to enable various report features:

- **Show Header Information:** Displays the summary header information in the box at the top of each tab. The header information includes calendar and time category selections, overall health or downtime or availability metrics, and the overall data available and data relevance indicators.

- **Show Root Cause:** Includes the Root Cause tab in the report. Only applies to health and compliance for Agreements.

- **Show Breaches:** Includes the Breaches tab in the report. Only applies to health and compliance for Agreements. Also, select from the following options:
  - **Show Objective Breaches:** Displays objective breaches in the Breaches tab.
  - **Show Major Breaches:** Displays major condition breaches, which are breach warning alarms, in the Breaches tab.
  - **Show Cleared Breaches:** Displays cleared breaches in the Breaches tab. Excluding cleared breach alarms eliminates all warning and violation breaches associated with a cleared breach alarm. Only applies to health and compliance reports.
  - **Show Breach List:** Displays a detailed list of all breaches in the Breaches tab. By default, shows breach violations (CRITICAL) only. Includes cleared and warning (MAJOR) breaches based on Show Cleared Breaches and Show Major Breaches selections. Only applies to health and compliance reports.

- **Show Details:** Includes the Details tab in the report. Only applies to health and compliance for Agreements.

- **Show Charts:** Includes the Charts tab in the report.

- **Show Outages:** Displays the Outages tab. Also, select from the following options:
  - **Show outages not generated by element condition changes:** Includes manually entered or imported outages, as well as system generated outages (for example, based on real-time state data) when reporting on downtime, availability, and agreement or objective health.
  - **Show Outages List:** Displays a detailed list of outages in the Outages tab. Outages include only those outages that start in the report interval.
Show Options: Displays options for the user viewing the report to change the time intervals and time categories in the report.

- Show Calendar: Displays a calendar under Options that allows users to select to run the report using a different calendar than the one selected in Edit mode. Show Options must be selected for this option to have any effect.

Show PDF Link: Displays a link to save the report in PDF format.

12 Click the Report Time Zone drop-down list, then select the time zone for the report to use in presenting data.

13 Click Save.

If you exit Preferences without clicking Save first, your changes are lost.

14 If this report is to be run automatically on scheduled intervals, click Advanced, then click Scheduling to configure the report to run at regular intervals.

For more information about Scheduling, see Section 7.8.5, “Scheduling Portlets,” on page 96.

9.2.2 Using the SLA Compliance Portlet

While viewing the SLA Compliance portlet, do any of the following:

- Click any of the available tabs (Compliance, Details, Chart, Outages, Breaches, or Root Cause) to change the display to that view.
- Click Next/Previous to navigate to the next or the previous time period for the given report.
- Click 🏛️ to return to the default home view of the SLA Compliance report as defined in Preferences.
- Click 📄 to print the report.
- Click 📄 to save the report as a PDF file.
- Click Objectives to view objectives related to the SLA. A tool tip displays with information on the objectives. Click the icons to view compliance, root cause, breaches, details or charts for the objective.
- Click Options to run an ad hoc query.

For more information, see Section 9.2.3, “Regenerating the Report with Ad-Hoc Options,” on page 138.

9.2.3 Regenerating the Report with Ad-Hoc Options

While viewing the SLA Compliance portlet, there are various on-the-fly options that can be used to modify and rerun the report. These options are available if Show Options is enabled in Preferences.

The Options selections do not change the original report options as set in Preferences or Scheduling. They are used only for the immediate view. When the view is changed or the session expires, these selections are not retained.
To change the time categories, calendar or reporting ranges for the portlet:

1. Click the **Options** link.
2. Use the **Report On** check boxes to select or clear any time categories.
3. Click the **Calendar** drop-down list, then select a calendar to use for filtering time categories.
4. Select one of the following radio buttons to adjust the time reported on:
   - **Use Interval** to select a date interval, such as the last 30 days.
   - **Use Date Range** to select a date range.
     - Select the time to report on: minutes, hours, days, weeks, months, or years.
   - **Use Real-Time** to report on real-time data (only available if reporting on health and compliance for an agreement).
5. Click **Run** to run the report with the new selections.

## 9.3 Configuring the SLA Status Portlet

The **SLA Status** portlet displays a status summary on agreement health, availability, or downtime for the selected element’s children during the specified time frames. This report uses the same data as an **SLA Compliance** portlet and includes access to SLA Compliance reports by clicking any of the metrics.

The **SLA Status** portlet can also display child availability and child downtime. Detailed information in this report shows outages, downtime, availability, committed time, downtime contributed (as a percent), and outages contributed (as a percent) for leaf children.

Note the following tips and information when setting up the **SLA Status** report:

- When configuring the report, decide whether the user of the report can see only that element (selected element option) or that element and its children (viewable elements option). The elements that the user can view are governed by privileges set in Operations Center.
- When reporting on child availability and downtime, you must select a calendar to use to calculate values. You must also select to define outages as either element outages, outages based on a minimum duration and threshold that you set, or apply an SLA agreement and objective.
- In contrast to the **SLA Compliance** portlet, instead of selecting a use interval or data range, you select the time periods for which data displays and whether an arrow or status box displays.
- Setup a schedule to run the report at specified intervals. Users view a cached version for improved performance.

For more information about scheduling, see Section 7.8.5, “Scheduling Portlets,” on page 96.

The following sections cover how to configure the **SLA Status** settings, using the portlet and user navigation options:

- Section 9.3.1, “Setting Up the SLA Status Portlet,” on page 140
- Section 9.3.2, “Using the SLA Status Portlet,” on page 142
- Section 9.3.3, “Setting Up User Navigation to Drive an SLA Status Portlet,” on page 143


9.3.1 Setting Up the SLA Status Portlet

To configure the SLA Status Portlet:

1. Click the options icon and select Preferences.

2. Click the Elements tab to select the element(s) for the report to generate data on.
   
   The default element selection is Enterprise. For more information on selecting the element, see Section 7.3.2, “Configuring Starting Elements for Portlets,” on page 84.

3. Click the SLA Status tab to specify report parameters and options.

4. Select whether the report is to be run for selected elements only, selected specific elements including children, or the children of the selected elements from the Show Elements drop-down list.

5. For each selected element, do the following:
   
   5a. Select whether the report is to be run for a specific agreement, or on availability or downtime in the Agreement drop-down list.

   5b. If reporting on an agreement, do the following:
      
      5b1. Select All or select a specific objective from the Objective drop-down list.

      5b2. Select the Display objective’s Threshold column check box to a threshold reference value in the report.

      Define the desired threshold value that must be reached for the selected objective, in the Objective Threshold text box. This value is displayed in the Threshold column as a reference only.

      5b3. If a specific objective is selected, define reporting and calculation rules with the following options:

         Select the Calculate health using time indicators as objective interval check box to have the specified time indicators used as the interval over which the objective is evaluated to determine compliance.

         Select the Display key metric values check box to use any of the following sub-options:

         Select Show key metric as a percentage check box to display the key metric as a percentage value.

         Select Show inverse of key metric check box to display the inverse value of the key metric.

   5c. If reporting on availability or downtime (including child availability/downtime), do the following:

   5c1. Click the Calendar drop-down list, then select a calendar.

   5c2. Specify availability/downtime calculation rules by selecting one of the following radio button options:

         Use Element Outages to calculate outages in the report.

         Specify Outage Definition which requires specifying a minimum outage duration and threshold condition.

         Specify the minimum duration (in seconds) for outages to include in this report in the Minimum Outage Duration field.

         Specify the lowest severity level to include in this report in the Outage Threshold Condition list.

         Apply Agreement Definition which requires selecting an agreement and an objective. This option is unavailable for Child Availability and Child Downtime.
Select an agreement from the Agreements list. If the selected element has no associated agreements, then no agreement names display. Remote agreements are listed with the prefix “Remote.”

Select an objective from the Objective list, or select All to display all objectives. If the selected agreement has no associated objectives, no objective names display.

5c3 (Child Availability and Child Downtime only) Specify the levels of children used in the availability and downtime calculation:

- **Children in hierarchical structure**: Select how many levels of children that naturally exist in the hierarchy, regardless of whether they contribute to the state of the parent element, that contribute to the calculation.

- **Children contributing to state**: Select how many levels of children that contribute to state but are not natural children of the element (have been matched or linked under the element), that contribute to the calculation.

6 Under **Time Categories**, indicate the time categories for the report to run against by selecting the associated check boxes.

7 Configure the report title by doing the following:
   - Specify the report title in the Title field.
   - Select the Use Default Title check box to use the default title for all displays.
   - Select the Hide title check box to not show a title in the report.

8 Click the Report Time Zone drop-down list, then select the time zone for the report to use in presenting data.

9 Configure the indicator values to show for each element using the options under **Status Indicators**:
   - Include Real Time, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Quarter, Last Quarter, This Year, and Last Year values by leaving the Hide indicator check boxes unselected.
   - Select None, Arrow or Status from the Indicator drop-down lists to specify the type of indicator show with each value.
   - Select the Do not show actual values within acceptable threshold limits. Display as "<100%" check box to display availability that is slightly less than 100% as <100% (with a down arrow).

10 Select the Show PDF/Excel export links option to include options to export the report information.

11 Click the Home Page drop-down list, then select the tab for the report to use as the default report page when displaying a SLA Compliance report.

12 Select the Open SLA Compliance information in new window check box to open the related SLA Compliance report in a pop-up window. If this option is unselected, SLA Compliance reports open in the same page.

13 Select the following check boxes to enable various report features shown in the SLA Compliance views:
   - **Show Header Information**: Displays the summary header information in the box at the top of each tab.
     The header information includes calendar and time category selections, overall health or downtime or availability metrics, and the overall data available and data relevance indicators.
   - **Show Root Cause**: Includes the Root Cause tab in the report. Only applies to health and compliance for Agreements.
Show Breaches: Includes the Breaches tab in the report. Only applies to health and compliance for Agreements. Also, select from the following options:

- **Show Objective Breaches:** Displays objective breaches in the Breaches tab.
- **Show Major Breaches:** Displays major condition breaches, which are breach warning alarms, in the Breaches tab.
- **Show Cleared Breaches:** Displays cleared breaches in the Breaches tab. Excluding cleared breach alarms eliminates all warning and violation breaches associated with a cleared breach alarm. Only applies to health and compliance reports.
- **Show Breach List:** Displays a detailed list of all breaches in the Breaches tab. By default, shows breach violations (CRITICAL) only. Includes cleared and warning (MAJOR) breaches based on Show Cleared Breaches and Show Major Breaches selections. Only applies to health and compliance reports.

Show Details: Includes the Details tab in the report. Only applies to health and compliance for Agreements.

Show Charts: Includes the Charts tab in the report.

Show Outages: Displays the Outages tab. Also, select from the following options:

- **Show Outages Not Generated by Element Condition Changes:** Includes manually entered or imported outages, as well as system generated outages (for example, based on real-time state data) when reporting on downtime, availability, and agreement or objective health.
- **Show Outages List:** Displays a detailed list of outages in the Outages tab. Outages include only those outages that start in the report interval.

Show Options: Displays options for the user viewing the report to change the time intervals and time categories in the report.

- **Show Calendar:** Displays a calendar under Options that allows users to select to run the report using a different calendar than the one selected in Edit mode. Show Options must be selected for this option to have any effect.

14 Click Save.

If you exit Preferences without clicking Save first, your changes are lost.

15 If this report is to be run automatically on scheduled intervals, click Advanced, then click Scheduling to configure the report to run at regular intervals.

For more information about Scheduling, see Section 7.8.5, “Scheduling Portlets,” on page 96.

### 9.3.2 Using the SLA Status Portlet

While viewing the SLA Status portlet, do any of the following:

- Click Refresh to update the data in the view. Only real-time data is refreshed in the view. Scheduled reports update the next time the schedule job runs.
- To navigate between SLA Status views, do the following:
  - Click an element name to drill-in to an SLA Status report for child elements.
  - Click the Up link to return to the parent SLA Status report.
  - Click 📦 to return to the default home view of the SLA Status report as defined in Preferences.
  - Click 📦 to save the report as a PDF file.
• Click any metrics value to view the SLA Compliance report.

For more information on the SLA Compliance report, see Section 9.2, “Configuring the SLA Compliance Portlet,” on page 134.

9.3.3 Setting Up User Navigation to Drive an SLA Status Portlet

If you use the SLA Status portlet on a page, you can also add and configure a Starter portlet, Navigation portlet, Search portlet, or Status portlet to dynamically control element selection for a SLA Status portlet implemented within the same portal page.

For SLA portlets, you’ll configure a default element(s) but in addition, you can set up a Starter portlet, Navigation portlet, Search portlet, or Status portlet on the same page can also allow users the ability dynamically change the element selection that drives data in the SLA portlet.

These portlets can be used to create a single page to report on multiple services for a single user, or to create a single page for multiple role-based users, or to produce a single page that supports multiple end users who have different data access privileges. It eliminates the need to create multiple customers without having to create separate portal pages for everyone.

For more information, see Section 7.4, “Using Navigation Mode to Drive Multiple Portlets,” on page 84 or the section on each portlet type:

• Section 8.13, “Configuring the Starter Portlet,” on page 127
• Section 8.6, “Configuring the Navigation Portlet,” on page 119
• Section 8.11, “Search Portlet,” on page 124
• Section 8.14, “Configuring the Status Portlet,” on page 128
## Chart Builder Portlet

The Chart Builder portlet allows you to build and deploy charts containing data from Operations Center that meet the reporting needs of your organization.

The Chart Builder portlet is also available as a view from other Operations Center portlets including Alarms, Element Properties, Properties Table, Show Impacted, Tree Map, Root Cause, and Performance. Click Actions and select Go to > Chart Builder from any of these portlets.


Chart Builder does not support SVG rendering for any browser version; users must select Flash, PNG, or JPG to view data through Chart Builder.

Charts use templates that leverage data from Operations Center. Templates are PCXML files that use the Operations Center JSP tag libraries to incorporate data from Operations Center. The Dashboard has predefined templates that are ready to use, or you can create your own custom templates.

- Section 10.1, “Predefined Templates,” on page 145
- Section 10.2, “Custom Templates,” on page 148

### 10.1 Predefined Templates

Predefined templates show the following types of data:

- Alarm counts in pie or bar charts
- SLA status in a dashboard
- Status and location of an element on a map chart
- Numeric element properties in a speedometer gauge

These templates can be added to a Web page by using the Chart Builder portlet.

All Chart Builder templates automatically contain a link added to the bottom right corner of the portlet that allows the user to view the source data used to generate the chart. For more information about viewing source data, see Section 7.7, “Viewing Source Data for Charts,” on page 92.

The following sections show examples of the predefined templates included with the Dashboard and provide steps for deploying charts and configuring the SLA Status Dashboard:

- Section 10.1.1, “Chart Display Examples,” on page 146
- Section 10.1.2, “ Deploying Charts,” on page 146
- Section 10.1.3, “Setting Up the SLA Status Dashboard,” on page 147
10.1.1 Chart Display Examples

The following sections show examples of the different types of displays:

- "Alarms Charts" on page 146
- "Map Chart" on page 146
- "Element Properties Gauge" on page 146
- "SLA Status Dashboard" on page 146

Alarms Charts

By default, there are four types of charts that show alarm data.

- Element Alarms Pie Chart
- Child Element Alarms Bar Chart
- Element Alarms Bar Chart
- Element Alarms Radar and Pie Chart

The user can click the link located in the bottom right corner of the portlet to view data used to generate the chart.

Map Chart

The Map Chart template shows a map from the Locations hierarchy tree in Operations Center with drill-down to show alarm charts. The user can click the link located in the bottom right corner of the portlet to view data used to generate the chart.

Element Properties Gauge

The Element Properties Gauge template shows element property information in a gauge speedometer. The user can click the link located in the bottom right corner of the portlet to view data used to generate the chart.

SLA Status Dashboard

The SLA Status Dashboard template shows service level agreement status information including breach and outage counts overlayed with health, downtime, availability and cost impact levels. The user can click the link located in the bottom right corner of the portlet to view data used to generate the chart.

10.1.2 Deploying Charts

Charts are deployed and configured by using the Chart Builder portlet in the Dashboard.

If some of the chart elements overlap after you configure the chart, increase the chart width.

To configure the Chart Builder Portlet:

1. Add the Chart Builder portlet to a web page.

For more information on adding a portlet to a page, see Section 6.2.1, "Adding a Portlet," on page 75.
2 Click the Configuration icon and select Preferences.

3 Select a .jsp template from the drop-down list to specify the chart type.
   The PCXML files are samples, or templates, that administrators use to create a new chart. They
   are not fully coded to show custom static data or dynamic information from Operations Center.
   Click Manage to upload a new chart template from your file system.

4 Specify the chart width in the Chart Width field.

5 Specify the chart height in the Chart Height field.

6 Click the Chart Output drop-down list, then select the output type.

7 Specify other chart options as required, such as the chart title.
   For specific information about running the SLA Status Dashboard template example, see
   Section 10.1.3, “Setting Up the SLA Status Dashboard,” on page 147.

8 Click Save to save the chart settings.

9 Click to open the Elements tab and select an element to drive the portlet.

10 Click Save to save the element selection.

### 10.1.3 Setting Up the SLA Status Dashboard

The SLA Status Dashboard uses data from the Service Level Manager (SLM) in Operations Center
and has different configuration options. Using this chart requires a license for SLM. For more
information about SLM and SLA data, see the *Operations Center Service Level Agreement Guide*.

Cleared breaches can be included in the Dashboard, even if they are not included in the summary
metrics and statistics. This can occur when a breach is cleared on a day that is not included in the
reported interval.

To set up custom chart options for the SLA Status Dashboard template:

1 Follow the basic directions to setup the Chart Builder portlet and use the Elements tab to select
   an element to drive the portlet. See Section 10.1.2, “Deploying Charts,” on page 146.

2 Click Select SLA Root Element to select the element with the associated SLA.

3 Select the Time Control value by using one of the following time selectors:
   - **Use Interval**: Use the options to select an interval range for running the report. Time intervals
     are always determined relative to the time that the report is run.
   - **Use Date Range**: Use the options to select a specific start and end time to include in the report.
     Click the (Calendar) icon to select the date/time.
   - **Use Real-Time**: Reports on real-time data.

4 To specify an agreement name in the SLA field, click SLA to browse, then select an applicable
   agreement:
   - **None**: Shows information for an element.
   - **Objective**: Shows information for an objective. First, select an option, then specify the
     objective in the Objective option.

   If no agreement is selected, the health displays as 100 with 0 breaches existing (if breaches are
   selected to display).
5 To specify an objective in the **Objective** field, click **Objective** to browse and select an applicable objective:
   - To show information for an element, specify **None**.
   - To show information for an agreement, specify **None**, then specify the agreement in the **SLA** option.

6 Select the appropriate **Time Categories** check boxes.

7 Specify a title in the **Chart Title** field.

8 Select the **Show Overall Cost Calculation** check box to include a cost total amount in the portlet display.

9 Set the options to configure the cost calculation:
   9a Click **Calculate Cost Metric Using Each** drop-down list, then select the metric that drives the cost calculation.
   9b Specify a **Cost Impact Per Metric Instance Number** to facilitate cost calculations.
   9c Specify an **OverAll Cost Multiplier Number** to multiply the cost impact per metric instance.

10 Select one or more of the following check boxes to customize the display:
   - **Show Costs in Chart**: Cost values.
   - **Show Health in Chart**: Health indicators. If no agreement is selected, health displays as 100%.
   - **Show Availability in Chart**: Availability data.
   - **Show Downtime in Chart**: Downtime data. Click the **Show Downtime In** drop-down list, then select the interval display for downtime data.
   - **Show Outages in Chart**: Outages.
   - **Show Outages Not Generated by Element Condition Changes**: Manually created outages.
   - **Show Breaches in Chart**: Breaches. If no agreement is selection, no breaches display.
   - **Show Cleared Breaches**: Cleared breaches.
   - **Show Warning Breaches**: Warning breaches.
   - **Show the Last Updated Date/Time**: Date and time of the last data update.

11 Click **Save** to save the chart settings.

### 10.2 Custom Templates

Custom templates are made in the Corda Builder tool, then deployed by using Chart Builder portlet. You create a template by making a PCXML file, then incorporating data from Operations Center by using JSP tags. When a template is created, it can be uploaded to the Chart Builder portlet and configured to appear on a Web page.

- **Section 10.2.1, “Creating the Template File,” on page 149**
- **Section 10.2.2, “Integrating Operations Center Data,” on page 151**
- **Section 10.2.3, “Creating Drill-Down URLs for a Chart,” on page 153**
- **Section 10.2.4, “An Example: Modifying a PCXML File with JSP Tags,” on page 153**
- **Section 10.2.5, “Uploading New Templates,” on page 155**
- **Section 10.2.6, “Deleting Templates,” on page 156**
10.2.1 Creating the Template File

APCXML file is created using Corda Builder*, a wizard-based tool, which is later with JSP tags to leverage data from Operations Center.

Chart Builder templates use Velocity*, a templating mechanism. To learn more about Velocity, go to the Apache Velocity Project (http://velocity.apache.org/).

The following sections cover how to create a new chart for the Chart Builder portlet.

- “Creating a Chart” on page 149
- “Modifying Chart Settings and Properties” on page 150
- “Modifying Map Settings and Properties” on page 150

Creating a Chart

To create a chart by using the chart wizard:

1 In the Operations Center installation directory, browse to and launch the /OperationsCenter_install_path/image/bin/CordaBuilder executable. The Corda Builder tool launches.

2 Do one of the following:
   - Click Graph Wizard, then continue with Step 3.
   - To create a map, click Map, then skip to Step 4.
   - Click Close to cancel the Fast Start options and open an existing template.
   - Click Close to work from scratch without using the wizard.
   - If creating a chart or graph, the easiest way is to work from a template, then customize a chart or graph as necessary.

3 Select Create New Project from a Template.

4 In the Template Selection tab, select template names in the Template Selection left pane to preview the various styles.

5 When you have found a chart style you want to use, click Next to continue.

6 In the Graph Type Selection tab, select the graph type, subtype, and style.

7 Click Next to continue.

8 In the Data Selection tab, do one of the following:
   - Use the Graph Data spreadsheet to specify valid data if you want to create a chart with static values.
   - Specify placeholder information to replace with JSP tags later to pull data from Operations Center.

9 Click Next to continue.

10 In the General tab, specify border, background, and color theme options.

11 In the Title tab, specify the chart title, and specify border, shadow, and font settings for the title.

12 Select Continue Customizing Project, then click Finish.

The chart template is displayed in the Corda Builder tool.

13 Continue to “Modifying Chart Settings and Properties” on page 150, or “Modifying Map Settings and Properties” on page 150 if creating a map.
Modifying Chart Settings and Properties

To modify chart settings and properties:

1. Double-click any of the objects in the Object drop-down list, or double-click any element directly on the map.
2. Click the PCXML tab to view the chart code directly.
   To integrate Operations Center data, the file needs to be modified to include JSP tags to pull in dynamic data. See Section 10.2.2, "Integrating Operations Center Data," on page 151.
3. To publish the chart with static data, verify that all data points are correct.
4. To publish the chart, click File > Publish.
5. Select image types to be created by selecting the appropriate check boxes.
6. Browse and save the file to a directory and with a file name that can be remembered later.
7. Continue to Section 10.2.2, "Integrating Operations Center Data," on page 151.

Modifying Map Settings and Properties

To modify map settings and properties:

1. Double-click any of the objects (such as, Graph, Legend_Graph, Title) in the Object drop-down list, or double-click any element directly on the actual chart.
   If creating a map the easiest way is to build it based on a template using a map from the map library, then customize further as necessary.
2. Click Template.
3. Click Predefined.
4. Browse the maps hierarchy tree, then select the PCXML file for the continent, country, region, US, or world.
5. Click OK to select the map.
   The chart is displayed in the Corda Builder tool.
6. Continue to Section 10.2.2, "Integrating Operations Center Data," on page 151.
10.2.2 Integrating Operations Center Data

After a chart has been created through the Corda Builder, the PCXML file must be customized to work with Operations Center data.

This is where you leverage the various tag libraries (see Appendix C, “JSP Tag Library Reference,” on page 193) and define user setup options that format or drive the chart. Depending on chart requirements, this can include:

- Operations Center element selection
- Date/time or date range selection
- Time category selection
- Performance Series (profile/expression) selectors
- SLA (agreement/objective) selectors
- A custom check box series option
- A custom field option (that is, a chart title)
- A custom drop-down list option

To customize a chart with Operations Center data:

1. To launch the Corda Builder if it is not already open, go to the Operations Center installation directory, then browse to and launch the `/OperationsCenter_install_path/image/bin/CordaBuilder` executable.
2. Open a template PCXML file. If one is not already open, then click the PCXML tab.
3. Select and copy all the code, then open a text/HTML editor and paste in the PCXML code.
4. Add the required UI Model code in the `.jsp` file header.

These are the options that form the editor portion of the chart and drive the generation of the chart at runtime. For an example, see Section 10.2.4, “An Example: Modifying a PCXML File with JSP Tags,” on page 153.

Following are the available UI Model selectors:

<table>
<thead>
<tr>
<th>Selector Type</th>
<th>Attribute(s)</th>
<th>Fields¹</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>calendar</td>
<td>label</td>
<td></td>
<td>Provides a drop-down list to select a calendar. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;selector type=&quot;calendar&quot; label=&quot;Select calendar:&quot; /&gt;</code></td>
</tr>
<tr>
<td>check box</td>
<td>label, name, checked</td>
<td></td>
<td>Provides a check box selection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;var type=&quot;check box&quot; label=&quot;Use Breaches for Cost Counts&quot; name=&quot;useBreaches&quot; checked=&quot;checked&quot; /&gt;</code></td>
</tr>
<tr>
<td>date</td>
<td>label</td>
<td></td>
<td>Provides options to run report for an interval, date range, or real-time data. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;selector type=&quot;date&quot; label=&quot;Run report for:&quot; /&gt;</code></td>
</tr>
</tbody>
</table>
Add any necessary taglib references.

For more information about using the tag libraries, see Appendix C, “JSP Tag Library Reference,” on page 193.

For an example, see Section 10.2.4, “An Example: Modifying a PCXML File with JSP Tags,” on page 153.
6 Update any places where information is dynamic.

Instead of the placeholder static values, insert the code to pull the data from Operations Center where needed. For an example, see Section 10.2.4, "An Example: Modifying a PCXML File with JSP Tags," on page 153.

7 Add drill-down URL links, if desired. See Section 10.2.3, "Creating Drill-Down URLs for a Chart," on page 153.

8 Close all open tags.

9 Save the file as a .jsp file to a working directory.

10 Continue to Section 10.2.5, "Uploading New Templates," on page 155.

10.2.3 Creating Drill-Down URLs for a Chart

When you create a custom chart through the Chart Builder, it is possible to set up links (URLs) that allow for drill-down functionality.

The following parameters are required for the drill-down URLs in chart templates:

- **template parameter (+ id):** Specifies the location of the template to include.
- **goto parameter (+ id):** Sends the request to the helder include file.

An example of a link is:

```jsp
<%= response.encodeUrl( request.getContextPath() + "Controller?backLink"+id+"="+java.net.URLEncoder.encode(thisLink)+"&goto"+id+"="+chartBuilderDrillDown.jsp&template"+id+"="/generated/templates/radarAndPieAlarms.jsp&dname"+id+"="+java.net.URLEncoder.encode(dname) ) %>
```

The Dashboard ships with a Chart Builder example (see the Map Drill Down Example template) that shows a map with this drill-down functionality. Although the example is not intended for use out-of-the-box without further customization, it shows how Chart Builder can be used to build a custom map with drill-down support. The link can be configured to drill down to one element.

10.2.4 An Example: Modifying a PCXML File with JSP Tags

The example uses an example code snippet from the ElementBarAlarms.jsp file after it was edited to expose Operations Center information. Compare this to the ElementBarAlarms.PCXML file to view the raw file before it was updated. This is an example of how you might modify a PCSML file, actual edits depend on the chart you are building.

To modify a PCXML file with JSP Tags:

1 Add the UI Model code to the header for each chart setup option in the Dashboard:
Get access to element info by using DName. Insert the DName code as follows below the xml version code but above the chart tag as shown in the first line below:

```
<element:exists name="$graph1.element.dname" id="element">
</Chart Version='4.40.00' BorderType='None' BorderColor='#99ccff' BGGradientColor='"#4d718e">
```

Use value entered in edit options to set chart title.

```
<Textbox Name='Title' Top='6' Left='4' Width='121' Height='23'>
  <Properties ShadowStyle='Fade' HJustification='Left' Font='Name:Lucida Sans; Size:14.0; Style:Bold; Color:#003333;' />
  <Text>$graph1.textbox.title.value</Text>
</Textbox>
```

Leverage Formula tag to get condition colors as shown in the bottom half of this section.

```
<formula:colors id="colors">
  <ValueScale Position='Left' MinorGrid='Visible:False;' MinorFont='"Size:10.0;'/>
  <CategoryScale MinorFont='"Size:10.0;'/>
</formula:colors>
```
5 Use Element tag to get severity counts and plug into data values as shown in the bottom half of this section.

```xml
<GraphData Name='graph' Method='Replace'>
  <Categories>
    <Category Name='Critical' />
    <Category Name='Major' />
    <Category Name='Minor' />
    <Category Name='Informational' />
    <Category Name='OK' />
    <Category Name='Unknown' />
  </Categories>
  <Series Name='Count'>
    <Data Value='<%=element.getAlarmCount("(severity=critical)")%>' />
    <Data Value='<%=element.getAlarmCount("(severity=major)")%>' />
    <Data Value='<%=element.getAlarmCount("(severity=minor)")%>' />
    <Data Value='<%=element.getAlarmCount("(severity=informational)")%>' />
    <Data Value='<%=element.getAlarmCount("(severity=ok)")%>' />
    <Data Value='<%=element.getAlarmCount("(severity=unknown)")%>' />
  </Series>
</GraphData>
```

6 Print time data was last updated.

```jsp
<% 
  if ($graph1.checkBox.datetime.value) {
    java.text.SimpleDateFormat lu = java.text.SimpleDateFormat.getDateTimeInstance( 
      java.text.Format.MEDIUM, java.text.Format.MEDIUM );
  %>
  <Textbox Name='textbox3' Top='314' Left='1' Width='537' Height='19'>
    <Properties AutoWidth='False' AutoHeight='False' AutoSizeText='True' 
      BorderType='None' TransparentFill='True' Font='Size:11.0; Style:Italic;' />
    <Text>Last updated <%= lu.format( new java.util.Date() ) %></Text>
  </Textbox>
<% }
%
```

7 Close the chart and element tag.

```jsp
</Chart>
</element:exists>
```

### 10.2.5 Uploading New Templates

After creating a new template, use the Chart Builder portlet in the Dashboard to upload it to your Web page. After uploading it, you must configure it.

To upload a chart template:

1 From a Chart Builder portlet, click the options icon and select Preferences. The Chart Builder tab opens.
2 Click Manage.
3 Click Browse to browse and select a chart template file.
4 Click Upload to add the template.
5 The template is now available to use with the Chart Builder portlet.
10.2.6 Deleting Templates

You can remove templates that you uploaded by using the Chart Builder portlet in the Dashboard.

To delete a chart template:

1. From a Chart Builder portlet, click the options icon and select Preferences. The Chart Builder tab opens.
2. Click Manage.
3. Select the check box for the chart template.
4. Click Delete.
11 Reporting Center Portlets

The Reporting Center portlets consist of the Configuration portlet and the Reporting portlet. These portlets are used to view the Analysis Center reports in the Operations Center Dashboard. The reports are created in the Reporting Center using the Reporting Center Console. For more information on Reporting Center, see the Reporting Center Reporting Guide.

The following sections contain descriptions and details about the Reporting Center portlets:
- Section 11.1, “Understanding the Configuration Portlet,” on page 157
- Section 11.2, “Understanding the Reporting Portlet,” on page 158
- Section 11.3, “Selecting the Dashboard 508 theme,” on page 164
- Section 11.4, “Differences in the reports between and Reporting Center Console and the Dashboard,” on page 164
- Section 11.5, “Supported Reporting Center report properties,” on page 165

11.1 Understanding the Configuration Portlet

The Configuration portlet connects the Operations Center Dashboard to the Reporting Center Web Service. The portlet allows you to specify the details of the Reporting Center Web Service from which the reports are retrieved.

Figure 11-1  Configuration portlet

The Configuration portlet can be added only once in a Dashboard page. Once the portlet is configured, the same configuration setting is applicable to all other pages in the Dashboard.

IMPORTANT: Only administrators and power users can add and view the Configuration portlet. For all other users, this portlet is not visible.

The following sections describe how to add and configure a Configuration portlet:
- Section 11.1.1, “Adding a Configuration Portlet,” on page 158
- Section 11.1.2, “Configuring the Configuration Portlet,” on page 158
11.1.1 Adding a Configuration Portlet

To add a Configuration portlet:

1. In the Operations Center Dashboard, click ✅ Add.
2. Click Applications > Reporting Center.
3. Do one of the following:
   - Click the portlet and drag to a desired position on the page.
   - Click Add next to the portlet.
4. Refresh the page after adding the Configuration portlet.

11.1.2 Configuring the Configuration Portlet

To configure the Configuration portlet:

1. Specify the following:
   - **URL**: The address of the Reporting Center Web Service that you want to connect. The address should be in the http://servername/nrcwebservice/ACS.asmx format. For example: http://amdom.lab/nrcwebservice/acs.asmx.
   - **Name**: The user name in the Domain\Username format. For example: amdom\user1.
   - **Password**: The password to connect to the Reporting Center Web Service.

2. Click Save.

11.2 Understanding the Reporting Portlet

The Reporting portlet displays the Analysis Center report that is created in the Reporting Center. The report is displayed in the form of chart.

To view the latest data in the report, refresh the Reporting portlet periodically.

NOTE: If a report is modified in the Reporting Center Console, you must refresh the Operations Center Dashboard to view the updated report.
The Reporting portlet allows only one report to be configured at a time. You can add multiple Reporting portlets in a page or different pages to display multiple reports.

**IMPORTANT:** Only administrators can add and configure the Reporting portlets. Users can view and filter the reports in the Reporting portlets.

The following sections describe how to add, configure, and use the Reporting portlet:

- Section 11.2.1, “Adding a Reporting Portlet,” on page 159
- Section 11.2.2, “Configuring the Reporting Portlet,” on page 159
- Section 11.2.3, "Using the Reporting Portlet," on page 161

### 11.2.1 Adding a Reporting Portlet

To add a Reporting portlet:

1. In the Operations Center dashboard, click **Add**.
2. Click **Applications > Reporting Center**.
3. Do one of the following:
   - Click the portlet and drag to a desired position on the page.
   - Click **Add** next to the portlet.

### 11.2.2 Configuring the Reporting Portlet

After adding a Reporting Portlet, the portlet should be configured to display a report. To configure a report in the Reporting portlet:

1. Click **Options > Configuration**.
2. In the Setup tab, select a report.
3 Select the required Interactivity options:

- **Allow Server Selection**: Displays a list of selected servers from the Group Context of the Reporting Center.
- **Allow Metric Selection**: Displays a list of selected metric data from the Metric Context of the Reporting Center.
- **Allow Time Selection**: The time duration for which the report will be displayed.

**NOTE**: By default, the Interactivity options are enabled based on the report that you have selected. But you can deselect the Interactivity options according to your requirements.

4 Specify the **Number of X Axis Labels [0 for All]** to be displayed in the report. By default, the number is 6.

**NOTE**: When you increase the number of labels, the exact number of labels might not appear on the X-axis of the graph because the labels will be closely spaced.

5 Click **Save**, and close the configuration pop up window.
11.2.3 Using the Reporting Portlet

The Reporting portlet consists of the Report Context, the Date Range, and the Chart panel.

Report Context

The Report Context contains the Server Context and the Metric Context tabs, which are displayed based on the Interactivity options selected while configuring a report in the Reporting portlet. That is, the Server Context tab is based on the Allow Server Selection option and the Metric Context tab is based on the Allow Metric Selection option. If you have deselected these options during configuring a report, the tabs do not appear in the Report Context for the report.

*Figure 11-4  Server Context with server objects*

The Server Context tab displays the list of server objects, which you have selected from the Group Context while creating a report in the Reporting Center.

*Figure 11-5  Metric Context with metric objects*

The Metric Context tab displays the list of metric objects, which you have selected from the Metric Context while creating a report in the Reporting Center.
**Report Context filter:** Used to filter the Server Context data and the Metric Context data. You can select or deselect the objects in the Server Context and the Metric Context tabs and then click Apply to update the report.

If you refresh the Dashboard page or the Reporting portlet, the filter set by you is removed and the objects are restored to default selection.

**IMPORTANT:** The filter on the Server Context or the Metric Context is effective only when the X-axis of the chart represents the Server Context data or the Metric Context data for a report.

**NOTE:** This filter is not applicable for Aggregate template reports.

**Date Range**

The Date Range tab allows you to select a time period for which you want to view the report. This tab is based on Allow Time Selection option.

*Figure 11-6  Date Range*

When you specify a date range:

- Filter applied on the Server Context or the Metric Context is ignored and the chart displays the data based on the selected time period.

- The objects in the Server Context and the Metric Context tabs remain unaffected. For example, when you select a date range, the chart displays the data for all the connected servers during the time period but the server objects in the Server Context tab do not change as per the selected time period.

**Chart Panel**

The chart panel displays a report in the form of charts. The data in the chart is organized in the form of categories (X-axis data) and series (Y-axis data). You can click the series to hide or display the data in the chart.
In the illustration:

- SQL Server Available Log Space, SQL Server Blocked Processes and SQL Server Cache Hit Ratio are known as categories
- Today and Yesterday are known as series

For example, if you want to view today’s report only, click the Yesterday series to hide the yesterday’s data.

**NOTE:** Few charts require at least two data points to plot the graph: area chart, line chart, and so forth. A maximum of 1000 data points can be added on a chart based on the number of labels.

You can zoom a chart to view a particular area. Click and drag the mouse over the desired area to zoom. Click Reset zoom to return to the default scale.

**Printing a chart**

The Reporting portlet allows you to print a chart:

1. Click Print.
2. Select your configured printer.
3. Click OK.

**Exporting a chart**

A chart can be exported to various forms, for example: .png, .jpeg, .pdf, .svg.

1. Click Export.
2. Select the desired format.
11.3 Selecting the Dashboard 508 theme

The Operations Center Dashboard provides 508 compliance and compatibility for the Reporting Center portlets also.

Do the following to select the Dashboard theme:

1. In the Dashboard, do one of the following:
   - Click the options icon next to the site name, click Admin, and select Site Administration. On the Site Administration page, click Pages, and then select Site Pages.
     From the list of pages, select the desired page. To change the theme for all pages, click the community name (top level page).
   - Navigate to the desired Dashboard page.
     Click the edit icon and expand Look and Feel.

2. On the Look and Feel page:
3. Select the 508 Accessibility theme.
4. Repeat for each page that needs to be 508 accessible.
5. In the Reporting portlet, to open the Report Context:
   - Point the cursor on the Date Range.
   - Press Alt + Shift + M.

6. In the Reporting portlet, to close the Report Context:
   - Point the cursor on the Apply button.
   - Press Alt + Shift + N.

For more information on Section 508 Accessibility, see Section 13.3, “Enabling the Dashboard for Section 508 Accessibility,” on page 174.

11.4 Differences in the reports between and Reporting Center Console and the Dashboard

This section highlights the differences in the reports between Reporting Center Console and the Operations Center Dashboard:

- **Graph data supports only date or date-time format for custom time interval**: In the Operations Center Dashboard, reports configured with custom time intervals, such as week, month, quarter, or year in the Reporting portlet are not supported. The reports are displayed in date or date-time format.

- **If data points are close to each other in a chart, data points might overlap**: The data points in a chart might get overlapped if the data points are too close to each other.

- **Y-axis scale in the Operations Center Dashboard and the Reporting Center Console might not be same**: The Y-axis scale is set automatically and might vary based on the reports in Dashboard and Reporting Center Console.

- **Tool tip values for exponential data (e⁻¹⁰ or e⁺¹⁰) in the Operations Center Dashboard and the Reporting Center Console might not be similar**: The Y-axis scale is set automatically and might vary based on the reports in Dashboard and Reporting Center Console.
• **Sorting the report data in Reporting Center Console does not affect the graph in the Dashboard:** When you sort the report data in the Reporting Center Console, the graph displayed in the Reporting portlet of the Operations Center Dashboard does not change accordingly. So, the graph on the Reporting Center Console and Operations Center Dashboard might not appear similar.

• **Forecast and Moving Average reports do not work in the Operations Center Dashboard.** These reports are not supported.

### 11.5 Supported Reporting Center report properties

This section lists the report properties of the Reporting Center that are supported in the Operations Center Dashboard:

- 2-dimensional charts
- 3-dimensional charts (Only column, bar, pie, and doughnut charts)
- Show data point markers
- Empty point value appear as zero
- Data point format (except custom data point)
- Y-axis affinity (primary Y-axis and secondary Y-axis)
- Primary Y-axis enable
- Secondary Y-axis enable
- Reversed (X-axis and Y-axis)
- Enable X-axis cursor
- Enable Y-axis cursor
- Threshold enabled for primary and secondary Y-axis
- Threshold type (except custom threshold type)
- Threshold background color

**NOTE:** For any graph in the Reporting portlet, the null value represents zero.
Permissions are granted to users to perform actions on a set of resources. You can assign permissions to individual users or to a group of users who share the same role.

The administrator can use permissions to delegate tasks to users. For example, assign a user the permissions needed to manage a specific site.

- Section 12.1, “Assigning Permissions Using Roles,” on page 167
- Section 12.2, “Setting Individual Permissions,” on page 170
- Section 12.3, “Delegating Tasks with Roles,” on page 171
- Section 12.4, “Verifying User Permissions,” on page 171

### 12.1 Assigning Permissions Using Roles

Roles are groupings of users that share a particular function within the portal, according to a particular scope. You can grant roles permissions to various functions within portlet applications.

Roles are used to define permissions across their scope: across the portal, across an organization, or across a site. For example, consider a role which grants access to create a Service Management category. A portal role would grant that access across the portal, wherever there was a Service Management portlet.

Roles are scoped by:

- Portal
- Organization
- Site

A site role grants access only within a single site. An organization role grants that access only within an organization. Because roles are used strictly for portal security, they also do not have pages, like sites and organizations.

Administrators can define roles through the Control Panel. Roles are assigned permissions and then are assigned users or user groups. Users, user groups, sites, or organizations can be members of a role.

In the Dashboard, there are two types of roles that you are likely to require:

- Roles related to portal administration. For example, these roles might have rights to create new sites and maintain their pages.
- Roles that allow users to perform specific tasks within or for a site.

**NOTE:** While the following sections cover setting and assigning permissions for a site, these same features and steps apply for organizations.
The following sections cover roles and assigning permissions to them:

- Section 12.1.1, “Site Roles,” on page 168
- Section 12.1.2, “Portal Administration Roles,” on page 169
- Section 12.1.3, “Granting Role Permissions for Other Roles,” on page 170

12.1.1 Site Roles

When you create a site or organization, three default roles are created:

- **Administrator**: super users of their site and can assign site roles to users.
- **Owner**: super users of their site and can assign site roles to users.
- **Member**: default role assigned to all users who belong to the site or organization.

For information about assigning site users to these default roles, see “Assigning Site Roles” on page 169.

In addition, you might want to create additional roles that grant specific administrative capabilities for the site or allow access to perform an action within the site. For example, you can create a role that can assign users, or a “Journal” role that is in charge of updating journal entries.

Setting up site roles is a three-step process:

- “Creating Site Roles” on page 168
- “Granting Portlet Permissions” on page 168
- “Assigning Site Roles” on page 169

Creating Site Roles

Site roles allow you to define permissions for specific functionality that you want to grant to a subset of site members.

**To create a site role:**

1. In the Control Panel, click Users > Roles.
2. Click Add and select Site Role.
3. Provide a name and description for the role, and then click Save.
   
   Continue to “Granting Portlet Permissions” on page 168.

Granting Portlet Permissions

After you define a role, the next step is to define portlet permissions for the role.

**To grant portlet permissions to a role:**

1. In the Control Panel, click Users > Roles.
2. Click Actions next to the desired role and select Define Permissions.
   
   A list of portlets and the permissions that are associated with that role and portlet displays.
3. Click the desired portlet to define permissions for that portlet type.
4. Select the desired permissions, and then click Save.
   
   Continue to “Assigning Site Roles” on page 169.
Assigning Site Roles

At a minimum, assign the Administrator and Owner roles to at least one site member. After you define more specialized site roles, you can assign users to them.

For information about assigning default roles to users, see Section 4.4.1, “Default Associations for User Accounts,” on page 54.

To assign site users to a role:

1. In the Control Panel, click Users > Roles.
2. Click Actions next to the desired role and then select Assign Members.
3. On the Users tab, click Available.
4. Select the users to assign to the role, and then click Update Associations.

12.1.2 Portal Administration Roles

Portal-wide roles are related to portal administration. For example, these roles might have rights to create new sites and maintain their pages.

By default, there are four portal-wide roles:

- **Administrator:** has administrative privileges.
- **Power User:** is assigned to all users by default. You can give this role certain permissions or disable it altogether.
  
  If you remove the Power Users role from the default user associations, you will need to modify the permissions on certain portlets.
- **User:** is the most basic user.
- **Guest:** includes all unauthenticated users.

Assign permissions for portal-wide activities that are in several categories, such as Site, Location, Organization, Password Policy, etc. This allows you to create a role that, for example, can create new sites in the portal. This would allow you to grant users that particular permission without making them overall portal administrators.

**NOTE:** Portal permissions can only be assigned to roles of Regular type.

For information about assigning default roles to users, see Section 4.4.1, “Default Associations for User Accounts,” on page 54.

To create a portal administration role:

1. In the Control Panel, click Users > Roles.
2. Click Add, and then select Regular Role.
3. Specify a name and description for the role, and then click Save.
4. To define permissions for the role, do the following:
   4a. On the Roles page, click Actions next to the role and select Define Permissions.
   4b. Click Applications, and then click the portal for which you want to grant permissions.
   4c. Select the permissions you want to grant to the role.
To limit the sites for which the role has a permission, click Change, and then click Choose for each site for which you want to grant the permission.

Click Save.

To assign members to the role, do the following:

- On the Roles page, click Actions next to the role, and then select Assign Members.
- Click Users, User Groups, Communities, or Organizations.
- Click Available.
- Select the desired members to assign to the role, and then click Update Associations.

### 12.1.3 Granting Role Permissions for Other Roles

For all roles, you can give permissions to other roles for the maintenance of that role.

To assign permissions to another role:

To grant role permissions for other roles:

1. In the Control Panel, click Users > Roles.
2. Click Actions next a role of type Site or Organization, and then select Permissions.
3. Select the other role permissions to grant to the members of the selected role, and then click Save.

### 12.2 Setting Individual Permissions

You can grant various individual permissions for roles at the page or portlet level.

- Section 12.2.1, “Assigning Individual Permissions to Pages,” on page 171
- Section 12.2.2, “Assigning Individual Permissions to a Portlet,” on page 171
12.2.1 Assigning Individual Permissions to Pages

Page permissions are applicable only to the page for which you configure them.

To assign individual permissions for a page:
1. On the page, click the edit icon and then click Permissions.
2. For each role, select the desired permissions.
3. Click Save.

12.2.2 Assigning Individual Permissions to a Portlet

You can configure permissions for individual portlets, but it is not the best way to implement permissions because you might need to repeat the process for many users.

Portlet permissions are applicable only to the portlet instance for which you configure them.

To configure permissions for a portlet instance:
1. In the desired portlet, click the options icon, and then select Configuration.
2. On the Permissions tab, select the desired permissions for each role.
3. Click Save.

12.3 Delegating Tasks with Roles

Use permissions to assign tasks to users to help with the administration of the Dashboard. For example, assign to a user some of the roles of an enterprise, organization, or location administrator. Assign users to manage sites and pages within sites. You can moderate content by distributing it among sites and delegate the responsibility for moderating sites to various users.

To delegate tasks using roles:
1. Assign permissions to a role that allows a user to perform a specific task.
2. Assign that role to the resource.
3. Assign users to that role.
   You can assign roles to any resource, regardless of scope.

12.4 Verifying User Permissions

The impersonate feature allows you to log in as a user and see exactly what the user sees. This is useful to verify that permissions are set correctly.

To verify user permissions:
1. In the Control Panel, click Users > Users and Organizations.
2. Next to the desired user, click Action, and then select Impersonate User.
13 Advanced Administrative Topics

This section covers various administrative topics, such as:

- Section 13.1, “Encrypting the Dashboard Database Password,” on page 173
- Section 13.2, “Configuring Dashboard Ports for RMI Callbacks,” on page 173
- Section 13.3, “Enabling the Dashboard for Section 508 Accessibility,” on page 174
- Section 13.4, “Moving a Dashboard Configuration,” on page 175
- Section 13.5, “Upgrading the Dashboard,” on page 176
- Section 13.6, “Performing System Recovery,” on page 180

13.1 Encrypting the Dashboard Database Password

Database credentials are set in the portal-ext.custom.properties file, but the password can be encrypted to further secure your implementation.

To encrypt the database password:

1. To generate the encrypted password, run one of the following scripts:
   - Windows: /OperationsCenter_Dashboard_install_path/bin/encrypt.bat
   - UNIX: /OperationsCenter_Dashboard_install_path/bin/encrypt.sh

2. Copy and paste the encrypted password into the /OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/portal-ext.custom.properties file for the active database configuration.

   If the database properties have not previously been added to the portal-ext.custom.properties file in the same directory. Do not modify the portal-ext.properties file, as you might overwrite software upgrades that are already running.

   Note that the copied encrypted password should begin with X-TEAV and must not contain any passwords on the end.

3. Restart the Dashboard.

   For more information about starting and stopping the Dashboard, see Section 2.3, “Starting and Stopping the Dashboard,” on page 25.

13.2 Configuring Dashboard Ports for RMI Callbacks

Traditionally, firewall communication is restricted from the Dashboard to the Operations Center server. For more information on these RMI port settings, see Section 2.2.1, “Verifying Your Operations Center Server’s Default Accounts and Configuration Settings,” on page 16. For information about port configuration, see “The Dashboard using RMI” in the Operations Center Server Configuration Guide.

In some environments, it might be necessary to specify the number of ports available to use for communication from the Operations Center server to the Dashboard.
To specify the RMI Callback Port:

1. Stop the Dashboard.
   For information on stopping the Dashboard, see Section 2.3.2, “Stopping the Dashboard,” on page 25.

2. Edit the /OperationsCenter_Dashboard_install_path/server/webapps/ManagedObjectPortlets/WEB-INF/mo-settings.xml file to add the following:

   ```xml
   <entry>
     <string>rmi.callback.port</string>
     <string>PortNumber</string>
   </entry>
   ```

   Where PortNumber is the port number or a range of acceptable port numbers. For example, <string>6050:6059</string> sets 6050 as the lowest available port number and 6059 as the highest available port number.

3. Start the Dashboard.
   For information on starting the Dashboard, see Section 2.3.1, “Starting the Dashboard,” on page 25.

### 13.3 Enabling the Dashboard for Section 508 Accessibility

Section 508 requires that Federal agencies’ electronic and information technology is accessible to people with disabilities. The Operations Center Dashboard provides Section 508 compliance and compatibility whenever possible.

The following technical considerations apply when using the Dashboard with Section 508 accessibility enabled:

- Access the Dashboard using Internet Explorer 8 or Firefox when Section 508 accessibility is enabled.
- Enabling 508 accessibility in Operations Center changes the default appearance of some portlet content to be compliant with Section 508 standards. For example, it might enable features to be compliant in color dependence.
- Alarm summary charts, in the Information portlet, are not 508 compliant. The Information portlet is not 508 compliant when CSS is disabled.

To enable the Dashboard for 508 accessible functionality:

1. To enable accessibility options in Operations Center for one or more users:
   - 1a From the Operations Center console, expand Administration > Security > Users.
   - 1b Right-click the user’s account, and then select Properties.
   - 1c Click User.
   - 1d Select Enable Accessibility Options, and then click Apply.
   - 1e Repeat these steps for each user.

2. To enable accessibility options in Operations Center for your own account, from the Operations Center console, click File, and then select Enable Accessibility Options.
3 Do the following to select the Dashboard 508 theme:
   3a From the Dashboard Welcome page, click the options icon, click Admin, and then select Site Administration.
   3b Expand Pages, and then click Site Pages.
   3c Select the desired page. To change the theme for all pages, click the site name (top level page).
   3d Click Look and Feel, and then select Define a specific look and feel for this page.
   3e Select the MicroFocus 508 theme, and then click Save.
   3f Repeat these steps for each page that needs to be 508 accessible.

13.4 Moving a Dashboard Configuration

After configuring the Dashboard, you might want to move the Dashboard configuration to another computer. For example, you can first deploy the Dashboard in a test or development environment, then later move it to a production environment for general use.

- Section 13.4.1, “Preparing to Move a Dashboard Configuration,” on page 175
- Section 13.4.2, “Moving a Dashboard Configuration,” on page 175

13.4.1 Preparing to Move a Dashboard Configuration

To successfully move a Dashboard configuration, ensure that the environment meets the following prerequisites:

- Both the existing server and the target server must have the same version of the Dashboard, including the same patch bundles installed.
- The configuration settings in the Operations Center Dashboard Configuration Manager must be the same on both servers.

13.4.2 Moving a Dashboard Configuration

To move a Dashboard configuration:

1 Shut down both the Dashboard servers.
2 Copy /OperationsCenter_Dashboard_install_path/data/hsql/1portal.script from the existing server to the target server.
3 Modify the server_profiles section of the target server’s /OperationsCenter_Dashboard_install_path/server/webapps/ManagedObjectsPortlets/WEB-INF/data/serverprofiles-ext.xml file for the server’s properties.
4 Determine if any customizations were made to the existing server and if those customizations need to be made on the target server, as well.

Some files that might have been customized are:

- portal-ext.custom.properties: In /OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/, it is used for auto-login, persistent connection account, disabling of portlets, power user personal pages changes, or for overriding other liferay properties set in portal.properties.
Note that any settings in portal-ext.custom.properties file takes precedence over those in the portal-ext.properties file. Do not customize portal-ext.properties and portal.properties files, as you might overwrite the files.

- system-ext.properties: In /OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/, it is used for proxy server configuration.
- web.xml: In /OperationsCenter_Dashboard_install_path/server/conf/, it is used for session management.
- globals.xml: In /OperationsCenter_Dashboard_install_path/server/webapps/ManagedObjectsPortlets/WEB-INF/data/, it is used for global defaults for all Operations Center portlets.

5 Make the necessary customizations on the target server.

13.5 Upgrading the Dashboard

The following sections cover information about software patches as well as upgrading the Dashboard.

- Section 13.5.1, "About Patches," on page 176
- Section 13.5.2, "Installing Patches," on page 177
- Section 13.5.3, "Rolling Back a Patch Installation," on page 178
- Section 13.5.4, "Upgrading the Dashboard," on page 178
- Section 13.5.5, "Upgrading from the Dashboard Embedded Database to Oracle or SQL Server," on page 179

13.5.1 About Patches

Technical Support provides updates for the Dashboard in patch bundles, which must be installed on the Dashboard server. Before installing a patch, read all correspondence sent along with the patch, including a Readme file or e-mail.

Patch files use the naming convention nnnyyy-mm-ddCRiiiiii-Rxxxxx-META-DASH.jar. Table 13-1 describes the components of the patch file name.

<table>
<thead>
<tr>
<th>Patch File Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>nnn</td>
<td>Software version number (such as 550 for version 5.5.0).</td>
</tr>
<tr>
<td>yyyy</td>
<td>Current year.</td>
</tr>
<tr>
<td>mm</td>
<td>Current month (such as 03 for March).</td>
</tr>
<tr>
<td>dd</td>
<td>Current day (such as 01, 02, 03).</td>
</tr>
<tr>
<td>iiiiii</td>
<td>Internal reference number</td>
</tr>
<tr>
<td>xxxxxx</td>
<td>Release number</td>
</tr>
<tr>
<td>META</td>
<td>If present, indicates the patch contains all interdependent patches.</td>
</tr>
</tbody>
</table>
13.5.2 Installing Patches

The procedure for installing the patch is the same for UNIX and Windows. The type of file for a patch is .jar. If you receive the file with a different extension, rename it to .jar before installing it.

One or more patches can be applied at a time, but patches and rollbacks cannot be applied at the same time with the same command. When a patch has already been applied, but is a older version than what you are installing, it is necessary to rollback the patch before installing the newer version of the patch.

When a patch bundle is applied, all previously applied patches are removed before the patch is applied.

To install the patch:

1. Copy the patch bundle to the root of the Dashboard installation directory.
   The installation directory in the file system should have a minimum free disk space of twice the size of the patch bundle file.
   For example, if the .jar file is 50 MB, then the free disk space should be at least 100 MB.
2. At a command prompt, enter Java to verify that Java is installed.
   Patch files are issued as .jar files. The patch bundle is a Java executable file.
3. If you receive the patch file with a different extension than .jar, such as a .zip, rename it to .jar before installing it.
4. At the command prompt in the Dashboard installation directory, enter java –jar and the file name of the patch bundle.
   For example, if the Dashboard is installed in the C: directory and the name of the patch bundle is 5502015-03-04CR913407-R95915-DASH.jar, then the command is:
   ```
   C:/OperationsCenter_Dashboard_install_path>java -jar 5502015-03-04CR913407-R95915-DASH.jar
   ```
   For additional options when running the installation, enter:
   ```
   java -jar patch_bundle_filename(s) --help
   ```
   Where, `patch_bundle_filename(s)` is a list of one or more patch files separated by a space.
   This displays the following options:
   - **–describe**: Prints patch manifest information.
   - **–prompt**: Displays the Operations Center Dashboard Configuration Manager after the patch is installed.
   - **–verbose**: Prints detailed information to the screen as the patch is installed.
   - **--force**: Forces a patch to install even if it has already been applied. Never use the force command unless instructed to by Support (https://www.netiq.com/support/).
Add one of these commands at the end of the `java -jar patch_bundle_filename` command when installing the patch bundle (for example, `java -jar 5502015-03-04CR913407-R95915-DASH.jar --verbose`).

If installing on Windows and User Access Control (UAC) is enabled, you must run the command prompt as the Administrator.

5 During installation, the following occurs:

- A back up is automatically created for all files that are overwritten. For more information about rollback files, see Section 13.5.3, “Rolling Back a Patch Installation,” on page 178.
- Patches (of the same version) that have already been applied are skipped unless the `--force` option was set.
- The Operations Center Configuration Manager always runs silently and applies the current settings.
- The patch does not override the existing Operations Center Configuration Manager settings.

For more information regarding the Operations Center Configuration Manager, see the Operations Center Server Configuration Guide.

6 Review the following chapter to configure and start the Dashboard.

After the patch has been installed and a rollback file is created, the patch cannot be installed again. If you attempt to run the patch bundle .jar file again, the following error messages are displayed:

```
ERROR: Unable to continue since rollback jar already exists
ERROR: unable to create rollback jar
```

### 13.5.3 Rolling Back a Patch Installation

As part of the patch installation process, Operations Center automatically backs up all files that are overwritten and places them in a file called `patch_filename-rollback.jar`, such as `5502015-03-04CR913407-R95915-DASH-rollback.jar`.

If you decide to remove the changes made by the patch to Operations Center, run this rollback JAR file from the Operations Center root installation directory. The command for running the rollback file is the same as when the patch is installed. For example:

```
C:/OperationsCenter_install_path>java -jar 5502015-03-04CR913407-R95915-DASH-rollback.jar
```

When multiple rollback patches are applied using the same command, they are applied in the reverse order.

### 13.5.4 Upgrading the Dashboard

The following notes apply when upgrading your version of the Dashboard:

- The `Dashboard_install_path/server/webapps/root/WEB-INF/portal-ext.xml` file, which might have been customized for various property settings, is overwritten during the upgrade process. A copy is automatically saved as `portal-ext.xml.previous` in the same directory. If you had modified this file as part of your installation, you will need to restore these changes after the upgrade installation.

Note that the `portal-ext.xml` file should never be modified. Any configurations and changes should be made in the `portal-ext.custom.xml` file as it is never overwritten by the installer.
If the NetIQ Operations Center Dashboard service is not using the Local System account to connect to the dashboard database, you must re-establish the service after upgrading.

Custom theme content is not updated and will default to the default theme when you upgrade from Operations Center v5.6 to v5.7. You must also manually change any static links to documentation.

Liferay 6 does not support the 2-1 (30/70) page layout. If you configured a page with the 2-1 (30/70) page layout, to avoid losing the portlet, change the page to use any other layout before you upgrade to Operations Center v5.7.

## 13.5.5 Upgrading from the Dashboard Embedded Database to Oracle or SQL Server

If running an existing dashboard implementation, you must switch from using the default Hypersonic SQL embedded database to upgrade to an Oracle or SQL Server database. If you have been using the dashboard with the embedded database, it is possible to upgrade your database and preserve existing data.

Operations Center includes the following packaged drivers for connecting to SQL Server and Oracle databases:

- **SQL Server**: net.sourceforge.jtds.jdbc.Driver
- **Oracle**: oracle.jdbc.OracleDriver

See "Supported Versions and Hardware Requirements" in the *Operations Center Getting Started Guide* for supported database versions.

### Important:
You must start the dashboard at least once using the Hypersonic SQL embedded database, so that it can run critical database verification processes. If you are installing the dashboard for the first time or have just upgraded, you must start the dashboard once before implementing the following steps to migrate the database to Oracle or SQL Server.

To migrate the dashboard to use an Oracle or SQL Server database on an existing integration:

1. Ensure that the dashboard is running. See Section 2.3.1, “Starting the Dashboard,” on page 25.
2. Ensure that the target database does not contain any Dashboard tables.
3. Use the Liferay Data Migration tool to migrate existing data from the database:
   3a. Start the Control Panel as administrator and navigate to **Configuration > Server Administration > Data Migration**.
   3b. Provide the requested information for the target database, and then click **Execute**.
The migration process updates the Dashboard configuration to use the new database. The Dashboard server is shut down during the update.

4 Restart the dashboard and verify that existing data is available. See Section 2.3.1, “Starting the Dashboard,” on page 25.

13.6 Performing System Recovery

If the Operations Center server stops, the following occurs:

- The Dashboard continues to function for users already logged in, but data from Operations Center is not available. Operations Center portlets display a message stating that the Operations Center server is not accessible. After the Operations Center server restarts, users must log out of the Dashboard and log in again in order to see Operations Center data.

- Users who were not logged in before the server stopped cannot log in to the Dashboard until the Operations Center server is back up.

- The Access Control Synchronizer stops and user accounts are not synchronized until the Operations Center server has come back up.

If the Dashboard Web server stops for any reason, when it restarts, it identifies all users who were logged in to the Dashboard at the time of stoppage and logs them out of the Operations Center server. It then begins working as usual. For errors that can be logged in the trace file if the Dashboard Web server stops while writing data, see Section D.1.2, “Data Dispatcher Exception – Broken Pipe,” on page 206.
System Properties File

The `system.properties` file contains properties that relate to the Dashboard including the proxy server configuration, default language, and default time zone. This file is never modified at any time.

The following sections describe how to override `system.properties` file properties as well as view default system properties:

- Section A.1, “Overriding System Settings in the Systems Properties File,” on page 181
- Section A.2, “Viewing the Default System Properties,” on page 182

A.1 Overriding System Settings in the Systems Properties File

The `system.properties` file contains properties that relate to the Dashboard including the proxy server configuration, default language, and default time zone. This file is never modified at any time.

Instead, a `/OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/classes/system-ext.properties` file is used to override setting, when necessary.

**WARNING:** Exercise caution when modifying the `system-ext.properties` file. Do not change any properties unless you are fully aware of the consequences. Changing some properties could cause conflicts with the Operations Center server and can have unintended consequences.

To configure the systems property file:

1. For the Dashboard to recognize the `system-ext.properties` file, open the `\OperationsCenter_Dashboard_install_path\bin\catalina.bat` (Windows) or the `/OperationsCenter_Dashboard_install_path/bin/catalina.sh` (UNIX) file.

2. Add the following line to the set `JAVA_OPTS` property:

   `-Dsystem.properties.load=true`
A.2 Viewing the Default System Properties

To view the default system.properties on your installation, open the copy of the system.properties file contained in the /OperationsCenter_Dashboard_install_path/server/webapps/ROOT/WEB-INF/lib/portal-impl.jar file.

The system.properties file cannot be edited.

The code for the default system.properties file is as follows:

```java
## Java
#
# The file encoding must be set to UTF-8 in order for the
# internationalization to work correctly.
#
file.encoding=UTF-8
#
# Java uses the underlying operating system to generate images. If you are
# using UNIX and do not start the portal in a X Windows session, then Java
# will not know how to generate images and you'll get lots of nasty
# exceptions. Setting this property to true will fix that. Sometimes this
# property cannot be set dynamically when the server starts and you'll need
# to edit your start script to include this as a system property.
#
java.awt.headless=true
#
# Set the default language.
#
user.country=US
user.language=en
#
# The time zone must be set GMT so that the portal knows how to properly
# translate time across time zones.
#
user.timezone=GMT
## Servlet Filters
##
#
# If the user can unzip compressed HTTP content, the compression filter will
# zip up the HTTP content before sending it to the user. This will speed up
# page rendering for users that are on dial up.
#
com.liferay.filters.compression.CompressionFilter=true
com.liferay.filters.compression.CompressionFilter.encoding=UTF-8
#
# The strip filter will remove blank lines from the outputted content. This
# will speed up page rendering for users that are on dial up.
#
com.liferay.filters.strip.StripFilter=true
com.liferay.filters.strip.StripFilter.encoding=UTF-8
#
# The layout cache filter will cache pages to speed up page rendering for
# guest users. Set the refresh time in milliseconds on how often the cache
# should refresh. Set it to 0 if the cache never times out. Default time
# out
# is set to one hour.
#```
com.liferay.portal.servlet.filters.layoutcache.LayoutCacheFilter=true
com.liferay.portal.servlet.filters.layoutcache.LayoutCacheFilter.encoding=UTF-8
com.liferay.portal.servlet.filters.layoutcache.LayoutCacheFilter.refresh.time=3600000

# The virtual host filter maps hosts to public and private pages. For example, if the public virtual host is www.helloworld.com and the friendly URL is /helloworld, then http://www.helloworld.com is mapped to http://localhost:8080/web/helloworld.
com.liferay.portal.servlet.filters.virtualhost.VirtualHostFilter=true

# The CAS filter will redirect the user to the CAS login page for SSO. See http://www.ja-sig.org/products/cas for more information.
com.liferay.filters.sso.cas.CASFilter=false

## Logging

# Set any logger that implements org.apache.commons.logging.Log.

#org.apache.commons.logging.Log=org.apache.commons.logging.impl.Log4JLogger

# Set the following to true if Log4j complains that it was not properly configured.
log4j.configure.on.startup=true

## Encryptor

# Set the security provider class.
com.liferay.util.Encryptor.provider.class=com.sun.crypto.provider.SunJCE

## HTTP

# Set the location of the HTTP proxy that the portal will use to fetch external content.
http.proxyHost=192.168.0.200
http.proxyPort=4480

# These are read for backwards compatibility and only used if the "http.proxyHost" and "http.proxyPort" settings are not specified.
com.liferay.util.Http.proxy.host=192.168.0.200
com.liferay.util.Http.proxy.port=4480

# Set the proxy authentication type.
com.liferay.util.Http.proxy.auth.type=username-password
com.liferay.util.Http.proxy.auth.type=ntlm
# Set user name and password used for HTTP proxy authentication.
#
#com.liferay.util.Http.proxy.username=
#com.liferay.util.Http.proxy.password=
#
# Set additional properties for NTLM authentication.
#
#com.liferay.util.Http.proxy.ntlm.domain=
#com.liferay.util.Http.proxy.ntlm.host=
#
# Set the connection timeout when fetching HTTP content.
#
#com.liferay.util.Http.timeout=5000
#
## Format
##
# Set the location of the class that implements
# com.liferay.format.PhoneNumberFormat. This class will format phone
# numbers.
#
com.liferay.util.format.PhoneNumberFormat=com.liferay.util.format.USAPhoneNumberFormat
#com.liferay.util.format.PhoneNumberFormat=com.liferay.util.format.IdenticalPhoneNumberFormat
#
## Axis
##
# Urls that match the specified pattern will use the SimpleHTTPSender. Urls
# that do not match the specified pattern will use Axis' default HTTPSender.
#
com.liferay.util.axis.SimpleHTTPSender.regexp.pattern=.*mappoint\net.*
#
## XSS (Cross Site Scripting)
##
# Set the pattern to strip text of XSS hacks.
#
com.liferay.util.XSSUtil.regexp.pattern=(?i)<[^\s]*script[^>]*>|[^\s]*embed[^>]*|[^\s]*object[^>]*|<[^\s]*a[^>]*href[^>]*javascript[^>]*[^\s]*[^>]*[^\s]*[^>]*[^\s]*[^>]
#
## Upload Servlet Request
##
# Set the maximum file size. Default is 1024 * 1024 * 1000.
#
com.liferay.util.servlet.UploadServletRequest.max.size=104857600
#
# Set the temp directory for uploaded files.
#
com.liferay.util.servlet.UploadServletRequest.temp.dir=C:\Temp
#
## Session Parameters
##
# Encrypt session parameters so that browsers cannot remember them.
# com.liferay.util.servlet.SessionParameters=true
##
## Lucene
##
## # Set a timeout to avoid lock errors.
## #org.apache.lucene.writeLockTimeout=30000
##
## Quartz
##
## # Make threads daemon so the JVM exits cleanly.
## org.quartz.threadPool.makeThreadsDaemons=true
##
## Velocity Engine
##
## # Input a list of comma delimited class names that extend
## com.liferay.util.velocity.VelocityResourceListener. These classes will
## run in sequence to allow you to find the applicable ResourceLoader
## to load a Velocity template.
##
## com.liferay.portal.velocity.JournalTemplateVelocityResourceListener,
## com.liferay.portal.velocity.DefaultVelocityResourceListener
Running a Console or Unattended Installation

Alternative methods for installing Operations Center software are provided in the following sections:

- Section B.1, “Console Installation,” on page 187
- Section B.2, “Unattended Installation,” on page 187

B.1 Console Installation

The console installation runs a text-based version of the Dashboard installation wizard. In a console installation:

- The options are the same as the Windows-based version, except that you must type the responses.
- There are no Choose buttons to open directories to locate files. Instead, you must provide the path names for the files.
- There is no option to open the Configuration Manager at the end of the installation. The default settings for the Configuration Manager are automatically applied.
- You can run a console installation on a Unix machine without having an X Window system set to display graphical (X client) applications on the local X server display. However, you will still need the local X server display to open the Configuration Manager on that machine, if you opt to do so after installing Operations Center.

To run a console installation:

1. Do one of the following:
   - Windows: Insert the Operations Center Installation CD and from the directory where the installation executable file resides, type `install.bat -i console` at a command prompt.
   - Unix: Create a home directory for the installation, mount the Operations Center Installation CD, then from the directory where the installation executable file resides, type `install.sh -i console` at a command prompt.

2. Follow the prompts in the script to provide the information required to install the product. For more information about installer prompts, see Section 2.2.2, “Installing the Dashboard,” on page 17.


B.2 Unattended Installation

This method installs Operations Center without opening the Installation Wizard. It takes all of the default values and run silently in the background. A response file can be used to supply predefined values including:

- Options from the installation wizard
- Licensing information from the license file
Configuration Manager settings
A configuration stored in the Configuration Storage data source

This method is intended for when you need to rerun the installation often, such as in a test environment.

You can run a silent installation on a Unix machine without having an X Window system set to display graphical (X client) applications on the local X server display. However, you will still need the local X server display to open the Configuration Manager on that machine.

For more information about the Configuration Manager and configurations and the Configuration Storage data source, see the Operations Center Server Configuration Guide.

Use the following sections to run an unattended installation:

- Section B.2.1, “Running an Unattended Installation,” on page 188
- Section B.2.2, “Using a Response File,” on page 190
- Section B.2.3, “Sample Response File,” on page 190

### B.2.1 Running an Unattended Installation

To run an unattended installation:

1. To install Operations Center, do one of the following:
   - **Windows**: Insert the Operations Center Dashboard Installation CD and from the directory where the installation executable file resides, type `install.bat -i silent` at a command prompt.
   - **Unix**: Create a home directory for the installation, mount the Operations Center Dashboard Installation CD, then from the directory where the installation executable file resides, type `install.sh -i silent` at a command prompt.
      
      Default install options are used to complete the installation.

2. After the unattended installation has completed, continue with Section 2.2.3, "Configuring the Dashboard Database," on page 19.

To run an unattended installation:

1. To install Operations Center, do one of the following:
   - **Windows**: Insert the Operations Center Installation CD and from the directory where the installation executable file resides, type `install.bat -i silent` at a command prompt.
   - **Unix**: Create a home directory for the installation, mount the Operations Center Installation CD, then from the directory where the installation executable file resides, type `install.sh -i silent` at a command prompt.

      Default install options are used to complete the installation.

2. After the unattended installation has completed, continue with Section 2.2.3, "Configuring the Dashboard Database," on page 19.
Using a Response File to Customize Installation Options

To run an unattended installation with a response file:

1. Because there are multiple ways to create a response file, depending on the content you want to include, do one of the following:
   - To create a response file that includes the options from the installation wizard, licensing information, configuration manager settings, and a configuration stored in the Configuration storage data source, at a command prompt on the machine that has the existing Dashboard installation that you want to use, enter the following:

     ```
     java -classpath Dashboard_Installation_Directory/lib/Customizer.jar com.mosol.install.myMOInstallerResponseFile responsefile.rsp
     Installation_Directory
     ```

     replacing `responsefile` with the name of the response file to be created and `Installation_Directory` with the installation directory for the existing Dashboard installation.

     For example, type:

     ```
     ```

     to create a response file called `moreresponse.rsp` that uses the Dashboard installation located in the `C:` directory.
   - To create a response file that includes installation wizard options only, run a wizard-based or console installation by typing the following at a command prompt:

     ```
     install.bat -i install method -r filename for Windows where install method is the installation method (either GUI or console) and filename is the name of the response file, such as myinstall.rsp.
     install.sh -i install method -r filename for Unix where install method is the installation method (either GUI or console) and filename is the name of the response file, such as myinstall.rsp.
     ```

     When a response file is created, it is saved in the Dashboard installation directory.

2. Copy the response file to the server where you want to install the Dashboard.

   If necessary, edit the file using a text editor. Some changes that you can make include:
   - Adding licensing information
   - Changing configuration settings
   - Modifying the configuration from the Configuration Storage data source

3. To use the response file to install the Dashboard, do one of the following:
   - **Windows**: Insert the Dashboard Installation CD and from the directory where the installation executable file resides, type `install.bat -i silent -f filename.rsp` at a command prompt replacing `filename` with the name of the response file.
   - **Unix**: Create a home directory for the installation, mount the Dashboard Installation CD, then from the directory where the installation executable file resides, type `install.sh -i silent -f filename.rsp` at a command prompt replacing `filename` with the name of the response file.

   The options in the response file are used to automatically complete the installation.

4. After the unattended installation has completed, continue with Section 2.2.3, “Configuring the Dashboard Database,” on page 19.
B.2.2 Using a Response File

Use the response file during the process of performing a silent installation of the Dashboard on a different machine. The installation uses the options in the response file to automatically complete the installation wizard.

To install the Dashboard using the response file:

1. Copy the response file to the machine where you want to install the Dashboard.
   If necessary, edit the response file using a text editor.

2. Perform a silent installation, enter the following at a command prompt:
   - **Windows**: `install.bat -i silent -f filename.rsp`
     - *filename* is the name of the response file (such as `myinstall.rsp`).
   - **UNIX**: `install.sh -i silent -f filename.rsp`
     - *filename* is the name of the response file (such as `myinstall.rsp`).

B.2.3 Sample Response File

This section contains a sample response file for the Dashboard installation, which is a standard ASCII text file. Response files are created from an actual installation of the product, giving you default values that are determined by that installation.

Because a response file’s content contains very few carriage returns, the following sample’s content is word-wrapped automatically where the documentation program can break a long string, such as at spaces, forward slashes, or certain characters. For example, in a text editor with word-wrap turned off, this sample response file contains 5 lines, one of which contains most of the content.

```xml
#Thu Feb 07 10:46:06 EST 2008
LICENSE_CONTENTS=
CONFIGURATIONS_CONTENTS=
USER_INSTALL_DIR=C:\myMOFeb7_Clone0
CUSTOMIZE_PROPERTIES_CONTENTS=<config>
  <properties>
    <entry>
      <string>MOCommunicationsMode</string>
      <string>https</string>
    </entry>
    <entry>
      <string>MyMORMICache</string>
      <string>false</string>
    </entry>
    <entry>
      <string>MOServerHost</string>
      <string>dhendricks</string>
    </entry>
    <entry>
      <string>JavaHome</string>
      <string>C:\Documents and Settings\sshetty\Local Settings\Temp\I1202399004\Windows\resource\jre</string>
    </entry>
    <entry>
      <string>MymoLogLevel</string>
      <string>WARN</string>
    </entry>
    <entry>
      <string>MOSqlServerPort</string>
      <string>7560</string>
    </entry>
    <entry>
      <string>MOImageServerPort</string>
      <string>7002</string>
    </entry>
    <entry>
      <string>LocalDomain</string>
      <string>localdomain</string>
    </entry>
    <entry>
      <string>MyMOWebServerPort</string>
      <string>7080</string>
    </entry>
    <entry>
      <string>MyMOServerPushEnabled</string>
      <string>false</string>
    </entry>
  </properties>
</config>
```

190 Operations Center Dashboard Guide
<entry>
  <entry>
    <string>MORMIServerPort</string>
    <string>7099</string>
  </entry>
  <entry>
    <string>MyMOServerAlarmOperationsEnabled</string>
    <string>false</string>
  </entry>
  <entry>
    <string>InstallDir</string>
    <string>C:\\myMOFeb7</string>
  </entry>
  <entry>
    <string>HostName</string>
    <string>djones</string>
  </entry>
  <entry>
    <string>HttpCommentEnd</string>
    <string>--&gt;</string>
  </entry>
  <entry>
    <string>HttpCommentHead</string>
    <string>&lt;!--</string>
  </entry>
  <entry>
    <string>IpAddress</string>
    <string>192.168.10.228</string>
  </entry>
  <entry>
    <string>MyMOWebServerSSLPort</string>
    <string>7443</string>
  </entry>
  <entry>
    <string>MyMORMICacheTimeout</string>
    <string>75</string>
  </entry>
  <entry>
    <string>HttpsCommentHead</string>
    <string></string>
  </entry>
</properties>
</config>
The Operations Center custom tag libraries can expose server component information and functions. Custom tag libraries extend the basic set of tags that can be defined within a JSP (JavaServer Pages) page.

- Section C.1, “Understanding JSP Tag Libraries in Operations Center,” on page 193
- Section C.2, “Query Tag Library,” on page 194
- Section C.3, “Constrain Tag Library,” on page 195
- Section C.4, “Expand Tag Library,” on page 197
- Section C.5, “Request Tag Library,” on page 198
- Section C.6, “Element Tag Library,” on page 200
- Section C.7, “Result Tag Library,” on page 202

**C.1 Understanding JSP Tag Libraries in Operations Center**

Operations Center custom tag libraries are an integral part of JSP. Tag libraries allow Web developers to create new tags for inclusion in JSP pages that perform custom actions within a Web page.

Operations Center provides several custom tag libraries for obtaining information from Operations Center server components. These custom tags provide the JSP programmer with an easy way to access Operations Center server information, including SLA performance, user authentication, alarms, and element conditions.

The following figure shows how custom tags fit into the Operations Center architecture:

*Figure C-1  Architecture of JSP Custom Tags and Operations Center*
The requirements for placing custom tag libraries are:

- Specify a tag library name at the top of the JSP page. For example, the following line appears at the top of the JSP file, before the `<html>` tag:

```jsp
<%@ taglib uri="http://www.managedobjects.com/taglibs/query" prefix="query" %>
```

This refers to the custom tags in the Query Custom tag library.

- The Web deployment descriptor file (WEB-INF/web.xml) must specify the location of the tag library. For example:

```xml
<taglib>
  <tagliburi>http://www.managedobjects.com/taglibs/query</tagliburi>
  <taglib-location>/WEB-INF/query.tld</taglib-location>
</taglib>
```

## C.2 Query Tag Library

The Query tag library contains functionality specific to the Operations Center application for querying against the performance engine. This tag library contains two tags: `createQuery` and `performQuery`. Use both tags together to retrieve information from Operations Center.

To reference this custom tags in the Operations Center tag library, add the following code to the top of the JSP file before the `<html>` tag:

```jsp
<%@ taglib uri="http://www.managedobjects.com/taglibs/remote/query" prefix="query" %>
```

The following sections explain the tags:

- Section C.2.1, “createQuery,” on page 194
- Section C.2.2, “performQuery,” on page 195

### C.2.1 createQuery

The `createQuery` tag creates a query to obtain information from Operations Center.

This tag is necessary to provide some constraints, requests, and expansions within the body of `createQuery` tag. Use the tags belonging to Constrain, Request, and Expand tag libraries.

The `createQuery` tag can be nested, if required, in order to create subqueries. It has the option of placing conditional code within the body of the tag.

For example:

```jsp
<query:createQuery>
  [provide constraints]
  [provide expansion]
  [provide requests]
  [perform query]
</query:createQuery>
```

The `createQuery` tag alone cannot generate any required result. Use it to begin a query. This tag creates a `HyperQuery` object, which maintains `java.util.Set` objects for storing/queuing unique constraints, requests, and expansions. When any tags belonging to the Constrain, Request, and
Expand tag libraries are inside the `createQuery` tag, objects pertaining to them are stored in the respective `java.util.Set` objects. A `HyperQuery` object is later used within the `performQuery` tag to obtain information from the performance engine.

### C.2.2 performQuery

The `performQuery` tag performs or executes a query.

After performing a query against the performance engine, the `performQuery` tag internally maintains a list of `HyperCube` objects. Tags belonging to the `Result` tag libraries use these objects to manipulate information. Place the `Result` library tags within the body of the `performQuery` tag to obtain information. For example, the `iterator` tag iterates information provided by the performance engine.

Place any conditional code within the body of the tag. For example:

```xml
<query:createQuery>
  <constrain:element name="<%=dname%>" />
  <constrain:time from='<%=""+start%>' to='<%=""+end%>' />
  <request:summaryState />
  <request:availability />
  <query:performQuery>
    <result:iterator id="test" />
  </query:performQuery>
</query:createQuery>
```

### C.3 Constrain Tag Library

The Constrain tag library contains functionality specific to the Operations Center application for filtering data using a query. Constraints are similar to the WHERE clause in SQL. A constraint reduces the amount of data returned by the query by applying the filter to the results. This tag library contains many tags used inside a `createQuery` tag. All the tags belonging to this library are empty; they do not contain body content.

The following sections explain the tags:

- Section C.3.1, "category," on page 195
- Section C.3.2, "element," on page 196
- Section C.3.3, "excludeManual," on page 196
- Section C.3.4, "local," on page 196
- Section C.3.5, "offering," on page 196
- Section C.3.6, "objective," on page 196
- Section C.3.7, "time," on page 197
- Section C.3.8, "timeZone," on page 197

#### C.3.1 category

The `category` tag provides constraints on time categories, such as Off, Non-Peak, On, Peak, Critical, and so on:

```xml
<% String[] catsAsArray = new String[] {"On", "Peak", "Critical"); %>
<constrain:category timeCategoryIds="<%= catsAsArray %>"/>
```
This tag has one mandatory attribute, timeCategoryIds, which provides time category names. The timeCategoryIds tag accepts an array of time category names to include in the calculations. For example, use this tag to query for downtime during Peak times only.

C.3.2 element

The element tag provides a constraint on a given Operations Center element:

```xml
<constrain:element name="element_to_constrain"/>
```

It has one mandatory attribute, name, which provides the name of the element to constrain. To obtain performance information about an Operations Center element, it is necessary to specify the element tag within the createQuery tag. The following code snippet constrains a query by instructing it to fetch information about the Organizations > Check Your Bill element that displays in the Explorer pane in the Operations Center console:

```xml
<query:createQuery>
    <constrain:element name="org=Check+Your+Bill/root=Organizations"/>
<query:createQuery>
```

C.3.3 excludeManual

The excludeManual tag manually excludes created outages when computing results:

```xml
<constrain:excludeManual/>
```

This tag has no attribute and is used like a parameter for the createQuery tag.

C.3.4 local

The local tag constrains all SLA calculations to data that are relevant for the current element only, and not its children:

```xml
<constrain:local/>
```

This tag has no attribute and is used like a parameter for the createQuery tag.

C.3.5 offering

The offering tag provides constraints on an SLA (offering):

```xml
<constrain:offering name="SLA name"/>
```

This tag has one mandatory attribute, name, which provides the SLA name.

C.3.6 objective

The offering tag provides constraints on a given SLA objective:

```xml
<constrain:objective name="objective name"/>
```

This tag has one mandatory attribute, name, which provides the SLA objective name.
C.3.7 time

The time tag provides constraints on a time period:

\[
<\text{constrain}:\text{time} \text{ form }="<%=\text{start}\%>" \text{ to }="<%=\text{end}\%>" />
\]

The attributes of this tag are: from, to, and interval. The from and to attributes provide the time frame value to use in obtaining performance information.

C.3.8 timeZone

The timeZone tag provides constraints on a given time zone specified by an ID:

\[
<\text{constrain}:\text{timeZone} \text{ name }="\text{Zone ID}\" />
\]

This tag has one mandatory attribute, name, which identifies the time zone.

C.4 Expand Tag Library

The Expand tag library contains functionalities specific to the Operations Center application for expanding a query against the performance engine.

To reference this custom tags in the Operations Center tag library, add the following code to the top of the JSP file before the <html> tag:

\[
\text{URL} = <%=\text{taglib} \text{ uri }="\text{http://www.managedobjects.com/taglibs/remote/query/expand}\" \text{ prefix }="\text{expand}\%>
\]

An expansion increases the amount of the data returned by the query by adding all data that matches the expansion criteria. For example, to produce a result set containing a cube of data for each hour of the day since yesterday, use the time expansion with an hour interval. The query result is 24 cubes of data.

As with the constrain tags, the expand tags must be used within the createQuery tag. All of the tags belonging to this tag library have no attributes, except for the time tag:

- Section C.4.1, “time,” on page 197

C.4.1 time

Expands the result cubes based on a time interval:

\[
<\% \text{ String end } = "\" + \text{System.currentTimeMillis()} ; %>
<\text{expand}:\text{time} \text{ from }='<%=\text{start}\%>' \text{ to }='<%=\text{end}\%>' \text{ interval }="\text{months}"/>\]

For example, to obtain a result set containing a cube for each day of the last month, use the time expansion with a day's interval. This returns 30 cubes of data in the query result, if the month has 30 days. This tag has three attributes: from, to, and interval. The from and to attributes specify the start and end dates of a period as a long value. The mandatory interval attribute provides time intervals, such as: "seconds", "minutes", "hours", "days", "weeks", "months", "years", "milliseconds".
C.5 Request Tag Library

The Request custom tag library contains tags that can access information in the Operations Center performance engine.

To reference this custom tags in the Operations Center tag library, add the following code to the top of the JSP file before the `<html>` tag:

```html
URL = <%= @taglib uri="http://www.managedobjects.com/taglibs/remote/query/request" prefix="request" %>
```

To obtain results using the performQuery tag, it is necessary to use request tags to obtain any type of information from the Operations Center performance engine. Use the request tag within a createQuery tag as you might use constrain and expand tags. All the tags belonging to this library have no body content. It is possible to provide any number of unique requests within a query. When a request is provided within a createQuery tag, it adds the requested value into the query result set. When the performQuery starts executing the tag, it takes the requests from the query and creates results containing the value.

The syntax for using the request tag is:

```xml
<query:createQuery>
  <constrain:element name="<%=dname%>">
  <request:availability>
  <query:performQuery>
    [result manipulation]
  </query:performQuery>
</constrain:element>
</query:createQuery>
```

- **Section C.5.1, “summaryState,” on page 198**
- **Section C.5.2, “compliance,” on page 198**
- **Section C.5.3, “availability,” on page 199**
- **Section C.5.4, “outageCount,” on page 199**
- **Section C.5.5, “breachCount,” on page 199**
- **Section C.5.6, “outageDuration,” on page 200**
- **Section C.5.7, “objectiveInstance,” on page 200**

C.5.1 summaryState

Obtains the condition or state of a given Operations Center element:

```xml
<request:summaryState/>
```

C.5.2 compliance

Requests compliance from an element’s agreement/objectives for a specified period of time:

```xml
<request:compliance/>
```
A time constrain tag must be provided within the createQuery tag to provide a time window to obtain compliance from the performance engine.

It is necessary to provide the element, time and offering constrain tags and a compliance request tag within the createQuery tag to obtain compliance from an element's agreement (SLA):

```xml
<constrain:time from="start time" to="end time"/>
<constrain:element name=" org=Check+Bill/root=Organizations"/>
<constrain:offering name="SLA Name"/>
<request:compliance/>
```

C.5.3 availability

Requests availability of an element's agreement (SLA) or of an objective of an agreement, for a specified period of time:

```xml
<request:availability/>
```

A time constrain tag must be provided within the createQuery tag to use a time window to obtain availability from the performance engine.

In order to make available an element's agreement, provide the element and offering constraints and request availability within the createQuery tag, as shown in the following code:

```xml
<constrain:time from="<%=""start%>" to="<%=""+end%>" />  
<constrain:element name=" org=Check+Bill/root=Organizations">  
<constrain:offering name="<%=SLA%>">  
<request:availability>
```

C.5.4 outageCount

Requests the outage count (the number of times an outage occurred) for an element's agreement or objective:

```xml
<request:outageCount/>
```

To obtain the outage count, a time constrain tag must be provided.

C.5.5 breachCount

Requests the breach count (the number of times a breach occurred) from an element's agreement/ objectives for a specified period of time.

```xml
<request:breachCount/>
<request:breachCount filter="(severity=major)"/>
<request:breachCount filter="(severity=major)&(alarm.status=closed)"/>
```

A time constrain tag is required within the createQuery tag to provide a time window to obtain a breach count from the performance engine. The optional attribute filter selects the type of alarms to consider when counting the breach.
To obtain a breach count for an element agreement, provide the element and offering constrain tags and request a breach count within the createQuery tag:

```
<constrain:time from="start time" to="end time" />
<constrain:element name="org=Check+Bill/root=Organizations"/>
<constrain:offering name="SLA Name"/>
:request:breachCount/>
```

C.5.6 outageDuration

Requests the outage duration (how long an outage occurred) for an element’s agreement or objective:

```
<request:outageDuration/>
```

The time constrain tag must provide the time span to use for obtaining the outage count from the performance engine.

C.5.7 objectiveInstance

Requests an instance of an objective of a given Operations Center element:

```
<request:objectiveInstance/>
```

The results returned are the name, description, and other information about the objective. To obtain the instance of an objective, the element, offering, and objective constrain tags must be provided within the createQuery tag.

C.6 Element Tag Library

The Element tag library contains custom tags that can access information and functions within elements in Operations Center. An element is any managed object, such as a router, server, organization, or site.

To reference this custom tags in the Operations Center tag library, add the following code to the top of the JSP file before the `<html>` tag:

```
<%@ taglib uri="http://www.managedobjects.com/taglibs/remote/element" prefix="element" %>
```

The following sections provide an overview of all tags available in the Element tag library:

C.6.1 exists

A parent tag of the other tags in Elements tag library. Other element tags contained within the exists tag use the element specified by the name attribute of the exists tag. Therefore, the child tags do not need to specify a name attribute themselves. This can improve both clarity and performance in the JSP. If an element named in the name attribute is not found, the body of the exists tag is not evaluated. This is shown in the following example:

```
<element:exists name="root=Elements" id="element">
   The element named <%= element.getName() %>> exists!
</element:exists>
```
ElementTagSupport class is the class which supports the element tag library. The methods available on this tag allow you to retrieve:

- "getName()" on page 201
- "getCondition()" on page 201
- "getTotalAlarmCount()" on page 201
- "getAlarmCount()s" on page 201
- "Alarm Severity Counts" on page 201

**getName()**

This method returns the name of the element. The declaration of the method is:

```java
public String getName()
```

**getCondition()**

This method returns a String object that describes the state or condition (OK, CRITICAL, MAJOR, and so on) of an element. The declaration of this method is:

```java
public String getCondition()
```

**getTotalAlarmCount()**

This method return a total count of alarms for this element. The declaration of the method is:

```java
public int getTotalAlarmCount()
```

**getAlarmCount()s**

Gives the count of alarms with the specified element condition.

```java
public int getAlarmCount(com.mosol.ORB.Formula.ElementCondition condition)
```

Allowed values are:

- com.mosol.ORB.Formula.ElementCondition.UNKNOWN
- com.mosol.ORB.Formula.ElementCondition.CRITICAL
- com.mosol.ORB.Formula.ElementCondition.MAJOR
- com.mosol.ORB.Formula.ElementCondition.MINOR
- com.mosol.ORB.Formula.ElementCondition.MINOR
- com.mosol.ORB.Formula.ElementCondition.INFORMATIONAL
- com.mosol.ORB.Formula.ElementCondition.OK
- com.mosol.ORB.Formula.ElementCondition.INITIAL

**Alarm Severity Counts**

Execute one call to get all the alarm severity counts - return the individual counts in the return array. The declaration of the method is:

```java
public Map<String, Integer> getTotalAlarmCountAndSeverityCount()
```
C.7 Result Tag Library

The Result tag library contains functionalities specific to the Operations Center application for iterating through data returned by the performance engine.

To reference custom tags in the Operations Center Results tag library, add the following code to the top of the JSP file before the `<html>` tag:

```html
URL = < %@ taglib uri="http://www.managedobjects.com/taglibs/remote/query/result" prefix="result" %>
```

When a request is performed within the createQuery tag, the result cubes contain the requested information. Iterate these result cubes using the tags belonging to the Result tag library.

The following sections explain the tags:

- Section C.7.1, "iterator," on page 202
- Section C.7.2, “ResultTagSupport Class,” on page 202

C.7.1 iterator

Cycles through the result cubes returned by the performance engine:

```html
<result:iterator id="identifier">
    [JSP Body Content]
</result:iterator>
```

To cycle through the result cubes, the iterator tag must be provided within the performQuery tag. All other specific iteration tags, such as alarms and metrics, must also be used within the iterator tag. In order to iterate through the results properly, it is necessary to understand the structure of the query and the resulting cubes. Iteration through the results could become complex if the structure of the query is complex, such as when using nested queries and expansion. Thus, the resulting iteration must analyze the structure of the query and resulting cubes.

C.7.2 ResultTagSupport Class

Acts as a super class for all the tags belonging to result iteration. The methods available in this class retrieve information while iterating the result. Tags that belong to result iteration inherit the functionalities of ResultTagSupport, either directly or indirectly.

The following sections provide the methods for the ResultTagSupport class:

- “getCompliance()” on page 203
- “getAvailability()” on page 203
- “getElementCondition()” on page 203
- “getCondition()” on page 203
- “getBreachCount()” on page 203
- “getOutageCount()” on page 203
- “getDowntime()” on page 203
getCompliance()

This method obtains the compliance of an element’s agreement or its objective. This method returns availability as a double value.

public double getCompliance()

gAvailability()

This method obtains the availability of an element’s agreement or its objective. Availability is the amount of time when the condition of an element is below the selected threshold condition. This method returns availability as a double value.

public double getAvailability()

gElementCondition()

This method returns a String object that describes the state or condition (OK, CRITICAL, MAJOR, and so on) of an Operations Center element.

public String getElementCondition()

gCondition()

This method returns a String object that describes the state or condition (OK, CRITICAL, MAJOR, and so on) of an element’s objective or an agreement.

public String getCondition()

gBreachCount()

This method returns a breach count as an integer (int) value. A breach count is the number of breaches that occur in a Service Level Agreement or its objective.

public int getBreachCount()

gOutageCount()

This method returns an outage count as an integer (int) value. An outage count is the number of outages that occur in an agreement.

public int getOutageCount()

gDowntime()

This method returns the downtime of an element’s objective as a long value. Downtime is the total time that elapsed during an outage (such as the duration of an outage) when an element condition is above the selected threshold condition.

public long getDowntime()
The /OperationsCenter_Dashboard_install_path/server/logs/dashboard.trc file contains error and warning messages related to the Dashboard server.

- Section D.1, “Errors,” on page 205
- Section D.2, “Warnings,” on page 208

D.1 Errors

- Section D.1.1, “User ID Exception – Unable to Synchronize User,” on page 205
- Section D.1.2, “Data Dispatcher Exception – Broken Pipe,” on page 206

D.1.1 User ID Exception – Unable to Synchronize User

The Dashboard uses the managedobjects.com domain name for a reserved user account. If any Dashboard user account has the user name containing “managedobjects.com”, the following error occurs:

com.liferay.portal.UserIdException
at com.liferay.portal.service.impl.UserLocalServiceImpl.validate(UserLocalServiceImpl.java:1460)
at com.liferay.portal.service.impl.UserLocalServiceImpl.addUser(UserLocalServiceImpl.java:194)
at sun.reflect.GeneratedMethodAccessor513.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:25)
at java.lang.reflect.Method.invoke(Method.java:585)
at org.springframework.aop.support.AopUtils.invokeJoinpointUsingReflection(AopUtils.java:280)
at org.springframework.aop.framework.ReflectiveMethodInvocation.invokeJoinpoint(ReflectiveMethodInvocation.java:187)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed(ReflectiveMethodInvocation.java:318)
at com.liferay.portal.service.impl.UserLocalServiceImpl.validateImpl(UserLocalServiceImpl.java:1460)
at com.liferay.portal.service.impl.UserLocalServiceImpl.addUserImpl(UserLocalServiceImpl.java:194)
at sun.reflect.GeneratedMethodAccessor513.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:25)
at java.lang.reflect.Method.invoke(Method.java:585)
at org.springframework.aop.support.AopUtils.invokeJoinpointUsingReflection(AopUtils.java:280)
at org.springframework.aop.framework.ReflectiveMethodInvocation.invokeJoinpoint(ReflectiveMethodInvocation.java:187)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed(ReflectiveMethodInvocation.java:318)
at com.liferay.portal.service.impl.MOAuthServiceImpl.validate(MOAuthServiceImpl.java:82)
at com.liferay.portal.service.impl.MOAuthServiceImpl.addUser(MOAuthServiceImpl.java:152)
at sun.reflect.GeneratedMethodAccessor513.invoke(Unknown Source)
at sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:25)
at java.lang.reflect.Method.invoke(Method.java:585)
at org.springframework.aop.support.AopUtils.invokeJoinpointUsingReflection(AopUtils.java:280)
at org.springframework.aop.framework.ReflectiveMethodInvocation.invokeJoinpoint(ReflectiveMethodInvocation.java:187)
at org.springframework.aop.framework.ReflectiveMethodInvocation.proceed(ReflectiveMethodInvocation.java:318)
at com.liferay.portal.service.impl.MOAuthServiceImpl.addUserImpl(MOAuthServiceImpl.java:152)

Resolution:

1. Upgrade the Liferay version to a later release.
2. Contact the Liferay support team for assistance.

If the error persists after these steps, please consult the Liferay forums or support resources for further assistance.
D.1.2 Data Dispatcher Exception – Broken Pipe

If the Dashboard Web server stops while writing data, an exception can be thrown that appears as a SocketException or broken pipe error. This exception is not a true error because no data was lost and the Dashboard will recover itself and resume normal operations.

For more information, see Section 13.6, “Performing System Recovery,” on page 180.

The following is a sample of the code that might appear for this type of exception:

```
java.net.SocketException: Broken pipe
  at java.net.SocketOutputStream.socketWrite0(Native Method)
  at java.net.SocketOutputStream.socketWrite(SocketOutputStream.java:92)
  at java.net.SocketOutputStream.write(SocketOutputStream.java:136)
      at org.apache.coyote.Response.doWrite(Response.java:513)
  at org.apache.coyote.tomcat4.OutputBuffer.realWriteBytes(OutputBuffer.java:380)
      at org.apache.tomcat.util.buf.ByteChunk.append(ByteChunk.java:348)
  at org.apache.coyote.tomcat4.OutputBuffer.writeBytes(OutputBuffer.java:407)
      at org.apache.coyote.tomcat4.OutputBuffer.write(OutputBuffer.java:394)
  at org.apache.coyote.tomcat4.CoyoteOutputStream.write(CoyoteOutputStream.java:110)
  at org.apache.coyote.tomcat4.CoyoteOutputStream.write(CoyoteOutputStream.java:104)
  at org.jahia.bin.AbstractDispatchingServlet.service(AbstractDispatchingServlet.java:171)
      at javax.servlet.http.HttpServlet.service(HttpServlet.java:853)
  at org.apache.catalina.core.ApplicationFilterChain.internalDoFilter(ApplicationFilterChain.java:247)
```
Troubleshooting Trace Logs

```java
at org.apache.catalina.core.ApplicationFilterChain.access$000(ApplicationFilterChain.java:98)
at org.apache.catalina.core.ApplicationFilterChain$1.run(ApplicationFilterChain.java:176)
at java.security.AccessController.doPrivileged(Native Method)
at org.apache.catalina.core.ApplicationFilterChain.doFilter(ApplicationFilterChain.java:172)
at org.apache.catalina.core.StandardWrapperValve.invoke(StandardWrapperValve.java:260)
at org.apache.catalina.core.StandardPipeline$StandardPipelineValveContext.invokeNext(StandardPipeline.java:643)
at org.apache.catalina.core.StandardPipeline.invoke(StandardPipeline.java:480)
at org.apache.catalina.core.ContainerBase.invoke(ContainerBase.java:995)
at org.apache.catalina.core.StandardContextValve.invoke(StandardContextValve.java:191)
at org.apache.catalina.core.StandardPipeline$StandardPipelineValveContext.invokeNext(StandardPipeline.java:643)
at org.apache.catalina.core.StandardPipeline.invoke(StandardPipeline.java:480)
at org.apache.catalina.core.ContainerBase.invoke(ContainerBase.java:995)
at org.apache.catalina.core.StandardContext.invoke(StandardContext.java:2396)
at org.apache.catalina.core.StandardHostValve.invoke(StandardHostValve.java:180)
at org.apache.catalina.core.StandardPipeline$StandardPipelineValveContext.invokeNext(StandardPipeline.java:641)
at org.apache.catalina.valves.ErrorDispatcherValve.invoke(ErrorDispatcherValve.java:170)
at org.apache.catalina.core.StandardPipeline$StandardPipelineValveContext.invokeNext(StandardPipeline.java:641)
at org.apache.catalina.core.StandardPipeline$StandardPipelineValveContext.invokeNext(StandardPipeline.java:641)
at org.apache.catalina.core.StandardPipeline.invoke(StandardPipeline.java:480)
at org.apache.catalina.core.ContainerBase.invoke(ContainerBase.java:995)
at org.apache.catalina.core.StandardEngineValve.invoke(StandardEngineValve.java:174)
at org.apache.catalina.core.StandardPipeline$StandardPipelineValveContext.invokeNext(StandardPipeline.java:643)
at org.apache.catalina.core.StandardPipeline.invoke(StandardPipeline.java:480)
```
D.2 Warnings

- Section D.2.1, “No Such LayoutSet Exception,” on page 208

D.2.1 No Such LayoutSet Exception

If no Portal URL and Home URL have been specified in Section 3.2, “Updating Dashboard Administrative Configurations,” on page 28, warnings similar to the following can appear:

2007-04-20 17:09:44,520 WARN com.liferay.portal.servlet.filters.virtualhost.VirtualHostFilter - com.liferay.portal.NoSuchLayoutSetException: No LayoutSet exists with the key {companyId=managedobjects.com,virtualHost=qaredhat40}

This warning has no impact on the functioning of the Dashboard.